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Zákonná a regulační upozornění 

Copyright © 2010 

Bruker Daltonik GmbH 

Všechna ostatní obchodní označení jsou ve výlučném vlastnictví příslušných majitelů. 

Veškerá práva vyhrazena 

Kopírování, upravování nebo překládání toho manuálu bez předchozího písemného 
souhlasu je zakázáno (mimo výjimky definované v zákonech o ochraně autorských 
práv). 

Historie dokumentu  

MALDI Biotyper 3.0 Uživatelský manuál, 2. revize (únor 2011) 

Výrobní číslo: #269025#987654 

První vydání: leden 2011 

Záruka 

Informace uvedené v tomto dokumentu mohou být bez předchozího upozornění 
pozměněny. 

Firma Bruker Daltonik GmbH neposkytuje na tento materiál žádnou záruku, a to 
včetně (avšak bez omezení na) implicitní prodejní záruky a vhodnost jeho použití pro 
jiné účely.  

Firma Bruker Daltonik GmbH neodpovídá jak za chyby, které se v tomto dokumentu 
mohou vyskytnout, tak také za náhodné či následné škody, které vzniknou 
v souvislosti s pořízením, provozováním anebo používáním tohoto materiálu. 

Firma Bruker Daltonik GmbH rovněž nenese zodpovědnost za použití nebo 
spolehlivost tohoto softwaru u těch zařízení, která nejsou výrobky zn. Bruker Daltonik 
GmbH. 

Užití obchodních známek 

Názvy společností a produktů zde zmiňované  mohou být ochrannými známkami 
příslušných vlastníků. 



Bruker Daltonik GmbH 1  systemové komponenty 

 

MALDI Biotyper 3.0 User Manual Revision 2 Strana 3  

 

Omezení používání 

Použití pouze pro výzkum (RUO). Nepoužívat na diagnostické procedury. 

Odmítnutí odpovědnosti za hyperlink 

Firma Bruker Daltonik GmbH neposkytuje žádnou záruku (ani písemnou, ani ústní) a 
nezodpovídá ani za obsah, ani za údaje, jež jsou uvedeny na těch internetových 
stránkách, na které tento dokument odkazuje  
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Kontakt 

Pro získání dalších informaci a služeb kontaktujte svého místního zástupce firmy 
Bruker Daltonics  

Česká Republika Německo 

Bruker Daltonics s.r.o. 

Zdráhalova 10 

Brno, 613 00 

Česká Republika 

Bruker Daltonik GmbH 

Fahrenheitstraße 4 

28359 Bremen 

Německo 

Telefon e: +420 544 526 988 Telefon: +49 421 2205-450 

Fax: +420 544 526 989 Fax: +49 421 2205-370 

Internet: www.bdal.cz Internet: www.bdal.de 

  
Service Support 

Telefon: +420 733 351 541 

E-mail: service@bdal.cz 

  
Service Support 

Telefon: +49 421 2205- 350 

E-mail: service@bdal.de 
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Novinky 

Aktualizované balíčky programů MALDI Biotyper Realtime Classification (RTC) a 
MALDI Biotyper Offline Classification (OC) obsahují několik nových funkcí, které 
ulehčují identifikaci vzorků a zpracování dat. 

Novinky a vylepšené funkce programu MALDI Biotyper RTC: 

 Přímé zobrazení výsledků identifikace — okamžitý přístup k výsledkům rozborů 

dat v době kdy jsou zpracovávány další vzorky. 

 Opakovaný rozbor zkoumaných vzorků — pokud se pokud rozbor nezdaří, lze 

vzorky zcela jednoduše  analyzovat znovu. 

 Zobrazení případů shody (´matching hints´) na obrazovce – zvláštní klasifikační 

informace jsou okamžitě k dispozici. 

 Zobrazení úplného seznamu správných výsledků – lze zviditelnit až 10 případů 

shody aniž by bylo třeba vypracovat zprávu. 

 Interaktivní validace – uživatel může definovat validační status řazení výsledků 

(viz část 2.15). 

 Vzdálené definování a validace projektu – pohodlné nastavení projektu 

v jakémkoli počítači. 

 Německá, francouzská a španělská verze – usnadnění pro ty uživatele, kteří 

nehovoří anglicky. 

 Zlepšená grafická vizualizace výsledků – rychlý odhad výsledků klasifikace. 

 Vyhledávání archivovaných projektů podle jména vzorku a jeho ID – snadnější 

práce s daty. 

 Definovaná validační pozice a automatická kalibrace (viz část 2.5.1.9). 

 Hlášení o konzistentních kategoriích a o statistice (viz části 2.18 a 2.19). 
 

Nové a vylepšené funkce programu MALDI Biotyper OC: 

 Přímý import RTC projektů – pohodlné následné zpracování dat o RTC projektu. 

 Rychlé natažení obsahu uzlu s taxonomickým stromem – rychlejší organizace 

dat. 
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 Funkce Gel view zobrazí kterýkoli podsoubor hrubých spekter – zlepšená 

vizualizace dat. 

 Exportování tabulky CCI — zjednodušená výměna dat. 
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Typografické a aplikační zvyklosti 

Tyto zvyklosti obsahují styly písma užité k označení jednotlivých položek grafického 
uživatelského rozhraní (GUI) (např. Položky v menu) 

Navíc obsahují i vysvětlivky termínů užitých k popisu interakce uživatele s grafickým 
uživatelským rozhraním (např. zmáčknutí pravého tlačítka myši) 

Uživatelské rozhraní  

Vypnout (Clear) 

Funkci programu vypnete nastavením kurzoru myši na zaškrtnuté políčko a 
zmáčknutím levého tlačítka myši. 
Příklad: 'Vypněte políčko Curve Smoothing (vyrovnání křivky).' 

Kliknout (Click) 

Ke spuštění požadované akce programu nastavte kurzor myši na položku GUI a 
zmáčkněte levé tlačítko.  
Příklad: 'Zmáčkněte OK.' 

Kliknout a táhnout (Click and drag) 

Nastavte kurzor myši na okno a zmáčkněte levé tlačítko myši. Držte levé tlačítko 
zmáčknuté a pohněte kurzorem myši tak abyste označili požadovanou (obvykle 
obdélníkovou) oblast.  
Příklad: 'Přibližte zajímavé body pomocí příkazu „kliknout a přetáhnout“ („click 
and drag“) v okně zobrazujícím spektrum. 

Dvojité kliknutí (Double-click) 

Ke spuštění požadované akce programu nastavte kurzor myši na příslušnou 
položku a zmáčkněte rychle dvakrát po sobě levé tlačítko myši.  
Příklad: 'Dvakrát po sobě klikněte rychle levým tlačítkem myši na položku 
Sample.' 

Táhnout a přesunout (Drag and drop) 

Nastavte kurzor myši na příslušnou položku a zmáčkněte levé tlačítko. Levé 
tlačítko myši držte zmáčknuté a vybranou položku přesuňte na jiné místo.  
Příklad: 'Přesuňte pomocí příkazu „Táhnout a přesunout“ („Drag and drop“) 
tabulku do jiné skupiny tabulek.' 
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Vybrat (Select)  

          Přejděte na požadovaný příkaz v Menu. 

Příklad: 'Vyberte příkaz File > Zip > Zip Project…' 
Při výběru dané položky na ni nastavte kurzor myši (např. při vložení tabulky) a 
zmáčkněte levé tlačítko. 
Příklad: 'Vyberte požadovaný soubor z nabídky a klikněte na Export.' 
Příslušnou položku programu aktivujte nastavením kurzoru myši na 
nezaškrtnuté políčko  a zmáčknutím levého tlačítko myši.  
Příklad: 'Zaškrtněte políčko Curve Smoothing.' 

Kliknout pravým tlačítkem myši (Right-click) 

Pro otevření kontextového menu u dané položky uživatelského rozhraní (GUI) 
nastavte kurzor myši na tuto položku a zmáčkněte pravé tlačítko.  
Příklad: ' Zmáčkněte pravé tlačítko myši v okně Spectrum View'. 

Ovládání klávesnice 

Stisknout (Press) 

Použijte klávesy vyznačené na klávesnici. Pokud jsou vyznačeny změnové 
klávesy (např.  SHIFT, ALT, CTRL), držte je stisknuty současně s další 
klávesou. 
Příklad: 'K přepnutí mezi okny Tabulka a Spektrum zmáčkněte CTRL+F3.' 

Typografické konvence 

Názvy souborů a adresářů a jejich umístění 

Názvy souborů a adresářů a jejich umístění jsou psány fontem monospace 
type. 
Příklad: 'Navigujte do adresáře C:\Bruker\solariXcontrol\test a 
otevřete soubor test_1.txt. 

Položky grafického uživatelského rozhraní  

Položky grafického uživatelského rozhraní umožňují interakce uživatele s 
programem aniž by bylo nutno použít klávesnici.  
Mezi typické položky GUI patří okna, menu, menu s volbami, roletky s 
možnostmi a tlačítka v programu. 

 Názvy oken jsou psány běžnými kapitálkami. 
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 Názvy polí pro vkládání textu a tlačítek jsou psány tučně. 

Příklad: ´Do okna New Digest vložte hodnoty pro Name (povinný údaj) a Note 
(nepovinný údaj) a klikněte na tlačítko Next>. 

 Příkazy menu a volby GUI jsou psány tučně. 

Příklad: 'Vyberte Window > Show View > LC-MS Survey'. 

Klávesnice 

Odkazy na klávesy jsou psány tučně. 
Příklad: 'Zmáčkněte ALT+F4'. 

Publikace 

Odkazy na elektronické a tištěné dokumenty jsou psány kurzívou. 
Příklad: 'Pro získání dalších detailů vyhledejte manuál ProteinScape 

Administrator. 

Odkazy URL 

Jednotné lokátory zdrojů (URLs) jsou psány podtrženě. Názvy schémat 
(např: http://) jsou vynechány 
Příklad: 'Další podrobnosti naleznete na odkazu www.mascot.org/users'. 
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Začínáme s programem MALDI Biotyper 
Tato sekce poskytuje souhrnný přehled postupů potřebných k roztřídění neznámých 
mikroorganismů pomocí softwaru MALDI Biotyper. 

Předpoklady 

Použití hmotnostního spektrometru MALDI-TOF (viz Příloha A) 

 Připravený MALDI terčík (viz Příloha A) 

►► Roztřídění neznámých mikroorganismů pomocí programu MALDI Biotyper 
RTC 

1. Vložte misku se vzorkem do hmotnostního spektrometru (viz příručka s návodem) 

2. Spusťte program MALDI Biotyper Realtime Classification (viz  část 2.1). 

3. Spusťte Průvodce programem MALDI Biotyper Realtime Classification Wizard (viz  

část 2.3). 

4. Vytvořte nový projekt (viz  část 2.4). 

5. Zadejte údaje o vzorku (viz  část 2.5.1). 

6. Definujte projektové metody (viz  část 2.7). 

7. Zkontrolujte nastavení projektu a spusťte identifikaci (viz  část 2.8). 

8. Vytvořte přehled výsledků identifikace (viz  část 2.17). 

Analýza výsledků 
Výsledky rozboru získané pomocí programu MALDI Biotyper RTC mohou být dále 
zpracovávány a analyzovány pomocí programu MALDI Biotyper Offline Classification. 

►► Analýza výsledků pomocí programu MALDI Biotyper OC 

1. Spusťte klasifikační program MALDI Biotyper OFFLINE Classification (viz  část 

1.1). 

2. Nahrajte projekt MALDI Biotyper RTC do programu MALDI Biotyper Offline 

Classification ( viz  část 3.3.2.2). 

3. Program MALDI Biotyper použijte k následujícím úkonům: 

 Proveďte analýzu neznámých mikroorganismů  pomocí: 

o Hrubých spekter anebo hlavních spekter (viz  část 3.4) 
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o Matice kompozitního korelačního indexu (Composite Correlation Index 

Matrice; viz část 3.8.3)  

 Zpřesnění klasifikace úzce příbuzných mikroorganismů pomocí subtypizace 

podle hlavních spekter (MSP – viz část 3.4.4) 

 Začlenění spekter určených mikroorganismů do taxonomických stromů a 

knihoven MSP (viz  část 3.5) 

 Ke zjištění vztahů mezi mikroorganismy použijte: 

o PCA dendrogramy a tabulky skóre a nahrávání (viz část 3.7)  

o MSP dendrogramy (viz  část 3.6) 

o CCI matrice (viz  část 3.8.1) 
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1  Systémové komponenty 

Software MALDI Biotyper má tři hlavní komponenty: 

• MALDI Biotyper RTC (klasifikace v reálném čase) 

o Tento software je určen pro ty uživatele, kteří chtějí neznámé vzorky 

klasifikovat rychle a snadně. V tomto případě uživatel prostě vloží vzorek do 

přístroje, spustí proces klasifikace a čeká na výsledek. 

• MALDI Biotyper OC (offline klasifikace) 

o Určeno pro vyspělejší uživatele tj. ty, kteří chtějí klasifikační proces přesně 

doladit a podrobně zkoumat vztahy mezi jednotlivými skupinamI organismů. 

• flexControl 

o Tento software se používá ke kontrole přístroje MALDI-TOF. V průběhu 

klasifikace vzorku přístrojem MALDI Biotyper může tento progrtam běžet 

skrytě. 

1.1  Použití přístroje MALDI Biotyper ke klasifikaci v 
reálném čase 

1.1.1  Identifikace mikroorganismů pomocí hmotnostní 
spektrometrie 

V současnosti představují biochemické testy základ většiny technik, jež se k 
identifikaci mikroorganismů používají. Ke kulturám se přidávají ty reagencie, které jsou 
metabolizovány pouze specifickými organismy. To má za následek určitou  
charakteristickou změnu barvy přidaného činidla a tu pak lze porovnat s referenčními 
hodnotami. Korelování výsledků velkého počtu testů provedených u kultivovaného 
vzorku potom umožňuje indikaci identity příslušného mikroorganismu.  

Přístroj MALDI Biotyper používá odlišnou metodiku: mikroorganismy jsou v tomto 
případě identifikovány na základě exprese jejich vlastních bílkovin pomocí hmotnostní 
spektrometrie. Tento hmotový spektrální obraz proteinové exprese se porovnává s 
referenčními hodnotami uvedenými v databázi přístroje (seznam záznamů 
obsažených v této referenční databázi lze na požádání obdržet).  

Výchozím materiálem pro klasifikaci pomocí přístroje MALDI Biotyper je individuální 
kolonie mikroorganismů, která je získána po jejich krátkodobé kultivaci na agarové 
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plotně (obvykle přes noc). Vzorek pak je přenesen na určitou pozici terčíku MALDI 
target a vysušen na vzduchu.  

Po vysušení se ke vzorku přidá malé množství zásobního roztoku (matrix). Organické 
rozpouštědlo, ktreré je v tomto roztoku obsaženo, pak z mikroorganismů extrahuje 
jednotlivé bílkoviny. Tyto extrahované proteiny jsou hlavně ribozomálního původu a ve 
vzorku jsou přítomny ve vysokých koncentracích.  

Jakmile matrix vykrystalizuje, je příprava vzorku dokončena a lze jej analyzovat.  

Není-li tato jednoduchá metoda přípravy vzorku úspěšná, lze použít dodatkový 
protokol obsahující krátký popis jednotlivých kroků chemické extrakce k tomu, aby se 
zvýšil počet mikroorganismů, jež lze pomocí MALDI analýzy identifikovat. 

Hmotnostní spektrometrie zvaná MALDI (matrix-assisted laser desorption/ionisation) 
TOF (Time of Flight) představuje základ analýz prováděných přístrojem MALDI 
Biotyper. Laser hmotového spektrometru MALDI-TOF ozáří směs matrix/vzorek, 
matrix odpaří a v rámci tzv. “měkkého” ionizačního procesu uvolní pozitivně nabité 
proteiny. Základním faktorem tohoto procesu je schopnost matrix absorbovat UV 
záření a přenášet protony na extrahované bílkoviny.  

Proteinové ionty jsou pak na krátkou vzdálenost elektrostaticky urychleny a proletí  
trubicí přístroje rychlostí, která je úměrná jejich hmotnosti. Proteinové ionty o různé 
hmotnosti doletí do detektoru během různých časových intervalů. Jednoduchým 
změřením doby, která uplyne mezi pulzačním zrychlením a příslušným signálem 
detektrou (nanosekundy), lze rychlost iontů změřit velmi přesně a výslednou hodnotu 
pak konvertovat na přesnou molekulární hmotnost. 

1.1.2  Generování identifikačních molekulárních otisků 
(‘Fingerprints’) 

Analýza pomocí přístroje MALDI Biotyper generuje charakteristickou distribuci 
hlavních ribozomálních bílkovin podle jejich hmotnosti a intenzity. Vzhledem k tomu, 
že toto hmotové spektrum je pro velký počet mikroorganismů druhově specifické, 
představuje de facto jejich “molekulární identifikátor” (tzv. fingerprint). Neznámé 
mikroorganismy lze pak identifikovat na základě srovnání jejich molekulárního 
identifikátoru s tisíci vzorů (pattern), jež jsou v referenční databázi uloženy. 

Při zpracování dat je prvním krokem přenesení získaných hmotových spekter na 
seznam píků (peaks). Ve druhém kroku je pak tento seznam píků porovnáván se 
všemi jednotlivými vzory (profily), jež jsou v referenční databázi uloženy. 
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1.1.3  Výpočet skóre vzorku 

Srovnávací algoritmus použitý ke srovnání molekulárního identifikátoru vzorku 
vypočítává tři samostatné hodnoty pro tři základní charakteristiky vzorku a pro 
referenční spektra.  

1. Nejdříve se stanoví počet těch signálů v referenčním spektru, které se 

srovnávanému neznámému spektru podobají nejvíce. Při žádném srovnávání není 

výsledek tohoto srovnání  roven nule a úplné porovnání dává hodnotu = 1. 

2. Pak se stanoví počet těch signalů neznámého spektra, které se partnerským 

hodnotám referenčního spektra nejvíce přiblížují. Při žádném srovnání není 

výsledek tohoto srovnání  roven nule a úplné porovnání dává hodnotu = 1. 

3. Nakonec se propočte symetrie srovnávaných signálních párů. Jestliže vysoce 

intenzivní (high-intensity) signály neznámého spektra korespondují s vysoce 

intenzivními signály spektra referenčního a odpovídají-li si navzájem i signály nízko 

intenzivní (low-intensity), je výsledkem tohoto postupu vysoce symterická hodnota 

a tzv. srovnávací (korelační) matice dává hodnotu blízkou 1. Jestliže ale 

srovnávané páry signálů tuto symetrii nevykazují je výsledná hodnota blízká nule. 

Uvedené tři hodnoty jsou pak společně vynásobeny a výsledek je normalizován na 

1000. Hodnota vypočteného skóre je v tomto případě dekadickým logaritmem tohoto 

výsledku. Maximálně dosažitelná hodnota skóre je rovna 3 (= log 1000). 

Následná klasifikace hodnot vypočteného skóre vykazuje nejvyšší shodu v horní části 

seznamu. Čím je hodnota skóre vyšší, tím pravděpodonější je I klasifikace 

analyzovaného druhu. Barevně kódované zobrazení hodnoty vypočteného skóre 

přitom umožňuje rychlé hodnocení výsledků. 

Hodnoty skóre ≥ 2,0 lze považovat za pravděpodobnou klasifikaci. 

 

V této souvislosti je ale důležité si uvědomit, že hodnota skóre vygenerovaného 

přístrojem MALDI Biotyper RTC znamená jen pravděpodobnost toho, že 

neznámý mikroorganismus bude jedním z druhů, jež jsou v databázi přístroje 

MALDI Biotyper zachyceny. 
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1.2  Offline kasifikace (OC) přístrojem MALDI 
Biotyper 

Při offline klasifikaci využívá přístroj MALDI Biotyper OC stejnou databázi a nabízí 

tytéž klasifikační algoritmy jako přístroj MALDI Biotyper RTC; rozdíl spočívá pouze v 

tom, že tato metoda dává uživateli větší volnost při definování klasifikačních 

parameterů. Software přístroje MALDI Biotyper OC umožňuje uživateli rovněž 

optimalizaci klasifikačního procesu, a to tím, že vytváří, modifikuje a organizuje data 

referenčního spektra. 

Zdokonalená analýza a různé výstupy umožňují také vizualizaci vztahů existujících 

mezi různými skupinami mikroorganismů a testovanými vzorky, a to na základě použití 

metod analýzy základních komponent (Principal Component Analysis – PCA) a 

kompozitního korelačního indexu (Composite Correlation Index – CCI). 

1.3  Program flexControl 

Program flexControl je určen pro konfiguraci a řízení činnosti hmotnostních 

spektrometrů  typu Time-Of-Flight (TOF) výrobkových řad microflex, autoflex a 

ultraflex firmy Bruker. Program flexControl pracuje v operačních systémech Microsoft® 

Windows® anebo XP® (SP3). 

Vice informací lze získat v manuálu flexControl User Manual. 
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2  Klasifikace v reálném 
MALDI Biotyper Realtime 
(RTC) 

2.1  Spuštění softwaru

Pro spuštění softwaru MALDI Biotyper Realtime 

1. Buď zvolit nabídku  > Programs > Bruker Daltonics > MALDI Biotyper 

RTC    anebo dvakrát kliknout na ikonu desktopu MA

2.2  Uživatelské rozhraní programu MALDI Biotyper 
Realtime Classification 

Okno programu MALDI Biotyper Realtime 
nástroj- a status (title-; menu-; toolbar
and legend displays) a výsledkovou tabulku

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)

Revision 2 

v reálném čase pomocí softwaru 
DI Biotyper Realtime Classification  

ní softwaru 

Biotyper Realtime Classification  je třeba:

> Programs > Bruker Daltonics > MALDI Biotyper 

anebo dvakrát kliknout na ikonu desktopu MALDI Biotyper RTC. 

Uživatelské rozhraní programu MALDI Biotyper 
Classification   

MALDI Biotyper Realtime Classification  obsahuje lišty: titulek
toolbar- a status-); cílový a legendový displej (t

výsledkovou tabulku (results table). 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 

Strana 20 

pomocí softwaru 
  

eba: 

> Programs > Bruker Daltonics > MALDI Biotyper 

Uživatelské rozhraní programu MALDI Biotyper 

titulek-, menu-
cílový a legendový displej (target 
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Lišta Titulek (Title) 

Tato lišta zobrazuje název aplikace a obsahuje známá tla
umožňující minimalizaci, maximalizaci a zav
anebo jsou-li zobrazeny výsledky klasifikace již 
souvisejícího projektu. 

Lišta Menu  

Tato lišta zobrazuje nabídky Soubor, Náhled, Nástroj
and Help) programu MALDI Biotyper RTC.

Lišta Panely nástrojů 

Na liště Panely nástrojů jsou zobrazena tla
příkazům. 

Panel Tip 
Hlavní panel nástrojů   

 Otevř

 Nová klasifikac

 Náhled výsledk

 Zavřít klasifikaci 

 Export validace

 
Resetování 
validace

Výsledky   

 
Kolaps
všeho

 Expand

 
Skrýr
identifikované 

 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)

Revision 2 

Tato lišta zobrazuje název aplikace a obsahuje známá tlačítka systému Windo
ující minimalizaci, maximalizaci a zavření okna. Je-li klasifikace spušt

li zobrazeny výsledky klasifikace již ukončené, je zde zobrazeno I jméno 

nabídky Soubor, Náhled, Nástroje a Pomoc (File, View
programu MALDI Biotyper RTC. 

jsou zobrazena tlačítka umožňující přímý přístup k u

 Funkce 
  

Otevřít klasifikaci  Otevření archivovaného projektu

Nová klasifikace Vytvoření nového projektu anebo 
natažení projektu již existujícího

Náhled výsledků  Generování zprávy o výsledcích 
klasifikace 

Zavřít klasifikaci  Zavření právě probíhající klasifikac

Export validace Uložení uživatelem definovaného 
stavu validace 

Resetování 
validace 

Použití již nastaveného  stavu 
validace 
  

olaps (zrušení) 
všeho 

Kolaps (zrušení) všech výsledk
klasifikace   

Expandovat vše Expandovat všechny výsledky 
klasifikace   

Skrýr/zobrazit 
identifikované  

Skrýr/zobrazit druh na základě
shodných(konzistentních) výsledk

ase pomocí softwaru MALDI 
time Classification  (RTC) 
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ítka systému Windows 
li klasifikace spuštěna 

zobrazeno I jméno 

View, Tools 

ístup k určitým 

ení archivovaného projektu 

ení nového projektu anebo 
ní projektu již existujícího 

rávy o výsledcích 

 probíhající klasifikace  

Uložení uživatelem definovaného 

stavu 

í) všech výsledků 

ovat všechny výsledky 

na základě 
výsledků 
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Displej terčíku 

Cílový displej zobrazuje zástupce terčíku MALDI a indikuje pozici a stav vzorků. 

Legenda k displeji 

Tato legenda vysvětluje barevné kódování použité k indikaci momentláního stavu 
vzorků zobrazených na tomto displeji. 

Tabulka výsledků 

Ve výsledkové tabulce je zobrazen souhrn výsledků aktivního nebo již ukončeného 
klasifikačního cyklu. Kliknutím pravého tlačítka na záhlaví tabulky se sloupce buď 
zobrazí  anebo skryjí. Pořadí sloupců lze změnit kliknutím levého tlačítka na záhlaví 
tabulky a přetažením sloupce na nové místo. 

Sloupec Komentář 

Ikona Kódování barvami semaforu. 

ID Identifikační číslo analytu (analyzovaného vzorku) (= ID 
vložené na stránku Analyte Placement v Průvodci k 
programu MALDI Biotyper RTC). 

Název Název analytu (= jméno vložené na stránku Analyte 
Placement v Průvodci k programu MALDI Biotyper RTC). 

Pozice Pozice cílového analytu (= pozice vložená na stránku Analyte 
Placement v Průvodci k programu MALDI Biotyper RTC). 

Čip Čip vložený na stránku Analyte Placement v Průvodci k 
programu MALDI Biotyper RTC. 

Detekovaný druh Jméno nejvíce odpovídajícího organismu. 

Skóre Bodová hodnota výsledku porovnání. 
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Poznámka Náznak shody (existuje-li) 

Popis Popis analytu (= popis vložený na stránku Analyte 
Placement v Průvodci k programu MALDI Biotyper RTC). 

Validace Uživatelem měnitelné konzistentní kategorie. 

Výsledky srovnání 
– Ikona     

Barevné kodování rozšířených (expandovaných) výsledků 
(použito je barev dopravních světel). 

Výsledky srovnání 
– Skóre  

Hodnota skóre shody u rozšířených (expandovaných) 
výsledků 

Výsledky srovnání 
– Zjištěný druh 

Jméno srovnávaného organismu  v  rozšířených 
(expandovaných) výsledcích. 

Výsledky srovnání 
– Poznámka  

Náznak shody u rozšířených (expandovaných) výsledků 
(existuje-li). 

Výsledky srovnání 
– Vazba  

NCBI identifikátor v příslušném uzlu (node) taxonomického 
kmene podle NCBI (existuje-li) v  rozšířených výsledcích.Je-li 
system napojen na Internet, otevře hyperlink v daném nodu  
taxonomický prohlížeč NCBI. 

 

Chcete-li zabránit tomu, aby výsledková tabulka automaticky nerolovala směrem 
nahoru a aby v průběhu klasifikace nové výsledky nebyly zobrazovány, zvolte řídící 
políčko Switch off scrolling (Vypnout rolování). Výsledky se na zobrazované tabulce 
přestanou pohybovat.  

Není-li nabídka Switch off scrolling vybrána, je stávající zobrazovaná výsledková 
zabulka ovlivňována právě probíhajícím měřením. Nové výsledky se objevují v dolní 
části tabulky, výsledková tabulka automaticky pomalu roluje směrem vzhůru a objevují 
se na ní postupně další a další nové výsledky. 
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Status Bar (Stavová lišta) 

Informace o aktuálním stavu programu 
stavové lišty, zatímco informace o p

Také průběh klasifikace  je na 
momentálně měřeného vzorku, propo
flexControl), údaj o počtu vzork
klasifikace (z programu MALDI Biotyper RTC).

2.2.1  Změna velikosti okna programu 

Okno programu MALDI Biotyper RTC 
nastavena výrobcem; uživatel ji však m

Velikost celého okna lze zvětšit nebo zmenšít
následným roztažením na požadovanou velikost
velikost displeje  a zobrazené výsledkové tabulky

Relativní šířku cílového displeje a zobrazení p
potažením jejich svislého dělítka pot

Také relativní výšku výsledkové tabulky, cílového 
změnit kliknutím a potažením jejich vodorovného d

2.3  Průvodce programem 

Poradce programu  MALDI Biotyper RTC 

• vytvoření nového klasifikač

• pokračování v přerušeném klasifika

• natažení (nahrání) již archivovaných 

2.15). 

Průvodce (Wizard) programem MALDI

• Stránka uvítací (Welcome

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Informace o aktuálním stavu programu MALDI Biotyper je zobrazena na levé stran
tímco informace o připojení počítače jsou viditelné na straně pravé

je na stavové liště zachycen. Toto hlášení obsahuje 
eného vzorku, propočtený zbývající čas měření (z programu 

tu vzorků, které již byly klasifikovány, a zbývající dobu 
MALDI Biotyper RTC). 

na velikosti okna programu MALDI Biotyper RTC

MALDI Biotyper RTC se vždy otevírá ve velikosti, která byly 
nastavena výrobcem; uživatel ji však může změnit a přizpůsobit svým potřebám

ětšit nebo zmenšít kliknutím kurzoru na jeho okraj a jeho 
následným roztažením na požadovanou velikost. Spolu s tím se adekvátně
velikost displeje  a zobrazené výsledkové tabulky. 

eje a zobrazení příslušné legendy lze změnit kliknutím 
lítka potřebným směrem.  

ní výšku výsledkové tabulky, cílového displeje a příslušné legendy lze 
potažením jejich vodorovného dělítka potřebným směrem. 

vodce programem MALDI Biotyper RTC 

Biotyper RTC se používá pro: 

ení nového klasifikačního projektu (viz část 2.4)  

erušeném klasifikačním procesu (viz část 2.12) 

natažení (nahrání) již archivovaných projektů a zobrazení výsledků (viz č

MALDI Biotyper RTC má pět samostatných stránek

Welcome) (volitelná). 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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je zobrazena na levé straně 
ě pravé. 

 

oto hlášení obsahuje číslo 
z programu 

zbývající dobu 

 

MALDI Biotyper RTC  

se vždy otevírá ve velikosti, která byly 
řebám. 

nutím kurzoru na jeho okraj a jeho 
Spolu s tím se adekvátně změní i 

nit kliknutím a 

íslušné legendy lze 
.  

  

viz část 

t samostatných stránek: 
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• Stránka defininování proje

definování nových anebo k uložení již 

• Stránka umístění analytu 

o vzorku. 

• Stránka volba metod programu 

Biotyper Methods) — používá se k

vzorku a jeho identifikace (

• Stránka shrnutí projektu (

nastavení projektu. 

Chcete-li Průvodce programem 

• zvolte příkaz File > New classification 

• klikněte buď na   na liště

• současně stiskněte tlačítka 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)

Revision 2 

rojektu (Definition of Project) — používá se bu

definování nových anebo k uložení již existujících klasifikačních projektů

ní analytu (Analyte Placement) — používá se k vložení údaj

volba metod programu MALDI Biotyper (Selection of MALDI 

používá se k definování metod předběžné přípravy 

(preprocessing and identification). 

(Project Summary) — používá se ke kontrole 

ce programem MALDI Biotyper RTC spustit: 

classification a 

a liště nebo   

čítka Ctrl+N. 

ase pomocí softwaru MALDI 
ssification  (RTC) 
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používá se buď k 

ktů. 

vložení údajů 

Selection of MALDI 

řípravy 

používá se ke kontrole 
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Tip: Při tvorbě budoucích projekt
stránku (Welcome). 

Kliknutím na nabídku Next > na uvítací stránce (
definování projektu (Definition of Project

Příkazová tlačítka nacházející se v dolní 
navigaci uvedenou v obsahu Průvodce

Tlačítko Funkce 

Help Spuštění prohledávače

< Back Návrat na předchozí strán

Next > Přechod na další stránku

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)

Revision 2 

 

 budoucích projektů vyberte kontrolní box; tím přeskočíte uvítací 

a uvítací stránce (Welcome) získáte přístup na stránku 
Definition of Project). 

ítka nacházející se v dolní části každé stránky umožňují uživateli 
navigaci uvedenou v obsahu Průvodce. 

če. 

edchozí stránku 

echod na další stránku 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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íte uvítací 

tup na stránku 

ňují uživateli 
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Tlačítko Funkce 

Cancel Otevření níže uvedeného konfirma

Chcete-li Průvodce zav
Realtime Classification, klikn
vrátíte se zpět do pů
otevřenou stránku Průvodce programem, klikn

{b}Poznámka Zrušení nastavení (
bude mít za následek ztrátu všech nových dat, která bya na 
stránky Prů
projektu a tv
Creator). 

Finish Tento příkaz průvoce uzavírá a spouští proces klasifikace

 

2.4  Vytvoření nového projektu

►► Vytvoření  klasifikačního proje

Klasifikační projekt lze pomocí Pr
dvěma způsoby: 

• Kliknutím na tlačítko New…

přidáním údajů o vzorku na cílovou pozici, která se n

Placement. 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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ení níže uvedeného konfirmačního dialogu.  

 

vodce zavřít a vrátit se zpět do programu MALDI
Classification, klikněte na tlačítko Yes; tím Průvodce zav

původního okna. Chcete-li se vrátit zpět na práv
enou stránku Průvodce programem, klikněte na tlačítko No. 

Poznámka Zrušení nastavení (setupu) probíhající klasifikace 
bude mít za následek ztrátu všech nových dat, která bya na 
stránky Průvodce vložena (s výjimkou názvu projektu, popisu 
projektu a tvůrce – Project Name, Project Description

voce uzavírá a spouští proces klasifikace. 

ení nového projektu 

projektu 

kt lze pomocí Průvodce programem MALDI Biotyper RTC 

New… na stránce Definition of Project (viz část 

 o vzorku na cílovou pozici, která se nachází na stránce 

ase pomocí softwaru MALDI 
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MALDI Biotyper 
vodce zavřete a 

ět na právě 

probíhající klasifikace 
bude mít za následek ztrátu všech nových dat, která bya na 

žena (s výjimkou názvu projektu, popisu 
Project Description a 

MALDI Biotyper RTC vytvořit 

ást 2.5) a 

achází na stránce Analyte 
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• Kliknutím na tlačítko Import…

importováním  'klasifikačního úkolu´ (‘classification 

nanášecím (spotting) robot

{b}Poznámka{/b} Za výb
která je pro příslušnou laborato
programu. 

2.5  Vytvoření projektu pomocí tla
nacházejícího se v Pr

Název projektu, jeho tvůrce a jeho fakultat
of Project.  

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Import… na stránce Definition of Project (viz část 

čního úkolu´ (‘classification  job'), který je vygener

robotem anebo LIMS. 

 

Za výběr té setupové procedury klasifikačního projektu, 
íslušnou laboratoř nejvhodnější, je zodpovědný uživatel 

ení projektu pomocí tlačítka New… 
nacházejícího se v Průvodci 

rce a jeho fakultativní popis se vkládají na stránku Definition 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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část 2.5) a 

generován 

ního projektu, 
ědný uživatel 

Definition 
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Chcete-li pomocí tlačítka New… 

1. klikněte na tlačítko New… na stránce 

2. V rámci dialogu  New Project Biotyper Measurement

nového projektu do políčka Name

která bude projekt tvořit.  

Tip Pro vytvoření názvuprojektu se doporu
<date>_<operator's name or initials>_<sequential number>_<target ID> 
Syntax: yyyyymmdd_ABC_01_01234, e.g. 
20081208_JKB_02_01234

I když je tvůrce (Creator) systémem navržen 
zalogováno do Windows), lze jeho jméno zm
definován být musí. Je-li pů
vyřazeno z provozu, a to až do okamžiku, kdy bude vložen nový identifikátor

Popis projektu lze vložit do polí

Pounámka: Maxi
projektu činí 
projektu činí 

3. Kliknutím na tlačítko OK se vrátíte na stránku 

Project); na ní se pak objeví podrobné údaj

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classificat
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New… vytvořit nový klasifikační projekt: 

a stránce Definition of Project. 

New Project Biotyper Measurement, vložte název tohoto 

Name a do políčka Creator uveďte jméno té osoby, 

ení názvuprojektu se doporučuje použít následující postup
r's name or initials>_<sequential number>_<target ID> 

Syntax: yyyyymmdd_ABC_01_01234, e.g. 
20081208_JKB_02_01234. 

 

) systémem navržen automaticky (= jméno uživatele je 
, lze jeho jméno změnit. Tvůrce (Creator) projektu 
li původně nastavený údaj vymazán, je tlač

azeno z provozu, a to až do okamžiku, kdy bude vložen nový identifikátor

u lze vložit do políčka Description (tento údaj je nepovinný). 

Maximální délka názvu (Name) a  tvůrce (
činí 50 znaků. Maximální délka popisu (Description
činí 255 znaků. 

se vrátíte na stránku definování projektu (Definition of 

na ní se pak objeví podrobné údaje o projektu novém. 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 

Strana 29 

ázev tohoto 

te jméno té osoby, 

uje použít následující postup: 
r's name or initials>_<sequential number>_<target ID> 

jméno uživatele je 
) projektu ale 

je tlačítko OK 
azeno z provozu, a to až do okamžiku, kdy bude vložen nový identifikátor. 

).  

rce (Creator) 
Description) 

Definition of 
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4. Kliknutím na tlačítko Next přejdete v Pr

stránka se používá k přidání údaj

2.5.1  Vložení údajů o vzorku

Údaje o vzorku lze na cílové pozice dodat 

• vložit přímo pomocí myši a klávesnice po

• zkopírovat a vložit z některého tabulkového

(viz část 2.5.1.5),  

• importovat ze souboru XML 

• načíst a postupně vložit pomocí

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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řejdete v Průvodci na stránku Analyte Placement

idání údajů o vzorku na cílové pozice (viz část 2.5.1)

ů o vzorku 

Údaje o vzorku lze na cílové pozice dodat čtverým způsobem. Údaje o vozku lze

ímo pomocí myši a klávesnice počítače (viz část 2.5.1.3),  

kterého tabulkového programu, např. Microsoft Excel

XML (viz část 2.5.1.6) or  

pomocí čárových kódů (viz část 2.5.1.4). 

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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Analyte Placement; tato 

2.5.1). 

sobem. Údaje o vozku lze: 

Microsoft Excelu 
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2.5.1.1  Volba cílové pozice vzorků 

Mají-li být data vkládána přímo z klávesnice, je třeba na cílovém displeji zvolit ty cílové 
pozice, na něž tato data mají být uložena (viz část  2.5.1.3). 

Jsou-li údaje o vzorku vkládány kopírováním z tabulkového procesoru anebo 
importem ze souboru XML, jsou cílové pozice definovány těmi údaji, které jsou buď 
vkládány (viz část  2.5.1.5) anebo importovány (viz část  2.5.1.6). 

Sekvenční způsob vkládání 

Při použití sekvenčního způsobu vkládání jsou za výchozí cílovou pozici postupně 
ukládány i pozice další. Tento modus se obzvlášť hodí pro vkládání údajů o vzorku 
pomocí čárových kódů (viz část  2.5.1.4). 

Modus sekvenčního vkládání (Sequential Insert Mode) se aktivuje kliknutím 
pravého tlačítka myši na požadovanou startovací pozici a volbou příkazu Sequential 
Insert Mode v kontextovém menu cílového displeje. 

Zvolená cílová pozice je při aktivaci zvýrazněna bílým kroužkem a přidána na seznam 
v náhledu tabulky. Hodnota uvedená v kolonce Pozice je pak automaticky 
zkopírována do kolonky Name (může však být pozměněna). Textový kurzor se objeví 
v kolonce identifikačního čísla vzorků (sample ID).  

ID vzorku lze nyní vložit buď pomocí klávesnice a stisknutí tlačítka Return anebo jeho 
oskenováním z čárového kódu vzorku. Poté, co je ID vzorku uloženo, vloží se do 
náhledu tabulky další následná pozice a kurzor se přesune na políčko pro vložení 
dalšího ID. Momentálně aktivní pozice je na cílovém displeji zvýrazněna modrým 
čtverečkem.  

V modu sekvenčního vkládání je myš stále aktivní. Kliknutím na určitou buňku tabulky 
se do ní textový kurzor přesune. Následné vložení dat do dalších buněk tabulky lze 
učinit pomocí klávesnice anebo čtečky čárových kódů. 

Jakmile je ukládání údajů o vzorku ukončeno, lze modus sekvenčního vkládání 
vypnout tím, že příkaz Sequential Insert Mode z kontextního menu displeje 
odstraníme. 

2.5.1.2  Požadavky kladené na kategorii údajů o vzorku 

Vlastnosti a jmenná omezení údajů o vzorku vkládaných na stránku Analyte 
Placement jsou uvedeny v Tab. 3-1. 
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Neobsazená identifikační čísla vzorku (
musí být uživatelem vytvořeno tak, že se bu
externího zdroje dat anebo se nač

Jsou-li údaje importovány z XML 
dojde v případě neobsazeného 
fungovat. 

Jestliže existují pozice s neobsazenými identifika
okamžiku, kdy je kliknuto na tlačítko 

Tabulka 3-1   Vlastnosti a jmenná omezení kategorií údaj

Kategorie Povinné/Nepovinné

Pozice Povinné 

Čip Povinné 

Datum 
vytvoření 

Povinné (přidává se 
automaticky) 

Jméno Nepovinné 
(doporučeno) 

ID Povinné 

Popis Nepovinné 

* Ke speciálním znakům patří ty, které v zázvech soubor

                                                           
1Ty MALDI terčíky které žádnou substrukturu nemají, jsou výrobcem definovány jako 
Čip 0; MSP BigAnchorChip™ 96 a MTP BigAnchorChip™
substrukturu tzv. kalibračních míst na 
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ísla vzorku (ID) v projektu nejsou povolena. Vkládané 
tak, že se buď napíše, zkopíruje či importuje z ur

externího zdroje dat anebo se načte z čárového kódu.  

XML souboru anebo přeneseny z tabulkového procesoru
 neobsazeného ID vzorku k tomu, že tento příkaz / vložení nebude 

ce s neobsazenými identifikačními čísly (ID) vzorků, dojde v 
čítko Next, k zahájení konfirmačního dialogu. 

 

Vlastnosti a jmenná omezení kategorií údajů o vzorku  

Nepovinné Charakter omezení Speci
znaky

Velké písemno následované 
jednomístnou anebo dvoumístnou 

číslicí (např. A3, D11 atd.) 

Nepoužito

0 nebo 11 Nepoužito

idává se Nepoužito Nepoužit

50 

50 

50 

í ty, které v zázvech souborů nejsou povoleny (\|:*?”<>|) 

íky které žádnou substrukturu nemají, jsou výrobcem definovány jako 
ip 0; MSP BigAnchorChip™ 96 a MTP BigAnchorChip™ 384 T F charakterizují 

ních míst na Čipu 1, jež lze použít jako validační pozici.

ase pomocí softwaru MALDI 
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Vkládané ID 
i importuje z určitého 

eneseny z tabulkového procesoru, 
/ vložení nebude 

, dojde v 
 

Speciální 
znaky* 

Nepoužito 

Nepoužito 

Nepoužito 

Ne 

Ne 

Ano 

|:*?”<>|)  

íky které žádnou substrukturu nemají, jsou výrobcem definovány jako 
384 T F charakterizují 

ní pozici. 
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Povinné a nepovinné údaje 

Kolonky se záhlavím Name a Description obsahují nepovinné údaje; doporučujeme 
však použít nejméně jedno jméno (Name) analyzovaného vzorku. V módu 
sekvenčního ukládání, jsou v případě prázdných názvů (Names) do nich automaticky 
ukládány údaje vložené do kolonky Pozice. 

Omezení počtu znaků   

Velikost údajů vkládaných do kolonek Name, ID a Description je omezena počtem 50 
znaků. Manuálně nelze vložit více než 50 znaků. Při načítání z čárového kódu budou 
řetezce údajů vkládaných do kolonek Name, ID anebo Description zkráceny a po 50. 
znaku již nebudou zobrazeny. 

Při importu dat ze souboru XML anebo při jejich přenášení z tabulky dojde také k 
tomu, že importovaný/přenášený příkaz nebude proveden v tom případě, že délka 
řezězce ID anebo Name překročí hranici 50 znaků. V kolonce Description bude delší 
text bez jakéhokoli upozornění  zkrácen taktéž na 50 znaků. 

Speciální znaky 

Speciální znaky a znaky, které v názvech souborů nelze použít (\|:*?”<>|), nemohou 
být použity ani v řetězcích kategorií ID anebo Name. Při manuálním vkládání dat 
anebo při načítání z čárového kódu jsou tyto speciální znaky bez bez jakéhokoli 
upozornění  rovněž vypuštěny.  

Při importu dat ze souboru XML anebo při jejich kopírování z tabulky nebude 
importovaný/kopírovaný příkaz proveden v tom případě, že název nebo identifikační 
číslo (Name or ID) analytu budou obsahovat některý z výše uvedených speciálních 
znaků. 

2.5.1.3  Přímé vkládání údajů o vzorku 

Cílové pozice, k nimž mají být údaje o vzorku přiřazeny, je třeba vybrat na cílovém 
displeji stránky Analyte Placement. Pro zvolené cílové pozice lze údaje o vzorku 
vložit přímo z klávesnice. 

Poznámka: Vkládané údaje musí respektovat omezení týkající se délky řetězce 
a používání speciálních znaků (viz část  2.5.1.2). 
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Volba cílové pozice pomocí myši 
V následující tabulce je popsán způsob, jenž lze použít pří výběru cílových pozic. 
Modrý čtvereček oznamuje, že určitá pozice byla vybrána. 

Myš Funkce 

Kliknutí levým tlačítkem na pozici (např. A5) Exkluzivní výběr pozice. 

Kliknutí levým tlačítkem na písmeno řádku (např. 
A) 

Exkluzivní výběr všech pozic v 
řádku. 

Kliknutí levým tlačítkem  na název sloupce (např. 
5) 

Exkluzivní výběr všech pozic ve 
sloupci. 

Kliknutí levým tlačítkem na rolující text 
(marquee) a jeho přetažení 

Exkluzivní výběr všech pozic v 
rolujícím textu. 

Podržení Ctrl + kliknutí levým tlačítkem na 
určitou pozici 

Přidání pozice do výběru. 

Podržení Ctrl + kliknutí levým tlačítkem na název 
řádku  

Přidání všech pozic v řádku do 
výběru. 

Podržení Ctrl + kliknutí levým tlačítkem na název 
sloupce 

Přidání všech pozic ve sloupci do 
výběru. 

Podržení Ctrl + kliknutí levým tlačítkem na 
rolující text a jeho potažení 

Přidání všech pozic v obdélníčku 
řádku do výběru. 

Kliknutí levým tlačítkem  mezi pozice Zpětný výběr všech pozic. 

 

Příklad: Vybrání řádku A kliknutím levého tlačítka myši na A. 
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Možnosti přímého vložení údajů

a. Zvolte příslušné cílové pozice

(nacházející se v modrém obdéln

Add Samples (přidat vzorky)

b. Zvolte cílové pozice a na klávesnici stiskn

Vybrané cílové pozice jsou aktivními (na cílovém displeji se objeví bílý indika
kroužek). 

Příkazy Pozice a Chip jsou u všech aktivovaných cílových pozic 
vygenerovány a vloženy do tabulky vzork
také automaticky uloží datum jeho vytvo
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ímého vložení údajů o vzorku 

íslušné cílové pozice, klikněte pravým tlačítkem na kteroukoli z nich 

(nacházející se v modrém obdélníčku) a z kontextového menu vyberte p

idat vzorky).  

na klávesnici stiskněte tlačítko Insert (vlož). 

Vybrané cílové pozice jsou aktivními (na cílovém displeji se objeví bílý indika

 

jsou u všech aktivovaných cílových pozic automatic
vloženy do tabulky vzorků. Při uložení projektu do databáze se 

také automaticky uloží datum jeho vytvoření (Creation Date). 

ase pomocí softwaru MALDI 
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ítkem na kteroukoli z nich 

z kontextového menu vyberte příkaz 

Vybrané cílové pozice jsou aktivními (na cílovém displeji se objeví bílý indikační 

automaticky 
i uložení projektu do databáze se 
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2. Požadované identifikátory vzorku p

3. Do sloupců Name a Description

údaj). 

Obsah tabulky lze zkopírovat a p
nacházejí  ve sloupcovém záhlaví kontextových menu
pravého tlačítka na záhlaví sloupc
procedury programu Microsoft Windows GUI.

4. Jakmile je vkládání dat ukonč

stránku výběru metod programu MALDI Biotyper (

Methods). 

a. Jestliže existují pozice s neobsazenými identifika
v okamžiku, kdy je kliknuto na tla

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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kátory vzorku přidejte do sloupce ID. 

Description přidejte všechny potřebné deskriptory (nep

Obsah tabulky lze zkopírovat a přenést pomocí příkazů Copy a Paste, 
ve sloupcovém záhlaví kontextových menu (tato se zpřístupní kliknutím 

tka na záhlaví sloupců). Tyto operace probíhají jako standardní 
Microsoft Windows GUI. 

Jakmile je vkládání dat ukončeno, klikněte  na  tlačítko Next, čímž  přejdete na 

ru metod programu MALDI Biotyper (Selection of MALDI Biot

ce s neobsazenými identifikačními čísly (ID) vzork
v okamžiku, kdy je kliknuto na tlačítko Next, k zahájení konfirmačního dialogu

omocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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nepoviný 

, které se 
ístupní kliknutím 

yto operace probíhají jako standardní 

ejdete na 

Selection of MALDI Biotyper 

) vzorků, dojde 
ního dialogu. 
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b. Kliknutím na tlačítko Yes 

projektu a otevřete stránku 

c. Kliknutím na tlačítko No se vrátíte na stránku 

vložíte chybějící ID vzorku

d. Jakmile je ukládání dat ukon

stránce výběr metod (Selection of MALDI Biotyper Methods

2.5.1.4  Načítání údajů o vzorku z 

Údaje o vzorku lze z čárových kód
postupného vkládání dat (Sequential Insert Mode

Poznámka Vkládané údaje musí respektovat ta omezení, která se týkají 
délky řetězce a používání speciálních znak

Čtečku čárového kódu lze považovat za druhou klávesnici
který je na klávesnici napsán, mů
kódu. 

Standardní aplikace čtečky čárových kód
označit svým valstním (jedinečným)
sekvenčního modu vkládání (viz č
tak, že se čárové kódy vzorků skenují striktn

Chcete-li údaje o vzorcích číst z 
vkládání (Sequential Insert Mode

1. Kliknutím levého tlačítka myši zvolte pot

cílovém displeji pozice vzorku

Tato pozice je nyní označ
obdélníček). 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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 vymažete v prázdném ID všechny aktivní pozice 

ete stránku Project Summary (souhrn projektu).  

se vrátíte na stránku Analyte Placement a poté 

vzorku. 

Jakmile je ukládání dat ukončeno, klikněte  na  tlačítko Next a pokračujte na 

Selection of MALDI Biotyper Methods).  

 o vzorku z čárových kódů 

árových kódů načíst pomocí čtečky a pracovního modu 
uential Insert Mode).  

údaje musí respektovat ta omezení, která se týkají 
ězce a používání speciálních znaků (viz část  2.5.1.2)

árového kódu lze považovat za druhou klávesnici. Každý textový 
ici napsán, může být vložen i naskenováním příslušného č

čárových kódů je určena pro ty vzorky, které pot
čným) ID. Toro označení lze snadno provést př
viz část  2.5.1.1), v němž je seznam vzorků vypl
ů skenují striktně podle pořadí, v němž byly přípraveny

číst z čárových kódů za použití modu sekvenč
Sequential Insert Mode), učiňte následující kroky:  

ítka myši zvolte potřebnou výchozí pozici (např. A1) na 

pozice vzorku (Sample Position).  

ato pozice je nyní označena jako pozice vybraná (výběr indikuje modrý 

ase pomocí softwaru MALDI 
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všechny aktivní pozice 

poté 

čujte na 

ky a pracovního modu 

údaje musí respektovat ta omezení, která se týkají 
2.5.1.2). 

Každý textový řetězec, 
íslušného čárového 

ena pro ty vzorky, které potřebují 
ení lze snadno provést při použití 

ů vyplňován 
řípraveny. 

 za použití modu sekvenčního 

na 

kuje modrý 
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2. Pravým tlačítkem klikněte na vybrané pozice 

modus sekvenčního vkládání

Vybraná cílová pozice je pomocí bílého kroužku ozna
do seznamu, který je zobrazen na náhledu tabulky
políčku (Pozice) je automatic
změnit). Textový  kurzor se v polí

3. Oskenujte ID prvního vzorku pomocí 

čárovým kódem je velmi výhodné a doporu

Nejsou-Ii čárové kódy k dispozici
pozic. 

4. Pokračujte ve skenování čárových kód

vzorcích. 

5. Jakmile je ukládání údajů o vzorku ukon

Tím se otevře níže uvedený k
čárového kódu přeskočí kurzor automaticky na ten nový 
(neobsazené) ID vzorku. 

6. Abyste přešli na stránku výbě

klikněte  na nabídku Yes. 

2.5.1.5  Kopírování a vkládání dat z tabulkového procesoru

Údaje o vzorku lze kopírovat a vkládat také z tabulkových procesor
Microsoft Excel.  

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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te na vybrané pozice a vyberte v kontextovém menu 

ního vkládání (Sequential Insert Mode).  

Vybraná cílová pozice je pomocí bílého kroužku označena jako aktivní a je p
do seznamu, který je zobrazen na náhledu tabulky. Hodnota uvedená v pozi

automaticky zkopírována do políčka jméno (Name) 
se v políčku objeví až pro vložení ID vzorku. 

prvního vzorku pomocí čtečky čárových kódů (používání vzork

e velmi výhodné a doporučuje se).  

árové kódy k dispozici, lze je také oskenovat ze seznamu cílových 

čárových kódů tak dlouho, až jsou vloženy údaje o všech 

 o vzorku ukončeno, klikněte  na  nabídku Next. 

e níže uvedený konfirmační dialog. Po oskenování posledního 
í kurzor automaticky na ten nový řádek, který má prázné 

 

ešli na stránku výběru metod (Selection of MALDI Biotyper Methods

írování a vkládání dat z tabulkového procesoru 

Údaje o vzorku lze kopírovat a vkládat také z tabulkových procesorů, např. z programu 
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vyberte v kontextovém menu 

ena jako aktivní a je přidána 
ná v pozičním 

) (lze ji ale 

používání vzorků s 

lze je také oskenovat ze seznamu cílových 

 tak dlouho, až jsou vloženy údaje o všech 

.  

Po oskenování posledního 
který má prázné 

LDI Biotyper Methods), 

ř. z programu 
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Poznámka Vkládané údaje musí respektovat ta 
délky řetězce a používání speciálních znak

 

Pro kopírování a vkládání dat z tabulkového procesoru
následující kroky: 

1. Otevřete vhodný inputový soubor v tabulkovém procesoru

Tento inputový soubor by m
uspořádání: Pozice (pozice -
sloupec C), ID (identifikační č
Je-li projekt v běhu, bude datum vytv
zcela automaticky. 

2. Pak vyberte ty buňky, které obsahují údaje o vzorku

                                                           
2 Ty MALDI terčíky, které žádnou substrukturu nemají, jsou výrobcem definovány 
jako Čip 0; MSP BigAnchorChip™ 96 a MTP BigAnchorChip™ 384 T F 
charakterizují substrukturu tzv. kalibra
validační pozici. 
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údaje musí respektovat ta omezení, která se týkají 
ězce a používání speciálních znaků (viz část  2.5.1.2)

írování a vkládání dat z tabulkového procesoru je třeba provéstt 

ete vhodný inputový soubor v tabulkovém procesoru. 

bor by měl obsahovat potřebné informace v následujícím 
- sloupec A), Chip2 (čip – sloupec B), Name

ční číslo – sloupec D) a Description (popis – sloupec
hu, bude datum vytvoření (Creation Date) přidáno programem 

ky, které obsahují údaje o vzorku.  

 

íky, které žádnou substrukturu nemají, jsou výrobcem definovány 
ip 0; MSP BigAnchorChip™ 96 a MTP BigAnchorChip™ 384 T F 

rakterizují substrukturu tzv. kalibračních míst na Čipu 1a lze je použít jako 
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omezení, která se týkají 
2.5.1.2). 

eba provéstt 

ebné informace v následujícím 
Name (název – 

sloupec E). 
idáno programem 

íky, které žádnou substrukturu nemají, jsou výrobcem definovány 

ipu 1a lze je použít jako 
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3. Chcete-li vybrané údaje do schránky

Ctrl+C anebo na výbrané údaje klikn

menu programu schránky zvolte p

4. Na stránce Analyte Placement

na náhled prázdné tabulky a v kontextovém menu zvolte p

příkazem kopírované údaje do tabulky vložíte

Vybrané cílové pozice se tak stanou aktivními 
označeny bílým kroužkem) a 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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li vybrané údaje do schránky přidat, stiskněte  buď kombinaci tlačítek 

anebo na výbrané údaje klikněte pravým tlačítkem myši a v kontextovém 

menu programu schránky zvolte příkaz Copy. 

Analyte Placement v Průvodci programem, klikněte pravým tla

na náhled prázdné tabulky a v kontextovém menu zvolte příkaz Paste; tímto 

íkazem kopírované údaje do tabulky vložíte.  

 

Vybrané cílové pozice se tak stanou aktivními (na cílové obrazovce budou 
 údaje o vzorku budou vloženy do zobrazené tabulky

softwaru MALDI 
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čítek 

v kontextovém 

te pravým tlačítkem 

tímto 

na cílové obrazovce budou 
údaje o vzorku budou vloženy do zobrazené tabulky. 
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a. Jestliže kopírovaná data porušují n

část  2.5.1.2), objeví se chybové hlášení

b. Klikněte  na  Yes v nabídce 

u některých dat nedošlo k nedodržení požadavk

speciálních znaků).  

c. Chcete-li data opět vložit, opakujte kroky 

5. Jakmile je ukládání dat vzorku ukon

nabídku Next a tím postoupíte na stránku volby metod (

Biotyper Methods). 

a. Je-li na aktivních pozicích prázdné identi

ID), klikněte  na tlačítko Next

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Jestliže kopírovaná data porušují některá z omezení týkajících se vzork

e chybové hlášení.  

v nabídce dialogu a v tabulkovém procesoru zkontrolujte zda 

kterých dat nedošlo k nedodržení požadavků (tj. >50 znaků či použití 

t vložit, opakujte kroky 2 a 3. 

ádání dat vzorku ukončeno, klikněte  v Průvodci programem na 

a tím postoupíte na stránku volby metod (Selection of MALDI 

li na aktivních pozicích prázdné identifikační číslo vzorku  (empty sample 

Next a otevře se následující konfirmační dialog. 

ase pomocí softwaru MALDI 
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která z omezení týkajících se vzorků (viz 

v tabulkovém procesoru zkontrolujte zda 

použití 

vodci programem na  

Selection of MALDI 

empty sample 

dialog.  



Bruker Daltonik GmbH 

 

MALDI Biotyper 3.0 User Manual Revision 2
 

b. Kliknutím  na  nabídku Yes

prázdnými ID a otevřete stránku 

c. Kliknutím  na  nabídku No

stávající definice vzorku provedete tak, že v nabídce kontextového menu na 

displeji zvolíte příkaz Clear

d. Zkontrolujte, zda v datech tabulkového procesoru nechybí identifika

vzorků a zopakujte kroky 

e. Jakmile je ukládání dat o vzorku ukon

Průvodci přejdete na stránku volby metod (

Methods). 

2.5.1.6  Import údajů o vzorku ze soubo

Üdaje o vzorku lze ze souboru XML importovat.

Poznámka  Vkládané údaje musí respektovat ta omezení, která se týkají délky 
řetězce a používání speciálních znak

. 

Poznámka    Postup při 
projektu pomocí tla

  

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Yes vymažete z projektu všechny aktivní pozice s 

ete stránku Project Summary.  

No se vrátíte na stránku Analyte Placement. Vymazání 

vající definice vzorku provedete tak, že v nabídce kontextového menu na 

Clear.  

Zkontrolujte, zda v datech tabulkového procesoru nechybí identifikační 

 2 a 3; tím údaje znovu vložíte. 

í dat o vzorku ukončeno, klikněte na nabídku Next,

ejdete na stránku volby metod (Selection of MALDI Biotyper 

 o vzorku ze souboru XML  

Üdaje o vzorku lze ze souboru XML importovat.  

údaje musí respektovat ta omezení, která se týkají délky 
zce a používání speciálních znaků (viz část  2.5.1.2)

ři importování dat vzorku není stejný jako při vytvá
projektu pomocí tlačítka Import… v Průvodci (viz část  

ase pomocí softwaru MALDI 
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ní pozice s 

Vymazání 

vající definice vzorku provedete tak, že v nabídce kontextového menu na 

ční čísla 

, čímž v 

Selection of MALDI Biotyper 

údaje musí respektovat ta omezení, která se týkají délky 
2.5.1.2). 

ři vytváření 
 2.6). 
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Struktura XML souboru použitého pro 

Struktura příslušného XML souboru je velmi jednoduchá

Pro každou připravenou pozici 
element dceřinný (child element
sloupců tabulky se používají tzv. a

Kategorie dat vzorku 

Pozice 

Čip 

Název 

ID 

Popis 

 

Tento způsob importu údajů o pozici vzorku je t
pracovním postupu, při němž jsou 
programem zcela automaticky. 
pouze jednotlivé kroky tvorby projektu a selekce 

Import údajů o vzorku ze souboru 

1. Na stánce Analyte Placement

tlačítko myši prázdnou tabulku 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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souboru použitého pro import dat 

souboru je velmi jednoduchá.  

ipravenou pozici obsahuje sekvence kořenového elementu také 
child element), který je označen jako pos. K definování obsahu 

 tabulky se používají tzv. atributy (spot, chip, samplename atd.; viz níže

XML pos atribut 

spot 

chip 

samplename 

identifikátor vzorku 

popis 

ů o pozici vzorku je třeba použít při poloautomat
mž jsou importované XML soubory vytvářeny 

. Znamená to tedy, že interaktivně jsou provád
pouze jednotlivé kroky tvorby projektu a selekce XML souboru. 

 o vzorku ze souboru XML  

Analyte Placement v Průvodci programem zobrazíte kliknutím na pravé 

ítko myši prázdnou tabulku a v kontextovém menu zvolíte nabídku Import

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 

Strana 43 

 

enového elementu také 
K definování obsahu 
atd.; viz níže).  

automatickém 
eny externím 

 jsou prováděny 

vodci programem zobrazíte kliknutím na pravé 

Import. 
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2. V otevřeném dialogu (Open dialog

na  nabídku Open.  

Tím jsou importovány údaje o souboru 
target pozices) se stanou aktivními 
indikačním kroužkem). 

Nesplňují-li importovaná data ta omezení, která se údaj
2.5.1.2), objeví se chybové hlášení
souboru XML zkontrolujte p
znaků). Opakováním kroků 1 a

3. Jestliže se na stránce volby metod (

a. nachází po kliknutí na nabídku 

číslo vzorku  (empty sample 

2  Klasifikace v reálném čase pomocí softwaru
Biotyper Realtime Classification  (RTC)
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dialog) zvolte odpovídající XML soubor a poté klikn

ovány údaje o souboru XML a zvolené cílové pozice (
) se stanou aktivními (na cílovém displeji budou zvýrazně

li importovaná data ta omezení, která se údajů o vzorku týkají 
objeví se chybové hlášení. V dialogu klikněte  na nabídku 

souboru XML zkontrolujte případné chyby (>50 znaků; použití speci
1 a 2 jsou pak data reimportována. 

Jestliže se na stránce volby metod (Selection of MALDI Biotyper Methods

nachází po kliknutí na nabídku Next na aktivních pozicích prázdné identi

empty sample ID), otevře se následující konfirmační dialog. 

ase pomocí softwaru MALDI 
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poté klikněte  

a zvolené cílové pozice (selected 
na cílovém displeji budou zvýrazněny bílým 

 o vzorku týkají (viz část  
te  na nabídku Yes a v 

speciálních 

Selection of MALDI Biotyper Methods). 

na aktivních pozicích prázdné identifikační 

dialog.  
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b. Kliknutím na  nabídku Yes

prázdným ID a otevře se stránka 

c. Kliknutím na nabídku No 

kontextovém menu cílového displej

stávající definici vzorku.  

d. Zkontrolujte, zda v souboru 

zpakováním kroků 1 a 2 prove

e. Jakmile je vkládání údajů o vzorku ukon

v Průvodci přejdete na stránku volby metod (

Methods). 

2.5.1.7  Editace údajů o vzorku

Editace obsahu náhledu tabulky

Měnit lze pouze obsah sloupců Name

Prvním kliknutím myši vyberete text v p
nového textu dojde k přepsání jejího obsahu

Druhým kliknutím myši navedete kurzor
jakýkoli nový text. 

Editaci obsahu buňky ukončíte stisknutím tla
dolů do další buňky, která  se ve vybraném sloupci
obsah buňky a vložením jakéhokoli nového textu dojde k p

Třídění obsahu tabulky 

Tabulky lze třídit podle hodnot, kter
sloupcích, kliknutím na záhlaví př
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Yes budou z projektu vymazány všechny pozice s 

e se stránka Project Summary.  

 se vrátíte na stránku Analyte Placement; v 

kontextovém menu cílového displeje pak zvolte nabídku Clear a tím vymažete 

 

Zkontrolujte, zda v souboru XML nechybí identifikační čísla vzorků a 

proveďte reimport dat. 

Jakmile je vkládání údajů o vzorku ukončeno, klikněte  na  nabídku Next

ejdete na stránku volby metod (Selection of MALDI Biotyper 

 o vzorku 

ky 

Name, ID a Description. 

vyberete text v příslušné buňce tabulky. Vložením jakéhokoli 
epsání jejího obsahu. 

kliknutím myši navedete kurzor do textu. Na pozici kurzoru pak bude vložen 

číte stisknutím tlačítka Return. Kurzor přeskočí sm
ky, která  se ve vybraném sloupci nachází. Tím je vybrán úplný 

ky a vložením jakéhokoli nového textu dojde k přepsání textu stávajícího

ídit podle hodnot, které jsou uvedeny v jednotlivých specific
sloupcích, kliknutím na záhlaví příslušného sloupce. Chcete-li pořadí údajů ve sloupci 
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ce s 

v 

a tím vymažete 

Next, čímž 

Selection of MALDI Biotyper 

Vložením jakéhokoli 

Na pozici kurzoru pak bude vložen 

eskočí směrem 
ím je vybrán úplný 

u stávajícího. 

specifických 
ů ve sloupci 



Bruker Daltonik GmbH 

 

MALDI Biotyper 3.0 User Manual Revision 2
 

uvést obráceně (tj. odshora dolů
Měněný sloupec a způsob třídění je v jeho zá

2.5.1.8  Vymazání údajů o vzorku z cílových pozic

Údaje o vzorku lze vymazat tak,  že na cílovém displeji zvolíte data nacházející se na 
příslušné cílové pozici; pak kliknutím pravého tla
analyzované vzorky (Delete Analytes
odstraníte. 

{b}Poznámka{/b} Údaje o vzorku lze vymazat pouze z t
které nebyly měřeny (

Údaje o vzorku lze vymazat ze 
tlačítkem myši na cílový displej a v kontextovém menu zvolíte nabídku 
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 (tj. odshora dolů nebo naopak), klikněte na záhlaví sloupce znovu
ění je v jeho záhlaví označen symbolem � či �

ů o vzorku z cílových pozic 

Údaje o vzorku lze vymazat tak,  že na cílovém displeji zvolíte data nacházející se na 
liknutím pravého tlačítka myši na nabídku 

Delete Analytes) tato vybraná data z kontextového menu 

 

Údaje o vzorku lze vymazat pouze z těch cílových pozic, 
(zvýrazněno bílým indikačním kroužkem). 

Údaje o vzorku lze vymazat ze všech cílových pozic, a to tak, že kliknete pravým 
ítkem myši na cílový displej a v kontextovém menu zvolíte nabídku Clear.
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te na záhlaví sloupce znovu. 
�. 

Údaje o vzorku lze vymazat tak,  že na cílovém displeji zvolíte data nacházející se na 
ítka myši na nabídku vymaž 

tato vybraná data z kontextového menu 

ch cílových pozic, 

liknete pravým 
. 
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2.5.1.9  Definování validač

Uživatel si může vybrat tu cílovou pozici, na níž bude 
validační procedura provedena ješt

Kalibrace a validační procedur
standarního bakteriálního testu
#255343). Tento standard je v podstat
horním hmotovém rozmezí napíchnut spolu s dv
je umožněna kalibrace v hmotovém rozmezí

Validační pozici lze také vybrat pohybem sm
Validation Pozice na stránce 
validační krok vynechává. Valida
bílým indikačním kroužkem). 
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ční pozice 

brat tu cílovou pozici, na níž bude automatická kalibra
provedena ještě před zahájením klasifikačního procesu. 

procedura se provedou na cílové pozici obsahující vzorek 
ndarního bakteriálního testu (Bruker Bacterial Test Standard; Bruker výr. 

je v podstatě preparátem kmene E. coli DH5α, který byl v 
horním hmotovém rozmezí napíchnut spolu s dvěma dalšími proteiny; tímto opat

ce v hmotovém rozmezí 4 až 17 kDa. 

lze také vybrat pohybem směrem dolů přes seznam nabídek 
na stránce Analyte Placement. Volbou příkazu None

. Validační pozice musejí být aktivní (aktivace je zvýrazn
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alibrace a 
 

obsahující vzorek 
; Bruker výr. č. 

který byl v 
tímto opatřením 

es seznam nabídek 
None se pak 

aktivace je zvýrazněna 
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Výrobcem nastavená validační pozice je stejná jako pozice, která byla použita při 
posledním klasifikačním procesu. Je.li tato pozice inaktivní, je validační pozice 
definována jako první aktivní pozice. 

Při prvním otevření stránky Analyte Placement (tj. v okamžiku, kdy žádná z pozic 
není aktivní), není v boxu obsahzujícím seznam zobrazena žádná pozice a proto ji ani 
nelze vybrat. 

{b}Poznámka{/b} Přesvědčte se o tom, že testovací standard (Bruker 
Bacterial Test Standard) byl připraven v té pozici, v níž bude k validaci 
použit.  
Doporučuje se používat stále tu pozici, která odpovídá validační pozici pro 
všechny MALDI terčíky (např. A1:0). 
Je-li klasifikační běh přerušen anebo zrušen ještě před dokončením 
validace, je třeba validační pozici definovat znovu. 

2.6  Vytvoření projektu pomocí tlačítka Import…  

Nový klasifikační projekt lze v Průvodci programem MALDI Biotyper RTC vytvořit 
kliknutím na tlačítko Import… na stránce Definition of Project (viz část 2.4). 

Tato importní funkce je klávesovou zkratkou sloužící pro vytvoření projektu a pro 
přidání údajů o vzorku na stránku Analyte Placement; tyto údaje jsou importovány 
pomocí externě vytvořené definice terčíku (označované také jako 'klasifikační zadání - 
classification job'). 

V klasifikačním zadání jsou údaje o vzorku definovány v souboru znakově 
separovaných hodnot (character-separated values - CSV), který je generován buď 
pomocí nanášecího robota (spotting robot) nebo nebo LIMS.  

{b}Poznámka{/b} Vytvoření projektu pomocí tlačítka Import… v průvodci 
programem není totožné s importováním  údajů o vzorku ze souboru XML 
na stránce Analyte Placement (viz část 2.5.1.6). 

2.6.1  CSV (Classification Job) soubory 

Minimální soubor klasifikačního zadání (CSV file) musí obsahovat údaj o pozici 
(Positions) vzorku a o jeho odpovídajícím identifikačním čísle (ID), jež jsou od sebe 
odděleny středníkem; každá pozice se nachází na samostatném řádku.  
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Původně nastavená konfigurace předpokládá, že se pozice vzorku (Position) nachází 
v prvním sloupci a že ID vzorku je ve sloupci druhém (pozice terčíku je použita také 
jako název vzorku - Sample Name).  

Tak například soubor klasifikačního zadání CSV definujícího identifikační čísla pozic 
vzorků ID A1–A12 určitého terčíku mohou vypadat následovně: 

A1;XY00001-1 
A2;XY00002-1 
A3;XY00003-1 
A4;XY00004-1 
A5;XY00005-1 
A6;XY00006-1 
A7;XY00007-1 
A8;XY00008-1 
A9;XY00009-1 
A10;XY00010-1 
A11;XY00011-1 
A12;XY00012-1 

Doplňující údaje, např. názvy či popisy (Sample Names or Sample Descriptions) 
analytu mohou být připojeny ke každému řádku. Každá kategorie přitom musí být 
oddělena středníkem.  

Poznámka: Data musejí odpovídat omezením týkajícím se délky řetězce a 
používání speciálních znaků (viz část 2.5.1.2). 

Pojmenování souboru klasifikačního zadání  

Je-li projekt vytvořen pomocí tlačítka Import… v průvodci programem, použije se 
název souboru klasifikačního zadání jako název projektu (Project Name). Maximální 
cělka názvu projektu (Project Name) činí 50 znaků. 

Název souboru klasifikačního zadání má mít příponu “.in”. 

Tip Pro pojmenování souborů klasifikačních zadání se doporučuje používat 
následující schéma: <datum>_<jméno nebo iniciály operátora 
>_<sekvenční číslo >_<target ID> Syntax: rrrrmmdd_ABC_01_01234, 
např. 20081208_JKB_02_01234.in. 
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Lokalizace souborů klasifikačních zadání

Soubory klasifikačních zadání“.in
který  je do registru zadán v průbě

2.6.2  Import údajů o vzorku ze souboru 

Chcete-li importovat údaje o vzorku ze souboru 

1. Klikněte na okénko Import… 

2. V dialogu o importu projektu  

které se nachází vpravo od polí

které jsou v daném okamžiku v

část Příloha D).  

3. Požadovaný soubor zvolte tak, že na n

Jméno souboru přitom bude použito i jako název projektu (

4. Identifikátor osoby vytvářející projekt

(Creator) je systémem navržen

zalogováno do Windows = uživatel), lze jej ale i zm

Popis projektu (nepovinný údaj
Description). 
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čních zadání 

.in” by měly být ukládány do importního 
ůběhu instalace softwaru (viz část Příloha D). 

ů o vzorku ze souboru CSV  

ovat údaje o vzorku ze souboru CSV:  

 na stránce  definice projektu (Definition of Project)

 (Import Project) klikněte na tlačítko drop-down

které se nachází vpravo od políčka Name; tak se zobrazí všechny CSV soubory, 

daném okamžiku v designovaném importním adresáři dostupné

 

te tak, že na něj prostě kliknete.  

itom bude použito i jako název projektu (Project Name)

ející projekt vložte do políčka Creator. Tvůrce projektu 

je systémem navržen automaticky (jméno uživatele je současně

živatel), lze jej ale i změnit.  

nepovinný údaj) lze vložit do políčka popis projektu (
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 adresáře, 
 

Project). 

down,  

soubory, 

dostupné (viz 

). 

rce projektu 

asně 

ka popis projektu (Project 
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5. Chcete-li se v Průvodci vrátit zpět na stánku definice projektu (Definition of 

Project), klikněte  na nabídku OK.  

Název souboru CSV je pak přidán do políčka název projektu (Project Name) na 
stránce definice projektu (Definition of Project). 

6. Kliknutím na tlačítko Next budete imporiovat  data z vybraného souboru CSV a 

v Průvodci programem postoupíte na stránku Selection of MALDI Biotyper 

Methods (viz část 2.7). 

Poznámka: Stránka Analyte Placement průvodce je pak automaticky doplněna 
ze vstupního souboru a nebude už možno do ní vstoupit. 

a. Jestliže soubor CSV obsahuje pozici s prázdným vzorkem anebo neodpovídají-

li vstupní údaje příslušným omezením (viz část 2.5.1), objeví se chybové 

hlášení a projekt nebude importován.  

b. V dialogu klikněte na tlačítko Yes a zkontrolujte jak identifikační číslo vzorku, 

tak také to, zda jsou dodrženy požadavky na formát dat (>50 znaků; používání 

speciálních znaků).  

c. Chcete-li data reimportovat, zopakujte kroky 1 až 6. 

2.7  Definování projektových metod 

Stránka výběru selekčních metod programu MALDI Biotyper (Selection of MALDI 
Biotyper Methods) se používá k definování podrobností týkajících se procesu 
klasifikace hlavního spektra (MSP). Obecně lze říci, že tovární nastavení poskytuje 
uspokojivé výsledky a že tedy lze tuto stránku kliknutím na nabídku Next přeskočit a 
v Průvodci programem pokračovat až na stránce shrnutí projektu (Project Summary). 



Bruker Daltonik GmbH 

 

MALDI Biotyper 3.0 User Manual Revision 2
 

Inputové políčko Fun

Metoda předběžné 
přípravy 

Defin
(peak list

Metoda identifikace MSP Defin
spektra vzorku s
v databázi

Zdroj MSP  Defin
použita

• MSP z knihovny 

spekter 

Vybere ze seznamu jednotlivé požadované knihovny 
(mnohonásobná selekce je možná po stisknutí klávesy 
CTRL)

• MSP z taxonomického 

dendrogramu  

Vybere ze seznamu požadovaný 
dendrogram

• Všechna MSP Klasifikace
MSP
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Funkce 

Definuje metodu použitou k vytvoření seznamu pík
peak list) na základě hrubých dat.  

Definuje metodu použitou k porovnání seznamu pík
spektra vzorku s referenčními vzory (MSPs) obsaženými 
v databázi. 

Definuje ta hlavní spektra, která budou pro klasifikaci 
použita. 

Vybere ze seznamu jednotlivé požadované knihovny 
nohonásobná selekce je možná po stisknutí klávesy 

CTRL) 

Vybere ze seznamu požadovaný taxonomický 
dendrogram (vybrán ale může být pouze jeden jediný

Klasifikace je provedena za použití všech dostupných 
MSP (včetně nepřiřazených). 
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ení seznamu píků 

porovnání seznamu píků 
obsaženými 

ta hlavní spektra, která budou pro klasifikaci 

Vybere ze seznamu jednotlivé požadované knihovny 
nohonásobná selekce je možná po stisknutí klávesy 

že být pouze jeden jediný). 

je provedena za použití všech dostupných 
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2.8  Kontrola nastavení p

Stránka Projekt Summary se používá ke kontrole nastavení momentálního 
klasifikačního projektu a ke spušt
přehled o hlavních parametrech procesu klasifikace programem 

2.9  Zrušení nastavení 

Nastavení projektu lze zrušit z kterékoli stránky Pr
RTC. 

Chcete-li  zrušit nastavení projektu:

1. Klikněte nabídkou Cancel na kteroukoli ze stránek Pr

Biotyper RTC. 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Kontrola nastavení projektu 

se používá ke kontrole nastavení momentálního 
ke spuštění klasifikačního procesu. Tato stránka poskytuje 

procesu klasifikace programem MALDI Biotyper.

 

Zrušení nastavení projektu 

kterékoli stránky Průvodce programem MALDI Biotyper 

zrušit nastavení projektu: 

na kteroukoli ze stránek Průvodce programem 
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se používá ke kontrole nastavení momentálního 
o stránka poskytuje 

MALDI Biotyper. 

MALDI Biotyper 

vodce programem MALDI 
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Po tomto kliknutí se objeví níže uvedený k

• Kliknutím na No se vrátíte zp

Biotyper RTC. 

• Kliknutím na Yes Průvodce

Poznámka: Zrušení setup
do projektu vložených (s výjimkou údaj
projektu a tv
Creator). Projekty, které již 
vymazat (viz

2.10  Vymazávání projekt

Projekty,  které již byly zrušeny 
nelze ty projekty, které již obsahu

Chcete-li zrušený projekt z databáze vymazat

1. Zvolte buď nabídku File > New 

2. Přejděte na stránku Definition of 

3. Požadovaný  projekt zvolte buď

a. výběrem jeho názvu (Project

anebo  

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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Po tomto kliknutí se objeví níže uvedený konfirmační dialog.  

 

se vrátíte zpět na stránky Průvodce programem MALDI 

vodce uzavřete a vrátíte se do zdrojové aplikace. 

setupu projektu bude mít za následek ztrátu všech dat 
do projektu vložených (s výjimkou údajů název projektu, popis 
projektu a tvůrce projektu Project Name, Project Description

Projekty, které již byly zrušeny, lze z databáze 
viz část 2.10). 

rojektů 

yly zrušeny (viz část 2.9), lze z databáze vymazat. Vymazat ale 
které již obsahují klasifikační údaje,. 

databáze vymazat 

File > New Classification anebo klikněte na . 

Definition of Project. 

zvolte buď: 

Project Name) v sestupném seznamu 
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MALDI 

 

bude mít za následek ztrátu všech dat 
 název projektu, popis 

Description a 
databáze 

Vymazat ale 
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b. kliknutím na nabídku Open Tree

klikněte na OK. 

Použití nabídky Open Tree

databázi řetezce názvů projekt

příslušný box, vložte vyhledávací filtr 

anebo ID relevantní řetězce obsahují

Tip K vyhledání řetězce v
karty (*). Tak např
zobrazeny všechny náz

4. Kliknutím na Delete zvolený projekt

Tlačítko Delete je inaktiv
klasifikační data.  

2.11  Spuštění klasifika

Klasifikační proces lze spustit z
Biotyper RTC (s výjimkou stránky 
existovat přinejmenším jedna cílová pozice s

Chcete-li klasifikační proces spustit:

1. Klikněte na kterékoli stránce Pr

tlačítko Finish (kromě stránky 

Existují-li při stisknutí tlačítka 
k otevření konfirmačního dialogu
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Open Tree; pak navigujte na požadovaný projekt 

Open Tree umožňuje uživateli vyhledávat v projektové

ů projektů anebo ID analyzovaných vzorků. Vyberte 

vložte vyhledávací filtr a zobrazte ty projekty, jejichž názvy 

ězce obsahují. 

etězce v názvech projektů a ID použijte symbol divoké 
Tak např. použitím vyhledávacího filtru *ABC* budou 

zobrazeny všechny názvy projektů a ID, které obsahují řetězec 

zvolený projekt z databáze. vymažete 

ováno výběrem toho projektu, který obsahujíce 

ní klasifikačního procesu 

ní proces lze spustit z kterékoli stránky Průvodce programem 
s výjimkou stránky Welcome). Ke spuštění klasifikačního procesu musí 

inejmenším jedna cílová pozice s platným ID . 

oces spustit: 

na kterékoli stránce Průvodce programem MALDI Biotyper RTC na 

 stránky Welcome). 

čítka Finish aktivní pozice s prázdným ID vzorku, dojde 
ního dialogu 
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; pak navigujte na požadovaný projekt a 

uje uživateli vyhledávat v projektové 

Vyberte 

zobrazte ty projekty, jejichž názvy 

 a ID použijte symbol divoké 
budou 

zec ABC. 

rem toho projektu, který obsahujíce 

vodce programem MALDI 
ního procesu musí 

na 

vzorku, dojde 
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• Kliknutím na nabídku Yes 

s prázdným ID a odstartujete 

• Kliknutím na nabídku No se vrátíte na stránku 

chybějící ID vzorku. 

o Jakmile bude ukládání dat ukon

odstartujte  klasifikační proces

2.12  Pokračování v př

Klasifikační proces, který byl z
přerušením anebo výpadkem proudu)
pomocí Průvodce programem 
klasifikace. 

Po skončení klasifikačního procesu lze jednotlivé pozice op

Po aktivaci se validace automatic
použita těsně před přerušením. 

Chcete-li v přerušeném klasifika

1. Zvolte nabídku File > New Classification 

2. Pak přejděte na stránku Definition of 

4. Požadovaný  projekt zvolte buď

a. výběrem jeho názvu (Project

anebo  

b.   kliknutím na nabídku 

klikněte na 

Použití nabídky Open Tree

databázi řetezce názvů

příslušný box, vložte vyhledávací filtr á

názvy anebo ID relevantní 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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 vymažete z projektu všechny aktivní pozice 

a odstartujete klasifikační proces.  

se vrátíte na stránku Analyte Placement a vložíte 

Jakmile bude ukládání dat ukončeno, klikněte na nabídku Finish a 

ční proces. 

přerušeném klasifikačním procesu

ní proces, který byl z nějakého důvodu přerušen (např. manuálním 
erušením anebo výpadkem proudu), lze obnovit opětovným otevřením projektu 

vodce programem MALDI Biotyper RTC a zahájením procesu nové 

ního procesu lze jednotlivé pozice opět změřit (a reklasifi

automaticky zopakuje pomocí té validační pozice, která byla 

erušeném klasifikačním procesu pokračovat: 

Classification anebo klikněte na . 

Definition of Project. 

zvolte buď: 

Project Name) v sestupném seznamu 

nabídku Open Tree; pak navigujte na požadovaný projekt 

te na 

Open Tree umožňuje uživateli vyhledávat v projektové

etezce názvů projektů anebo ID analyzovaných vzorků

, vložte vyhledávací filtr á enter a zobrazte ty projekty, jejichž 

relevantní řetězce obsahují. 
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a vložíte 

a 

procesu 

. manuálním 
ením projektu 

zahájením procesu nové 

asifikovat).  

ní pozice, která byla 

; pak navigujte na požadovaný projekt a 

OK. 

uje uživateli vyhledávat v projektové 

yzovaných vzorků. Vyberte 

zobrazte ty projekty, jejichž 
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Tip K vyhledání řetězce v
karty (*). Tak např
zobrazeny všechny názvy projekt

4. Kliknutím na nabídku Next otev

zkontrolujte nastavení projektu

Nabídka počet pozic k měření (
nezměřených pozic vzorků. 

5. Kliknutím na nabídku Finish znovu nastartujete klasifika

Jakmile je klasifikační proces
výsledcích klasifikace; tato správa obsahuje výsledky, kte
měřených pozicích (tj. jak před p

Poznámka Cílový displej a výsledková tabulka v
Realtime 
oklasifikované analytové pozice

Poznámka Ty cílové pozice, které byly v
mohou být z
procesu zabránilo provedení klasifika
pozice p

Chcete-li cílové pozice opět změř

1. Zvolte buď nabídku File > New 

2. Přejděte na stránku Definition of 

3. Požadovaný projekt zvolte buď

a.  výběrem jeho názvu (Project

anebo  

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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etězce v názvech projektů a ID použijte symbol divoké 
Tak např. použitím vyhledávacího filtru *ABC* budou 

zobrazeny všechny názvy projektů a ID, které obsahují řetězec 

tevřete v Průvodci stránku Project Summary

zkontrolujte nastavení projektu.  

ěření (Number of Positions to measure) indikuje po

znovu nastartujete klasifikační proces. 

ní proces ukončen, objeví se na obrazovce zpráva o 
výsledcích klasifikace; tato správa obsahuje výsledky, které byly  získány na všech 

řed přerušením, tak také po něm). 

Cílový displej a výsledková tabulka v okně MALDI Biotyper 
Realtime Classification nezobrazí již dřívě naměř
oklasifikované analytové pozice. 

ílové pozice, které byly v okamžiku přerušení m
mohou být z klasifikace vypuštěny. Jestliže přerušení tohoto 
procesu zabránilo provedení klasifikačního úkolu, 
pozice příslušného vzorku změřena znovu. 

t změřit:  

File > New Classification anebo klikněte na . 

Definition of Project. 

zvolte buď: 

Project Name) v sestupném seznamu 
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 a ID použijte symbol divoké 
budou 

zec ABC. 

Summary a 

kuje počet 

objeví se na obrazovce zpráva o 
ré byly  získány na všech 

MALDI Biotyper 
 naměřené a 

erušení měřeny, 
erušení tohoto 

, musí být 
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b.   kliknutím na nabídku 

klikněte na 

Použití nabídky Open Tree

databázi řetezce názvů

příslušný box, vložte vyhledávací filtr á

názvy anebo ID relevantní 

 Tip K vyhledání řetězce v
karty (*). Tak např. použitím vyhledávacího filtru 
zobrazeny všechny názvy projekt

4. Kliknutím na nabídku Next otev

5. Zvýraznění požadované cílové pozice 

myši a výběrem nabídky Clear state for remeasurement

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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nabídku Open Tree; pak navigujte na požadovaný projekt 

te na 

Open Tree umožňuje uživateli vyhledávat v projektové

etezce názvů projektů anebo ID analyzovaných vzorků

, vložte vyhledávací filtr á enter a zobrazte ty projekty, jejichž

relevantní řetězce obsahují. 

zce v názvech projektů a ID použijte symbol divoké 
Tak např. použitím vyhledávacího filtru *ABC* budou 

zobrazeny všechny názvy projektů a ID, které obsahují řetězec 

tevřete stránku Analyte Placement. 

ní požadované cílové pozice (pozic) dosáhnete kliknutím pravého tla

Clear state for remeasurement v kontextovém 
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požadovaný projekt a 

OK. 

uje uživateli vyhledávat v projektové 

yzovaných vzorků. Vyberte 

zobrazte ty projekty, jejichž 

 a ID použijte symbol divoké 
budou 

zec ABC. 

dosáhnete kliknutím pravého tlačítka 

 menu. 
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Na cílovém displeji změní zvolené pozice svoji 

6. Kliknutím na nabídku Finish vyvoláte na zvolených cílových pozicích opakované 

měření a jejich reklasifikaci. 

2.13  Pokračování klasifika

Klasifikace v reálném čase programem 
se provádějí na každé pozici vzorku

• ze vzorku je získáno hmotové spektrum

• výsledné hmotové spektrum

s referenčními vzorky uloženými v databázi

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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ní zvolené pozice svoji barvu ze zelené na bílou. 

 

vyvoláte na zvolených cílových pozicích opakované 

ování klasifikačního procesu 

programem MALDI Biotyper sestává ze dvou krok
a každé pozici vzorku:  

ze vzorku je získáno hmotové spektrum (krok „měření“);  

výsledné hmotové spektrum je zpracováno a výsledný profil píků je porovnán 

ními vzorky uloženými v databázi (krok „klasifikace“).  
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vyvoláte na zvolených cílových pozicích opakované 

sestává ze dvou kroků, které 

 je porovnán 
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Klasifikační krok je zahájen okamžit
se hmotové spektrum stane opět dostupným

Jakmile je klasifikační proces spušt
Realtime Classification jako bílé te
stávajícího projektu měřeny,. 

Klasifikační krok daného vzorku je zahájen okamžit
spektrum. Postup měření a klasifika
sledovat v reálném čase.  

Jakmile je měření spektra úspěšn
dozelena. Jestliže ale měření neskon
vzorku dooranžova. 

Zbarvení pravé poloviny pozice
klasifikace (dozelena, dožluta nebo do
barevné kódování a indikuje status 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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je zahájen okamžitě poté, co je související měřicí krok ukonč
ět dostupným. 

ní proces spuštěn, zobrazí se v okně programu MALDI Biotyper 
ko bílé tečky ty pozice vzorků, které budou v

daného vzorku je zahájen okamžitě poté, co je k dispozici hmotové 
ení a klasifikační kroky každého vzorku lze na cílovém displeji 

ěšně ukončeno, zbarví se levá polovina pozice
ení neskončí  úspěšně, zbarví se levá polovina pozice

 

Zbarvení pravé poloviny pozice vzorku indikuje bodovou hodnotu (skóre) každé 
dožluta nebo dočervena). Použitý legendový displej zobrazuje 

status vzorků na cílovém displeji. 

ase pomocí softwaru MALDI 
ication  (RTC) 
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icí krok ukončen a co 

MALDI Biotyper 
udou v rámci 

 poté, co je k dispozici hmotové 
ní kroky každého vzorku lze na cílovém displeji 

zbarví se levá polovina pozice vzorku 
zbarví se levá polovina pozice 

u hodnotu (skóre) každé 
ej zobrazuje 
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Jakmile je klasifikace pozice vzorku ukon
do výsledkové tabulky. 

Výsledková tabulka (viz část 2.2)
Classification podává v reálném 
projektu. Tato tabulka obsahuje pouze nejvíce (nejlépe) se shodující r
předlohy (šablony) pro každou analyzovanou pozici a je souhrnem kompletní zprávy o 
vysledcích klasifikace (viz část 2.17)

Klasifikační proces je ukončen v
všechny pozice vzorků. Validač
dopravních světel. 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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vzorku ukončena, je výsledek příslušné klasifikace vl

2.2) okna programu MALDI Biotyper RTC Realtime 
reálném čase přehled o výsledcích klasifikace u aktivního 

ka obsahuje pouze nejvíce (nejlépe) se shodující r
edlohy (šablony) pro každou analyzovanou pozici a je souhrnem kompletní zprávy o 

2.17). 

čen v okamžiku, kdy jsou změřeny a oklasifikovány 
ční nabídky jsou aktivovány podle přiřazených kód

ase pomocí softwaru MALDI 
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íslušné klasifikace vložen 

MALDI Biotyper RTC Realtime 
u aktivního 

ka obsahuje pouze nejvíce (nejlépe) se shodující referenční 
edlohy (šablony) pro každou analyzovanou pozici a je souhrnem kompletní zprávy o 

eny a oklasifikovány 
azených kódů 
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Poznámka Je-li klasifikace
počítače, může generování výsledk
způsobeno tím, že jsou 
vyrovnávací pamě

2  Klasifikace v reálném čase pomocí softwaru MALDI 
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li klasifikace v reálném čase spuštěna poprvé po restart
že generování výsledků klasifikace zabrat určitý čas

sobeno tím, že jsou referenční předlohy nahrávány z datab
ěti. 
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startování 
itý čas. Je to 

databáze do 
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2.14  Zrušení klasifika

Probíhající klasifikaci lze manuálně

• Kliknutím na aktivované tlač

o V tomto případě bude klasifika

upozornění. Okno MALDI Biotyper Realtime Classification z

případě aktivní. 

• Kliknutím na tlačítko Close

Biotyper Realtime Classification. Tímto zp

konfirmační dialog: 

o Kliknutím na tlačítko Yes

Realtime Classification uzav

stisknutí tlačítka Yes. 

o Kliknutím na tlačítko No

Poznámka Zrušením klasif
zastaví, avšak klasifikace m
zrušení tohoto procesu nedojde k
výsledkové tabulky v
Classification. Všechny klasifika
v projektu uloženy a lze je shlédnout na základ
výsledcích klasifikace.

Klasifikační proces může být ukon
elektrického proudu. 
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Zrušení klasifikačního procesu 

klasifikaci lze manuálně zrušit:  

Kliknutím na aktivované tlačítko  Abort Classification   v panelu nástroj

 bude klasifikační proces ukončen bez jakéhokoli 

ní. Okno MALDI Biotyper Realtime Classification zůstává 

Close  v titulkovém pruhu okna programu MALDI 

Biotyper Realtime Classification. Tímto způsobem se otevře následující 

 

Yes klasifikační proces zrušíte a okno MALDI Biotyper 

Realtime Classification uzavřete. Klasifikační proces pak pokračuje až do 

 

No ponecháte klasifikační proces v běhu. 

Zrušením klasifikačního procesu se sice měření pozic vzork
klasifikace měřeného vzorku bude pokračovat. Po 

zrušení tohoto procesu nedojde k aktualizaci ani cílového displeje ani 
výsledkové tabulky v okně programu MALDI Biotyper Realtime 

echny klasifikační výsledky však budou po zrušení 
projektu uloženy a lze je shlédnout na základě generování zprávy o 

výsledcích klasifikace. 

že být ukončen i neúmyslně, např. v důsledku výpadku 
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panelu nástrojů 

 v tomto 

titulkovém pruhu okna programu MALDI 

e následující 

ní proces zrušíte a okno MALDI Biotyper 

čuje až do 

ení pozic vzorků 
ovat. Po 

aktualizaci ani cílového displeje ani 
 programu MALDI Biotyper Realtime 

ní výsledky však budou po zrušení 
 generování zprávy o 

sledku výpadku 
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Poznámka Dojde-li k neúmyslnému nebo ne
MALDI Biotyper RTC, projekt uložte a restartujte proces m
část 2.12). 

Tip Velmi vřele doporučujeme používat  “nep
(„uninterruptible power supply 
také pro jeho počíta

2.15  Natahování/nahrávání již

Archivované projekty lze do programu MALDI Biotyper RTC natáhnout 
tak lze zobrazit i dosažené výsledky klasifikac

Natažení archivovaného projektu

1. Zvolte buď nabídku File > Open Classification

2. Požadovaný projekt vyberte bu

a. volbou projektu v seznamu 

anebo 

b. klikněte na nabídku Open Tree

nabídku OK.  

Použití nabídky Open Tree

databázi řetězce obsahující

vzorku.Vyberte příslušný box a vložte vyhledávací filtr, který vám umožní 

zobrazit ty projekty nebo analyzované vzorky, v

řetězec vyskytuje. 

Tip K vyhledání řetězce v
karty (*). Tak např
zobrazeny všechny názvy projekt
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neúmyslnému nebo nečekanému přerušení programu 
MALDI Biotyper RTC, projekt uložte a restartujte proces měření 

ujeme používat  “nepřerušitelný zdroj energie“ 
(„uninterruptible power supply – UPS , a to jak pro přístroj samotný, tak 

čítač. 

/nahrávání již archivovaného projektu

Archivované projekty lze do programu MALDI Biotyper RTC natáhnout zpět 
dosažené výsledky klasifikace (viz část 2.16).  

Natažení archivovaného projektu: 

File > Open Classification anebo klikněte na . 

buď: 

seznamu Project Name. 

Open Tree, přejděte na požadovaný projekt a klikn

Open Tree umožňuje uživateli vyhledávat v projektové 

zce obsahující název projektu anebo ID analyzovaného 

íslušný box a vložte vyhledávací filtr, který vám umožní 

ekty nebo analyzované vzorky, v jejichž názvu se relevantní 

etězce v názvech projektů a ID použijte symbol divoké 
karty (*). Tak např. použitím vyhledávacího filtru *ABC* budou 
zobrazeny všechny názvy projektů a ID, jež řetězec ABC obsahují.

softwaru MALDI 
Biotyper Realtime Classification  (RTC) 
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erušení programu 
ení (viz 

erušitelný zdroj energie“ 
troj samotný, tak 

rojektu 

zpět a stejně 

ekt a klikněte na 

uje uživateli vyhledávat v projektové 

íslušný box a vložte vyhledávací filtr, který vám umožní 

jejichž názvu se relevantní 

 a ID použijte symbol divoké 
. použitím vyhledávacího filtru *ABC* budou 

obsahují. 
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2.16  Zobrazení výsledk

Výsledky klasifikace lze nalézt ve výsledkové tabulce programu MALDI Biotyper RTC 
(viz část 2.2). Nejvíce odpovídaj
nalézt ve sloupci zjištěné druhy (

Rozšíření a kolabování seznamu výsledk

Chcete-li u individuálních vzorků
řádku vzorku na tlačítko   . 
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Zobrazení výsledků klasifikace  

lasifikace lze nalézt ve výsledkové tabulce programu MALDI Biotyper RTC 
. Nejvíce odpovídající organismy (nebo 'nespolehlivou identifikaci') lze 

né druhy (Detected Species). 

ení a kolabování seznamu výsledků  

li u individuálních vzorků zobrazit největší míru shody, klikněte v př

ase pomocí softwaru MALDI 
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lasifikace lze nalézt ve výsledkové tabulce programu MALDI Biotyper RTC 
ící organismy (nebo 'nespolehlivou identifikaci') lze 

příslušném 
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Kliknutím na tlačítko   seznam zkolabuje (collapse). 

Chcete-li zobrazit u všech klasifikací projektu nejv

nástrojů výsledkové tabulky na tlač

nástrojů na tlačítko . 

Kliknutím na tlačítko 
klasifikace definované jako druhov

Chcete-li znovu zobrazit zeleně zbarvené klasifikace, klikn

tlačítko . 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)

Revision 2 

 

seznam zkolabuje (collapse).  

li zobrazit u všech klasifikací projektu největší míru shody, klikněte v

 výsledkové tabulky na tlačítko . Chcete-li seznam zavřít, klikněte v

 skryjete ve sloupci Validation všechny výsledky 
klasifikace definované jako druhově konzistentní.  

 

li znovu zobrazit zeleně zbarvené klasifikace, klikněte v panelu nástroj
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ěte v panelu 

ěte v panelu 

všechny výsledky 

panelu nástrojů na 



Bruker Daltonik GmbH 

 

MALDI Biotyper 3.0 User Manual Revision 2
 

Změna validačního stavu klasifikace 

Nabídka ve sloupci Validation 
jeho klasifikační status. 

►► Chcete-li změnit a uložit uživatelem definované 

1. změňte validační status příslušné klas

tj.druh, pouze rod anebo neznámý (

Kliknutím na nabídku  v
klasifikací v projektu na automaticky generované hodnoty (druhov
shoda = druh (species); rodov
žádná konzistence = neznámý (

2. Kliknutím na nabídku  v panelu nástroj

klasifikace. 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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sifikace  

 umožňuje uživateli nastavit a uložit každého vzorku 

nit a uložit uživatelem definované validace: 

říslušné klasifikace kliknutím na odpovídající nabídku 

tj.druh, pouze rod anebo neznámý (species, genus-only or unknown). 

 

v panelu nástrojů resetujete validační status všech 
projektu na automaticky generované hodnoty (druhově ko

; rodově konzistentní shoda = pouze rod (genus
žádná konzistence = neznámý (unknown). 

panelu nástrojů v projektu  uložíte validační status 
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uje uživateli nastavit a uložit každého vzorku 

ifikace kliknutím na odpovídající nabídku – 

status všech 
 konzistentní 
genus-only); 

status 
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2.17  Generování zprávy o výsledcích 

Zprávu o výsledcích klasifikace lze vytvo
archivovaný. Klasifikační zprávy se na lokálním harddisku ukládají jako 
<projectname>.html následujícím zp

C:\Documents and Settings\<username>

Daltonik\MALDIBiotyperAutomationControl

Stávající HTML soubor je přepsán po vytvo

Chcete-li vytvořit zprávu o výsledcích klasifikace u aktivního projektu: 

1. Vyberte buď nabídku View > Results

nabídku .  

Zpráva o vytvoření klasifikačních výsledk
do výrobcem nastaveného webového 

Chcete-li vytvořit zprávu o výsledcích klasifikace u archivovaného projektu: 

1. Požadovaný projekt uložte (viz 

2.  Vyberte buď nabídku View > Results

nabídku . 

Výrobcem nastavený webový browser se po 
zobrazí. 

Poznámka: Tlačítko 
tehdy, jsou

Tisk zprávy o výsledcích klasifikace 
Zprávu o výsledcích klasifikace lze z HTML vyhledáva
File > Print. Zprávy obsahující velký po
stran. Vytisknutím informací o projektu (
(Result Overview) lze vytvořit vhodný souhrnný p

Tip Symboly bodového hodnocení/skóre (nap
(Sample Name)
shody pomocí nátisk

2  Klasifikace v reálném čase pomocí softwaru
Biotyper Realtime Classification  (RTC)
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Generování zprávy o výsledcích  

Zprávu o výsledcích klasifikace lze vytvořit buď pro aktivní projekt anebo pro projekt 
ní zprávy se na lokálním harddisku ukládají jako 
následujícím způsobem: 

<username>\Application Data\Bruker 

MALDIBiotyperAutomationControl\HtmpResults 

epsán po vytvoření každé nové zprávy. 

it zprávu o výsledcích klasifikace u aktivního projektu:  

View > Results anebo v hlavním panelu nástrojů klikn

ení klasifikačních výsledků je v tomto případě okamžitě odeslána 
do výrobcem nastaveného webového vyhledávače (browseru). 

it zprávu o výsledcích klasifikace u archivovaného projektu: 

(viz část 2.15). 

View > Results anebo v hlavním panelu nástrojů klikn

obcem nastavený webový browser se po několika sekundách otevře a zprávu 

ítko Zobraz výsledky (View Results) je aktivováno pouze 
tehdy, jsou-li ve vybraném projektu obsažena data. 

Tisk zprávy o výsledcích klasifikace  
lasifikace lze z HTML vyhledávače vytisknout pomocí p

. Zprávy obsahující velký počet vzorků budou produkovat i velký po
utím informací o projektu (Project Info) a přehledné tabulky výsledk

řit vhodný souhrnný přehled dosažených výsledků

Symboly bodového hodnocení/skóre (např. +++) v názvu vzorku 
Sample Name) lze použít k rychlému stanovení bodové hodnoty 

shody pomocí nátisků provedených černobílou tiskárnou. 

ase pomocí softwaru MALDI 
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 pro aktivní projekt anebo pro projekt 
ní zprávy se na lokálním harddisku ukládají jako 

 

ů klikněte na 

 okamžitě odeslána 

it zprávu o výsledcích klasifikace u archivovaného projektu:  

ů klikněte na 

ře a zprávu 

je aktivováno pouze 

e vytisknout pomocí příkazu 
 budou produkovat i velký počet 

ehledné tabulky výsledků 
ehled dosažených výsledků.  

názvu vzorku 
bodové hodnoty 

ernobílou tiskárnou.  
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Je-li k dispozici  i tiskárna barevná, lze webový prohlížeč nastavit tak, aby bylo tištěno 
barevné pozadí. Ke konverzi HTML zprávy do PDF dokumentu lze použít některou 
z PDF aplikací (např. 'PDFCreator'). 

Tip Tisk na barevné pozadí se v Internet Exploreru přepíná pomocí 
příkazů Tools > Internet Options > Advanced > Printing > 
Print background colours and images check box. 

2.17.1  Struktura zprávy o výsledcích klasifikace  

Zpráva o výsledcích  klasifikace má několik částí: 

•  První část zprávy se skládá z: 

o Informací o projektu (Project Info) (viz část 2.17.2),  

o Tabulky Přehled výsledků (Result Overview) (viz část 2.17.3),  

o Sledování shody (Matching Hints) (viz část 2.17.4),  

o Významu hodnot skóre (Meaning of Score Values) (viz část 2.17.5) a  

o Významu konzistenčních kategorií (Meaning of Consistency 

Categories) (viz část 2.17.6).  

• Druhá část zprávy obsahuje pro každý název analyzovaného vzorku, který je 

uveden v přehledu výsledků (Result Overview) samostatný oddíl 

Analyte<number> s detailní klasifikační tabulkou (ranking table) (viz část 

2.17.7). 

2.17.2  Informace o projektu 

Část Project Info se nachází přímo pod záhlavím zprávy a obsahuje následující 
kategorie: 

Kategorie Poznámka 

Project Name Název projektu. 

Project Description Popis projektu (je-li specifikován) 

Project Owner Jméno tvůrce projektu. 
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Kategorie Poznámka 

Project Creation 
Date/Time 

Časové určení projektu. 

Project Analyte Count Počet analyzovaných vzorků v projektu. 

Project Type Typ by měl být  označen jako 'Vývoj' ('Development'). 

Validation Výsledek validace ('úspěšná' nebo 'neúspěšná') 

Validation Pozice Pozice standardu bakteriálního testu (Bruker Bacterial Test 
Standard). 

 

2.17.3  Přehledná tabulka výsledků 

Tabulka přehledu výsledků (Result Overview table) obsahuje seznam dvou 
nejlepších případů shody, které byly zjištěny u každého z analyzovaných vzorků. Tato 
tabulka obsahuje následující sloupce: 

Sloupec Poznámka 

Analyte 
Name 

Název analyzovaného vzorku = údaj Name vložený na stránku 
Analyte Placement v Průvodci programem MALDI Biotyper RTC 
spolu s přidruženými symboly hodnocení (skóre) a pod tím v 
závorkách uvedenou konzistenční kategorií. Hyperlink otevírá tabulku 
(ranking table) specifického zařazení vzorku (viz část 2.17.7). 

Analyte ID ID analytu = údaj ID vložený na stránku Analyte Placement 
v Průvodci programem MALDI Biotyper RTC. 

Organism 
(best match) 

Organismus, jehož referenční hodnocení (reference pattern)  má 
nejvyšší hodnotu skóre. Hyperlinkový údaj indikuje, že u této 
klasifikace existuje shoda s předlohou (viz část 2.17.4) 

Score Value Hodnota skóre nejlepšího výsledku srovnávání. 

Organism 
(second best 

Organismus, jehož referenční hodnocení má druhou nejvyšší hodnotu 
skóre. Hyperlinkový údaj indikuje, že i u této klasifikace shoda 
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Sloupec Poznámka 

match) s předlohou existuje

Score Value Hodnota skóre druhého n

 

Údaje o použitém barevném kódování, hodnot
uvedeny v přehledu výsledků
Meaning of Score Values (viz část 2.17.5)

Kategorie shody A, B a C jsou
Categories (viz část 2.17.6). 

Je-li zpráva vytvořena v průběhu procesu klasifikace, obsahují ty sloupce se záhlavím 
Organism a Score Value, u nichž údaje o analyzovaných vzorcích ješt
zaměřeny anebo klasifikovány, hlášení 'údaj ješt
and'<0'). 

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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edlohou existuje (viz část 2.17.4) 

Hodnota skóre druhého nejlepšího výsledku srovnávání. 

Údaje o použitém barevném kódování, hodnotě skóre a o jeho symbolu, jež jsou 
ehledu výsledků (Result Overview), jsou vysvětleny v

(viz část 2.17.5). 

Kategorie shody A, B a C jsou vysvětleny v kapitole Meaning of Consistency 

 

ěhu procesu klasifikace, obsahují ty sloupce se záhlavím 
u nichž údaje o analyzovaných vzorcích ještě

lasifikovány, hlášení 'údaj ještě neexistuje' a '< 0' ('not (yet) present' 
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, jež jsou 
tleny v kapitole 

Meaning of Consistency 

hu procesu klasifikace, obsahují ty sloupce se záhlavím 
u nichž údaje o analyzovaných vzorcích ještě nebyly 

'< 0' ('not (yet) present' 
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2.17.4  Shoda výsledků

Hlášení o shodě výsledku s referen
referenčního vzoru a příslušnou Poznámku).

Tabulka Matching Hints obsahuje následující sloupce:

Sloupec Poznámka 

Matched 
Pattern 

Název srovnávaného 
příslušného kmene).

Comment Poznámka, která je pro tento referen
(míra shody). 

 

2.17.5  Význam hodnot skóre

Kapitola Význam hodnot skóre 
barevných kódů, rozmezí hodnot skóre a symboly skórování, jež j
výsledků (Result Overview) uvedeny

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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Shoda výsledků s předlohou 

referenčním vzorem (profilem) má dvě části (tj. Název 
Poznámku). 

obsahuje následující sloupce: 

Název srovnávaného referenčního vzoru (úplné ozna
íslušného kmene). 

Poznámka, která je pro tento referenční model/šablonu k

Význam hodnot skóre 

Význam hodnot skóre (Meaning of Score Values) objasňuje v
hodnot skóre a symboly skórování, jež jsou v 

uvedeny. 

ase pomocí softwaru MALDI 
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ásti (tj. Název 

 

(úplné označení 

k dispozici 

ňuje význam 
 přehledu 
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2.17.6  Význam kategorií k

Kapitola Meaning of Consistency Categories
kategorií A, B a C.  

Kromě obecné zprávy o výsledcích klasifikace (
každé konsistenční kategorii vygenerovat i zprávy specifické

2.17.7  Tabulky zařazení jednotlivých analyt

Tabulky zařazení jednotlivých analyt
zpřístupnit kliknutím na hyperlinkový údaj 
výsledků (Result Overview). Tyto p
uspořádaných v sestupném pořadí podle

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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Význam kategorií konzistence 

Meaning of Consistency Categories sumarizuje význam konzisten

 obecné zprávy o výsledcích klasifikace (Classification Results Report
ní kategorii vygenerovat i zprávy specifické (viz část 2.18) 

azení jednotlivých analytů 

azení jednotlivých analytů (Analyte-specific ranking tables
ístupnit kliknutím na hyperlinkový údaj Analyte Name, který se nachází v 

. Tyto přehledné tabulky obsahují 10 nejlepších výsledk
řadí podle dosažených hodnot jejich skóre. 

ase pomocí softwaru MALDI 
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istenčních 

Classification Results Report), lze o 

 

specific ranking tables) lze 
 přehledu 

ehledné tabulky obsahují 10 nejlepších výsledků 
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Poznámka Podrobnosti o jednotlivých kmenech
v detailních hodnotících tabulkách

I když jsou identity červeně zvýrazn
<1,7) v přehledu výsledků (Result Overview
'klasifikace není spolehlivá' ('not reliable classification', jsou v
jednotlivých analyzovaných vzorků

Každá přehledná tabulka hodnocení obsahuje následující informace:

Kategorie Poznámka 

Analyte Name Název analyzovaného vzorku (= údaj 
Analyte Placement

Analyte 
Description 

Popis analytu (= údaj 
Placement v Prů

Analyte ID ID analytu (= údaj 
v Průvodci programem MALDI Biotyper RTC.
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Podrobnosti o jednotlivých kmenech, jež jsou 
detailních hodnotících tabulkách, slouží jen pro informaci.

 zvýrazněných výsledků hodnocení (tj. s hodnotou skóre 
Result Overview) potlačeny a nahrazeny údajem 

'klasifikace není spolehlivá' ('not reliable classification', jsou v tabulkách hodnocení 
jednotlivých analyzovaných vzorků uvedeny. 

ehledná tabulka hodnocení obsahuje následující informace:  

Název analyzovaného vzorku (= údaj Name vložený na stránku 
Analyte Placement v Průvodci programem MALDI Biotyper RTC

Popis analytu (= údaj Description vložený na stránku 
Průvodci programem MALDI Biotyper RTC. 

analytu (= údaj ID vložený na stránku Analyte Placement
vodci programem MALDI Biotyper RTC. 
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 uvedeny 
slouží jen pro informaci. 

hodnotou skóre 
eny a nahrazeny údajem 

kách hodnocení 

vložený na stránku 
vodci programem MALDI Biotyper RTC 

vložený na stránku Analyte 

Analyte Placement 
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2.18  Specifické zprávy o kategoriích shody

Program MALDI Biotyper RTC
Specifické zprávy o kategoriích shody (Consistency category
údaje umožňují uživateli vytvořit 
u jednotlivých druhů (zvýrazně
kategorie B) anebo bez shody (zvýrazn

Tyto specifické zprávy obsahují seznam dvou nejlepších výsledk
jednotlivých analyzovaných vzorků

Chcete-li  specifické zprávy o j

1. Vyberte buď nabídku File > New Classification

2. Přejděte na stránku Definition of Project

3. Požadovaný projekt vyberte bu

a. ze sestupného seznamu názv

anebo 

b. klikněte na nabídku Open Tree

OK. 

Použití nabídky Open Tree

ty řetězce. které obsahujíí bu

jednotlivých analytů. Vyberte si odpovída

řetězec; tak zobrazíte ty projekty, v

číslech jednotlivých analytů

Tip K vyhledání řetězce v
karty (*). Tak např
zobrazeny všechny názvy projekt

4. Klikněte na nabídku Options>>

kliknutím na nabídky View Results A

2  Klasifikace v reálném čase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC)
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Specifické zprávy o kategoriích shody 

Program MALDI Biotyper RTC může z archivovaných projektů vygenerovat 
Specifické zprávy o kategoriích shody (Consistency category-specific reports). Tyto 

řit i zprávy, které obsahují jen výsledky vyjadřující shodu 
 (zvýrazněno zeleně, kategorie A), rodů (zvýrazně

kategorie B) anebo bez shody (zvýrazněno červeně, kategorie C). 

Tyto specifické zprávy obsahují seznam dvou nejlepších výsledků dosažených u 
jednotlivých analyzovaných vzorků v každé ze zmíněných kategorií (A, B nebo C). 

zprávy o jednotlivých kategoriích shody vytvořit: 

File > New Classification anebo klikněte na . 

Definition of Project. 

Požadovaný projekt vyberte buď: 

ze sestupného seznamu názvů projektů (Project Name). 

Open Tree, přejděte na požadovaný projekt a klikn

Open Tree umožňuje uživateli vyhledávat v databázi projekt

obsahujíí buď názvy projektů  anebo identifikační čísla 

. Vyberte si odpovídající box a do něj vložte vyhledávací

; tak zobrazíte ty projekty, v jejichž  názvech  anebo v identifikač

íslech jednotlivých analytů jsou tyto relevantní řetěze obsaženy. 

etězce v názvech projektů a ID použijte symbol divoké 
arty (*). Tak např. použitím vyhledávacího filtru *ABC* budou 

zobrazeny všechny názvy projektů a ID, které obsahují řetězec ABC.

Options>> a zprávu pro požadovanou kategorii vytvoř

View Results A, View Results B anebo View Results C

ase pomocí softwaru MALDI 
Biotyper Realtime Classification  (RTC) 

Strana 75 

 vygenerovat také 
specific reports). Tyto 

řující shodu 
 (zvýrazněno žlutě, 

 dosažených u 
ných kategorií (A, B nebo C).  

te na požadovaný projekt a klikněte na 

databázi projektů 

čísla 

j vložte vyhledávací 

jejichž  názvech  anebo v identifikačních 

 a ID použijte symbol divoké 
. použitím vyhledávacího filtru *ABC* budou 

zec ABC. 

a zprávu pro požadovanou kategorii vytvoříte 

View Results C. 
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2.19  Vytvoření statistické zprávy

Z projektové databáze lze vygenerovat i statistickou zprávu. Tato zpráva obsahuje 
měsíční přehled o počtu zpracovaných projekt

Na lokální harddisk jsou statistické zprávy ukládány po
ProjectStatistics.html následujícím postupem:

C:\Documents and Settings\<username>

Daltonik\MALDIBiotyperAutomationControl

Již existující HTML soubor bude 

Chcete-li vytvořit statistickou zprávu

1. Vyberte nabídku View > Statistics

Vytvořená statistická zpráva pak je okamžit
webového browseru. 

Tisk statistické zprávy 
Statistickou zprávu lze z HTML browseru vytisknout pomocí p
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ení statistické zprávy 

Z projektové databáze lze vygenerovat i statistickou zprávu. Tato zpráva obsahuje 
tu zpracovaných projektů a analytů  .  

 

Na lokální harddisk jsou statistické zprávy ukládány pod ozna
následujícím postupem: 

<username>\Application Data\Bruker 

MALDIBiotyperAutomationControl\HtmpResults 

 při vytvoření každé nové zprávy vždy přepsán.

it statistickou zprávu: 

View > Statistics.  

ená statistická zpráva pak je okamžitě odeslána do výrobcem nastaveného  

Statistickou zprávu lze z HTML browseru vytisknout pomocí příkazu File > Print

ase pomocí softwaru MALDI 
Realtime Classification  (RTC) 
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Z projektové databáze lze vygenerovat i statistickou zprávu. Tato zpráva obsahuje 

d označením 

epsán. 

 odeslána do výrobcem nastaveného  

File > Print. 
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3  MALDI Biotyper 
(OC) 

3.1  Spuštění softwaru

Do aplikací Bruker Daltonics může být zalogován vždy jen jeden po
uživatel je uveden na stavové liště

►►  Start programu MALDI Biotyper

1. Zvolte nabídku  > Programs > Bruker Daltonics > MAL

anebo dvakrát klikněte na ikonu 

2. Nebyl-li program MALDI Biotyper OC licen

(viz část C.3). 

3.2  MALDI Biotyper OC

Uživatelské rozhraní programu MALDI

• Náhled souboru (File View

• Náhled spektra (Spectrum View

• Náhled taxonomického dendrogramu (

• Náhled gelu (Gel View) 

• Náhled tabulky (Table View

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

MALDI Biotyper – Offline klasifikace 

ní softwaru 

ůže být zalogován vždy jen jeden počítač; momentální 
uživatel je uveden na stavové liště programu MALDI Biotyper OC. 

Biotyper 

> Programs > Bruker Daltonics > MALDI Biotyper

te na ikonu desktopu. 

MALDI Biotyper OC licencován, vložte do počítače platnou licenci

MALDI Biotyper OC – Uživatelské rozhraní 

MALDI Biotyper OC má pět samostatných částí

File View) 

Spectrum View) 

ického dendrogramu (Taxonomy Tree View) 

View) 

Offline klasifikace (OC) 
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Offline klasifikace 

momentální 

DI Biotyper 

e platnou licenci 

 

částí: 
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3.2.1  Náhled souboru  

Oblast Náhled souboru podává přehled uložených hrubých spekter nebo MSA ve 
dvou samostatných tabulkách: 

• Spektrum 

• MSP 

Po kliknutí se tabulka přesunete do popředí náhledu. Momentálně aktivní tabulka má 
nahoře oranžový proužek (při použití standardních Windows). Spektra anebo MSP 
jsou číslována a uvedena v tom pořadí, v němž byla do náhledu natažena (vložena).  

Náhled souboru se používá k výběru nabídky určitého spektra anebo MSP pro 
zpracování. V náhledu spektra je zobrazeno poslední vybrané spektrum. 

Kliknete-li pravým tlačítkem myši na kteroukoli část tabulek Spectrum nebo MSP, 
otevřete kontextové menu. Tabulka hlavních spekter (MSP) obsahuje jako podsoubor 
příkazy kontextového menu tabulky Spektrum. 

3.2.1.1  Náhled souboru kontextového menu 

Příkaz Funkce  

Start Identification 
(Identifikace startu) 

Zahajuje  klasifikaci neznámého vzorku pomocí jeho 
spektra/MSP (viz část 3.4) 

View PCA Dendrogram 
(Náhled PCA dnegrogramu) 

Generuje a zobrazuje PCA dendrogram (viz část 
3.7.3.2) 

View PCA Clustering 
(Náhled PCA klastrování) 

Provádí klastrování na spektrech PCA (viz část 
3.7.2) 

Match Composite Correlation 
Index… 

Porovnává neznámý vzorek s CCI matrix (viz část 
3.8.3) 

Create MSP 
(Vytvoř MSP) 

Z vybraných hrubých spekter vytváří referenční 
spektrum (viz část 3.3.5.1) 

Create MSP Series 
(Vytvoř sérii MSP) 

Z vybraných hrubých spekter vytváří sérii 
referenčních spekter (viz část 3.3.5.1) 

Remove Selected 
Spectra/MSPs 
(Odstraň vybraná 
spektra/MSP) 

Odstraňuje vybraná  spektra/MSP z náhledu souboru 

Clear All Spektra/MSPs Z náhledu souboru vymazává všechna spektra/MSP 
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Příkaz Funkce  

(Vymaž všechna 
spektra/MSP) 

Create Report 
(Vytvoř zprávu) 

Vytváří zprávu o výsledcích klasifikace zvolených a 
oklasifikovaných spekter/MSP (viz část 2.17.1) 

Properties… 
(Vlastnosti...) 

Zobrazuje vlastnosti souboru spekter (tato funkce je 
aktivní pouze pro jeden soubor) 

Show Spektra in Gel View 
(Zobraz spektra v náhledu 
gelu) 

V náhledu gelu zobrazuje vybraná spektra (viz část 
3.2.4) 

Show Normalized Spektra in 
Gel View 
(Zobraz normalizovaná 
spektra v náhledu gelu) 

V náhledu gelu normalizuje a zobrazuje zvolená 
spektra (viz část 3.2.4) 

Show Selection in Spektra 
View 
(Zobraz výběr v náhledu 
spekter) 

V náhledu spekter zobrazuje vybraná spektra (viz 
část 3.2.2) 

 

 3.2.2  Náhled spektra  

Tato funkce zobrazí hrubá a zpracovaná spektra a přehled píků ve dvou tabulkách. 
Kliknutím na požadovanou tabulku ji přesunete do popředí náhledu. Při použití 
standardních Windows má momentálně aktivní tabulka nahoře taktéž oranžový 
proužek. 

Tabulka Spektrum  

Tabulka Spektrum zobrazuje hodnoty m/z (osa x) proti intenzitě (osa y).  

Při zobrazování souborů s jednotlivými spektry mohou být na displeji dvě spektra 
současně: 

• Hrubé spektrum (výrobní nastavení v černé barvě) 

• Předběžně zpracované (připravené) spektrum (jeho výrobní nastavení je 

v barvě modré) 

Při zobrazení MSP souborů je zobrazeno spektrum se seznamu píků (jeho výrobní 
nastavení je černé barvě). 
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Identifikační tabulka 
Tato tabulka zachycuje grafické zobrazení těch výsledků klasifikace, které byly 
získány porovnáním neznámého vzorku s referenčním MSP. V její horní polovině je 
zobrazeno normalizované spektrum píků neznámého vzorku a v její dolní části se 
nachází spektrum píků těch hlavních spekter (MSP), která jsou mometálně vybrána 
v tabulce obsahující jejich bodové hodnocení v Náhledu tabulky (tyto údaje jsou 
zobrazeny pomocí barevné stupnice s inverzní intenzitou). Barva každého píku 
vyjadřuje míru shody s referenčním MSP (zelená = plná shoda, žlutá = částečná 
shoda, červená = žádná shoda). 

3.2.2.1  Změna grafické úpravy náhledu 

Kliknutím pravého tlačítka myši otevřete kontextové menu, které lze použít buď ke 
změně anebo k uložení grafické úpravy náhledu. 

Příkaz Funkce  

Peak line width 
(Tloušťka píkové čáry) 

V náhledu nastaví sílu čáry (tenká/střední/silná) 

Copy (Zkopíruj) Zkopíruje obsah náhledu do vyrovnávací paměti 
(clipboardu)  

Save Image As… 
(Ulož obrázek jako...) 

Uloží obsah náhledu jako grafický soubor 
(Emf/PNG/Gif/Jpeg/Tiff/Bmp) 

Page Setup… 
(Nastavení stránky)  

Nastaví vlastnosti stránky pro tisk 

Print… 
(Tisk) 

Zahájí tiskový dialog 

Show Point Values 
(Ukaž bodové 
hodnocení) 

Změní zobrazení kooordinát kurzoru v ToolTipu 

Remove Selected 
Spectra 
(Odstraň zvolená 
spektra) 

Odstraní spektra vybraná z náhledu souboru (File View) 

Un-Zoom 
(Změň zoom) 

Vrátí transfokaci o jeden krok zpět 

Undo All Zoom/Pan 
(Zruš všechny zoom 
akce) 

Zruší všechny transfokační (zoom/pan) akce (= resetuje 
náhled) 

Set Scale to Default Použije výrobní nastavení stupnice 
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Příkaz Funkce  

(Nastav stupnici na 
výrobní hodnoty) 

 

Změna velikosti (transfokace) 

Zvětšování a zmenšování velikosti se provádí otáčením středového kolečka myši. 

3.2.3  Náhled taxonomického dendrogramu 

Funkce Náhled taxonomického dendrogramu zobrazí momentálně zvolený 
dendrogram, jeho taxonové uzly a hlavní spektra (MSP) přiřazená ke každému uzlu. 
Dvě číslice za názvem každého nodu jsou jednak číslem MSP, které je k příslušnému 
uzlu přiřazeno a jednak vyjadřují celkový počet těch MSP, jež jsou přiřazeny jak 
k příslušnému uzlu, tak také ke všem jeho uzlům podřazeným (subnodes). 

Jak dendrogram, tak také počet uzlů lze rozšiřovat či zužovat klikáním na symboly '+' 
a '–', které se nacházejí před názvy uzlů; druhou možností je použít odpovídající 
příkaz obsažený v kontextovém menu. 

Po kliknutí pravého tlačítka myši do náhledu taxonomického dendrogramu se otevře 
kontextové menu, které obsahuje následující příkazy. 

Příkaz Funkce  

View in Browser 
(Náhled do browseru) 

Otevře tu stránku NCBI databáze taxonů, která 
odpovídá zvolenému funkčnímu nodu ve 
standardním browseru (nutné je mít přístup na 
Internet). 

Search MSP… 
(Hledej MSP) 

Vyhledá funkční dendrograqm pro specifikované 
MSP. 

Start Taxonomy Tree Editor… 
(Spusť editor taxonomického 
dendrogramu)  

Otevře editor taxonomického dendrogramu (MALDI 
Biotyper Taxonomy Tree Editor). 

Add to MSP Selection 
(Přidej do výběru MSP) 

Přidá jedno vybrané MSP do tabulky vybraných 
MSP. 

Add Hierarchy to MSP 
Selection 
(Přidej hierarchii do výběru 

Přidá MSP nacházející se ve vybraném nodu (a také 
ve všech jeho dceřinných uzlech) do tabulky 
vybraných MSP. 
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Příkaz Funkce  

MSP)  

Clear MSP Selection 
(Vyčisti výběr MSP) 

Vyprázdní tabulku vybraných MSP. 

Add MSPs for Identification 
(Přidej MSP pro identifikaci) 

Přidá vybraná MSP do tabulky náhledu souborů 
MSP. 

Add Hierarchy for 
Identification 
(Přidej hierarchii pro 
identifikaci) 

Přidá MSP nacházející se ve vybraném nodu (a také 
ve všech jeho dceřinných uzlech) do tabulky náhledu 
souborů MSP. 

 

3.2.4  Náhled gelu 

Funkce Náhled gelu zobrazuje pseudogelovou reprezentaci hrubých nebo 
normalizovaných spekter. 

Chcete-li v Náhledu gelu některé spektrum zobrazit: 

1. Natáhněte a zvýrazněte požadovaná hrubá spektra v souboru Náhled spekter (viz 

část 3.3.2). 

2. Klikněte pravým tlačítkem na zvýrazněná spektra a zvolte buď nabídku: 

a. Show Spectra in Gel View (Zobraz spektra v náhledu gelu) 

ANEBO 

b. Show Normalized Spectra in Gel View (Zobraz v náhledu gelu 

normalizovaná spektra). 

Tip K přepínání mezi zobrazením hrubých a normalizovaných spekter 
použijte zkrácené příkazyCtrl+G a Ctrl+N. 

3.2.4.1  Změna vzhledu displeje Náhled gelů 

Na ose x jsou zobrazeny hodnoty m/z a na ose y vlevo se nachází číslo příslušného 
spektra.. Na pravé straně osy y je uvedena intenzita použitých barevných píků, a to 
podle jejich intenzity v gelu. 
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Po kliknutí pravým tlačítkem myši do kterékoli části náhledu gelu se otevře kontextové 
menu, které lze použít buď ke změně vzhledu tohoto náhledu anebo k jeho uložení. 

Příkaz Funkce  

Color Scheme 
(Barevné schéma) 

Nastaví typ zobrazení gelu (Oranžová stupnice /Horká mapa 
/Černá stupnice /Modrá stupnice /Fialová až modrozelená). 

Invert Background 
(Invertuj pozadí) 

Invertuje barevnou stupnici. 

Copy 
(Kopíruj) 

Zkopíruje obsah náhledu do vyrovnávací paměti. 

Save Image As… 
(Ulož obrázek 
jako...) 

Uloží obsah náhledu jako grafický soubor 
(Emf/PNG/Gif/Jpeg/Tiff/Bmp). 

Page Setup… 
(Nastavení 
stránky...) 

Nastaví rozvržení stránky pro tisk. 

Print… 
(Tisk...) 

Otevře tiskový dialog. 

Un-Zoom 
(Změň zoom) 

Vrátí zpět poslední transfokaci (zoom action). 

Undo All Zoom/Pan 
(Zruš všechny 
zoom/pan akce) 

 
Zruší všechny zoom/pan akce (= resetuje náhled). 

Set Scale to Default 
(Nastav stupnici na 
výrobní hodnoty) 

Použije výrobní nastavení stupnice. 

 

3.2.5  Náhled tabulky  

Náhled tabulky může obsahovat až šest jednotlivých tabulek. Ne všechny tabulky jsou 
ale vždy zobrazeny. Číslo za označením tabulky indikuje počet vstupů do příslušné 
tabulky.  

Zvolte nabídku MSP  
Tato tabulka obsahuje seznam těch MSP, která lze použít buď ke klasifikaci anebo 
k vytvoření MSP dendrogramu. Příkazy kontextového menu umožňují buď přidávat, 
odstraňovat a ukládat MSP do knihovny MSP anebo vytvořit jejich dendrogram. Další 
příkazy umožňují editaci seznamu MSP píků a metadat. 
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Aktuální MSP 
Tabulka aktuálních MSP přináší informace o těch MSP, jež jsou přiřazena k tomu 
taxonovému uzlu, který je právě vybrán v náhledu taxonomického dendrogramu. 

Skóre spektra 
Tabulka Skóre spektra sumarizuje výsledky klasifikace neznámého spektra. Přináší 
seznam těch MSP, u nichž existuje nejužší shoda se spektrem neznámého vzorku; 
nejvyšší shoda je přitom uvedena v horní části tohoto seznamu. 
Kódování podle dopravních barevných signálů indikuje míru shody (zelená = plná 
shoda, žlutá = částečná shoda, červená = žádná shoda). 
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Skóre MSP  
Tato tabulka sumarizuje výsledky klasifikace určitého MSP spektra na základě MSP 
standardu. Obsahuje seznam těch MSP, u nichž existuje nejužší shoda s MSP 
neznámého vzorku; nejvyšší míra shody je uvedena v horní části tohoto seznamu. 
Kódování podle dopravních barevných signálů indikuje míru shody (zelená = plná 
shoda, žlutá = částečná shoda, červená = žádná shoda). 

 Skóre MSP podsouborů  
Tato tabulka sumarizuje výsledky klasifikace neznámého MSP spektra na základě 
subtypizace MSP. Obsahuje pořadí těch MSP, u nichž je shoda s nezámým MSP 
největší, přičemž nejvyšší míra shody je uvedena v horní části tohoto seznamu.  

Kódování podle dopravních barevných signálů indikuje míru shody (zelená = plná 
shoda, žlutá = částečná shoda, červená = žádná shoda). 

Skóre CCI 
Tabulka CCI Scores sumarizuje výsledky klasifikace neznámého spektra na základě 
použití CCI matrix. Tato tabulka řadí spektra do skupin, jež se vyznačuijí nejvyšší 
mírou shody se spektrem neznámého vzorku; nejvyšší míra shody je přitom uvedena 
v horní části tohoto seznamu. 

Kódování podle dopravních barevných signálů indikuje míru shody (zelená = plná 
shoda, žlutá = částečná shoda, červená = žádná shoda). 

3.2.5.1  Zobrazování a skrývání informací obsažených v tabulkách 

Po kliknutí se příslušná tabulka přesune do popředí náhledu. Momentálně aktivní 
tabulka má (při použití standardních Windows) nahoře oranžový proužek. 

Tabulky lze třídit podle hodnot uvedených v určitém sloupci tak, že klikneme na jeho 
záhlaví. Opakovaným kliknutím se zobrazený výsledek třídění změní (buď ve směru 
shora dolů anebo zdola nahoru). Sloupec a způsob třídění, jež jsou v tomto případě 
použity, je označen černým trojjúhelníčkem, který v se nachází v záhlaví příslušného 
sloupce (� nebo �). 

Informace zobrazené v každé tabulce lze definovat pomocí sloupce nacházejícího se 
v záhlaví kontextového menu. Chcete-li sloupce zobrazit anebo skrýt, zvolte anebo 
vymažte příslušnou nabídku.  

Některé sloupce jsou nastaveny již výrobcem a skrýt je nelze.  
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3.2.5.2  Náhled tabulky kontextových menu 

Po kliknutí pravým tlačítkem myši dovnitř náhledu tabulky se otevře kontextové menu. 
Ne všechny příkazy však jsou v tabulkách dostupné. Některé z nich jsou dostupné 
pouze po zvýraznění jednotlivých tabulkových údajů (table entries), zatímco u jiných je 
třeba zvýraznit údajů více. 

Příkaz Funkce 

Locate MSP in Taxonomy Tree 
(Lokalizuj MSP 
v taxonomickém 
dendrogramu) 

Otevře taxonomický dendrogram v uzlu, který 
obsahuje zvolené MSP. 

View MSP Dendrogram 
(Náhled MSP dendrogramu) 

Vytváří dendrogram ze tří nebo více zvýrazněných 
MSP (viz část 3.6.1). 

View Sub-Scoring 
(Náhled skóre podsouborů) 

Vytváří tabulku  Sub-MSP Scores table for '+'-
labelled Výsledky MSP klasifikace (viz část 3.4.4). 

Remove Selected MSPs 
(Odstraň zvolené MSP) 

Odstraňuje z tabulky zvýrazněná MSP. 

Clear All MSPs 
(Vymaž všechna MSP) 

Odstraňuje z tabulky všechna MSP. 

Load MSP Library 
(Natáhni MSP  

Otevře dialog Load MSP Library (Natáhni knihovnu 
MSP). 

Save knihovnu MSP) Otevře dialog Save MSP Library (Ulož knihovnu 
MSP). 

Create Subtyping MSPs 
(Vytvoř subtypizaci MSP) 

Otevře editor MALDI Biotyper Subtyping MSP Editor 
(viz část 3.3.5.4). 

Add to MSP Selection 
(Přidej MSP do výběru) 

Přidává zvýrazněná MSP do tabulky vybraných 
MSP. 

Add MSPs for Identification 
(Přidej MSP pro identifikaci) 

Přidává zvýrazněná MSP do tabulky Náhledu 
souboru MSP. 

View Preprocessing Method 
(Zobraz metodu přípravy) 

Zobrazuje metodu přípravy zvoleného MSP. 

View MSP Creation Method 
(Zobraz metodu vytvoření 
MSP) 

Zobrazuje metodu vytvoření zvoleného MSP. 

View MSP Peak List 
(Zobraz seznam MSP píků) 

Otevře editor seznamu MSP píků (viz část 3.3.5.2) 

View/Edit MSP Metadata Otevře editor MSP metadat (viz část 3.3.5.2) 
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Příkaz 

(Zobraz/edituj MSP metadata) 

 

3.2.6  Panely nástrojů

Nabídka Panely nástrojů obsahuje tla
zkrácené provádění jednotlivých 
stručný popis funkce každého tlač

Toolbar ToolTip
Main toolbar 
(Hlavní panel nástrojů)   

 
Přidá spektr

 

Zavře všechna s
Vyčistí MSP 
identifikaci

 
Spustí identifi

Table View toolbar 
(Náhled tabulkového 
panelu nástrojů) 
 

  

 
Uloží knihovny

 
Uloží knihovny

 
Odstraní vybraná 

 
Odstraní všechna 
z tabulky výb

 Zobrazí 

 
Zobrazí seznam 

 
Nahrávání

Taxonomy Tree View 
(Náhled   
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Funkce 

 

Panely nástrojů 

obsahuje tlačítka, která nabízejí příkazy umož
ní jednotlivých operací a procesů. Ve sloupci ToolTips je uveden 

ný popis funkce každého tlačítka. 

ToolTip Funkce 

  

pektrum Otevření okna Spektrum Browser.

ře všechna spektra / 
MSP pro 

kaci 

Zavření všech uložených soubor
spekter/MSP. 

dentifikaci Spustí klasifikaci spektra nebo 
MSP. 

  

Uloží knihovny MSP Uložení knihovny MSP do 
externího souboru. 

Uloží knihovny MSP Uložení knihovny MSP z 
souboru. 

Odstraní vybraná MSP Odstranění zvýrazněných 

Odstraní všechna MSP 
tabulky výběru Odstranění všech MSP z  tabulk

 dendrogram MSP Vytvoření dendrogramu MSP
zvýrazněných MSP. 

Zobrazí seznam MSP píků Spuštění editoru seznamu 
píků. 

Nahrávání Nahrání zvolených MSP 
vyrovnávací paměti MBT 
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íkazy umožňující 
je uveden 

um Browser. 

ení všech uložených souborů 

a nebo 

do 

z externího 

ných MSP.  

z  tabulky. 

MSP ze 

ní editoru seznamu MSP 

MSP do rychlé 
MBT serveru 
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taxonomického 
dendrogramu) 

 Přidá MSP do výb

 
Vymaže zvolené 

 
Přidá hierarch
MSP  

 

Spustí editor 
taxonomického 
dendrogramu

 

3.2.6.1  Stavová lišta 

Stavová lišta v dolní části okna programu 
momentálně probíhajících procesech
modu) a pozici kurzoru. 

3.2.7  Online pomoc 

Online pomoc programu MALDI Biotyper
funkcí, všech menu a všech příkaz
Help > Help Topics anebo stisknutím klávesy 

Obrázky jsou uloženy jako miniatury
jeho zmenšenině. 
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idá MSP do výběru  Přidání zvýrazněné MSP 
tabulky vybraných MSP. 

Vymaže zvolené  MSP  Vyčištění zvolené tabulky

ierarchii do vybrané Přidá MSP do zvoleného 
dceřinné nody do tabulky 
vybraných MSP. 

ustí editor 
taxonomického 
dendrogramu 

Otevření editoru taxonomického 
dendrogramu programu MALDI 
Biotyper. 

ásti okna programu MALDI Biotyper poskytuje informa
jících procesech, nastavení klávesnice, uživateli (v compliance 

MALDI Biotyper poskytuje detailní popis všech softwar
všech příkazů. Online pomoc se spouští buď pomocí p

anebo stisknutím klávesy F1. 

Obrázky jsou uloženy jako miniatury. Chcete-li obrázek zvětšit, přejeďte kurzorem po 
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MSP do 
 

né tabulky MSP. 

eného nodu a 
tabulky 

editoru taxonomického 
MALDI 

informace o 
compliance 

softwarových 
ocí příkazů 

te kurzorem po 
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3.3  Práce s programem MALDI Biotyper OC  

Program MALDI Biotyper může být použit ke: 

• klasifikaci neznámých organismů pomocí: 

o hrubého spektra nebo MSP (viz část 3.4) 

o matrix CCI (viz část 3.8.3) 

• zpřesnění klasifikací úzce příbuzných mikroorganismů pomocí subtypizace MSP 

(viz část 3.4.4) 

• uspořádání spekter charakterizovaných organismů do taxonomických 

dendrogramů a MSP knihoven (viz část 3.5) 

• studiu vztahů mezi mikroorganismy pomocí: 

o PCA dendrogramů a tabulek skóre a natahování (Scores and Loadings 

tabules) (viz část 3.7) 

o MSP dendrogramů (viz část 3.6) 

o CCI matrix (viz část 3.8.1) 

3.3.1  Hrubá spektra a hlavní spektrum (MSP) 

Základním vstupem pracovních postupů při užívání programu MALDI Biotyper jsou 
hrubá spektra, a to buď neznámých anebo již charakterizovaných mikroorganismů. 
Před zaahájením přípravy je třeba tato hrubá spektra vybrat a uložit do programu 
MALDI Biotyper (viz část 3.3.2) 

Metody předběžné přípravy (viz část 3.3.4) slouží ke kontrole transformace hrubých 
spekter do seznamů píků. Metody dalšího zpracování (viz část 3.3.3) slouží ke 
kontrole vygenerovaných seznamů píků a algoritmů použitých ke generování 
výsledků. 

Některé  z procesů prgramu MALDI Biotyper potřebují mít hlavní spektra (MSPs) jako 
východisko. Tato MSP jsou vytvářena z hrubých spekter pomocí standardních metod 
předběžného zpracování (přípravy) a metod vytváření MSP. Po vytvoření jsou MSP 
uložena do databáze a dále se s nimi pracuje v tabulkovém náhledu (viz část 3.2.5). 
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3.3.2  Vkládání spekte

3.3.2.1  Práce se spektry 

Před tím, než začnou být soubory hrubých spekter zpracovávány
MSP anebo při klastrování PCA 
spekter (Spectrum Browser)¨do náhledu souboru (

3  MALDI Biotyper – Offline klasifikace (OC)
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er a MSP do Náhledu souboru 

 

nou být soubory hrubých spekter zpracovávány (např. při vytvá
 ), musí být hrubá spektra vložena pomocí prohlíže

)¨do náhledu souboru (File View). 
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ři vytváření 
musí být hrubá spektra vložena pomocí prohlížeče 
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Použití prohlížeče spekter (Spe

Prohlížeč spekter zobrazuje dendrogr
se nacházejí se ve zvoleném koř
zvoleným filtračním kritériim.  

Podle výrobního nastavení lze adresá
adresáře rozšířít. Výběrem box
dosáhnout importu spektra.  

Klikntím na nabídku Select All
nabídku Clear Selection všechny boxy v

Filtrování spekter 

Výběr možností v oblasti Filter S
podle následujících kriterií: 
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pectrum Browser) 

 

dendrogram, v němž se vyskytují všechna spektr
nacházejí se ve zvoleném kořenovém adresáři (Root folder) a která odpovídají 

Podle výrobního nastavení lze adresáře uzlů zavírat a čistit. Kliknutím na 
boxu nacházejícího se vedle názvu adresá

All vyberete všechny boxy v nabídce. Kliknutím na 
všechny boxy vyčistíte. 

Filter Spectra prohlížeče spekter umožňuje spektra filtrovat 
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pektra, která 
) a která odpovídají 

Kliknutím na  lze 
acházejícího se vedle názvu adresáře lze 

Kliknutím na 

uje spektra filtrovat 
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• buď podle typu (MS, LIFT, 

Unknown) anebo 

• podle data akvizice (From, 

Výběrem/vyčištěním nabídky typ
aktualizován. 

Chcete-li k fultrování použít data akvizice
příkaz Apply. 

V souladu s výrobním nastavením jsou pak vybrány všechny typy spekt
všechny datové filtry, takže k žádné filtraci nedochází

Oblast označená jako Vlastnosti spektra (
toho spektra, které je momentálně

Funkce Zvolená spektra (Select
v jejich dendrogramu. 

Nabídka Spectra zobrazuje poč
jak jsou zachycena v dendrogramu; poté následuje celkový po
v adresáři vybraných spekter. 

Uložení spekter do náhledu soubor

1. Otevře okno prohlížeče spekter (

File > Add Spectra anebo kliknutím na nabídku 

2. Browse… Pak přejděte v adresá

V okně se objeví ty adresáře a podadresá
Ke zpřesnění výběru použitje 
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, LIFT (converted), FAST, FAST Segment, 

, To).  

typu Spectra je dendrogram spekter automaticky 

fultrování použít data akvizice, zvolte požaqdovaný adresář a klikn

výrobním nastavením jsou pak vybrány všechny typy spekter a vymazány 
žádné filtraci nedochází. 

ená jako Vlastnosti spektra (Spectrum Properties) zobrazuje 
a, které je momentálně vybráno v dendropgramu spekter. 

Selected spectra) zobrazuje počet spekter zachycených 

počet spekter odfiltrovaných a uvedených v tom po
dendrogramu; poté následuje celkový počet spekter obsažených 

do náhledu souborů (File View)  

e spekter (Spectrum Browser) buď pomocí nabídek 

anebo kliknutím na nabídku  

adresáři  na požadované spektrum a klikněte na 

ře a podadresáře, které požadovaná spektra 
ru použitje filtry. 
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je dendrogram spekter automaticky 

 a klikněte na 

er a vymazány 

 vlastnosti 

zachycených 

tom pořadí, 
et spekter obsažených 

 pomocí nabídek Select 

te na OK. 

 obsahují. 
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3. Pomocí nabídky Select vyberte adresá

na příkaz Open, čímž je uložíte do náhledu soubor

Kliknutím na nabídku Select 
na Clear Selection naopak všechny 

Odstranění spekter z náhledu soubor

1.  Nežádoucí spektra zvýrazněte

2. Kliknutím pravého tlačítka na zvýrazn

Selected Spectra tato spektra z

3. Chcete-li z náhledu souborů (

příkazů Select File > Clear All S
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vyberte adresáře obsahující požadovaná spektra a

ímž je uložíte do náhledu souborů (File View). 

 All vyberete všechny boxy v dendrogramu. 
naopak všechny boxy vyčistíte. 

z náhledu souborů (File View) 

ěte. 

ítka na zvýrazněná spektra a použitím příkazu Remove 

tato spektra z kontextového menu odstraníte.  

ů (File View) odstranit všechna spektra, použijte bu

File > Clear All Spectra anebo klikněte na . 
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a a klikněte 

 Kliknutím 

Remove 

použijte buď 
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3.3.2.2  Ukládání spekter z

Z projektů programu MALDI Biotyper RTC 
zpracování (např. PCA, subtypizaci anebo vytvá

Při ukládání projektu MALDI Biotyper RTC 

1. Zvolte příkazy  Action > Open Realtime 

Příkazem Load Project se zahájí pot

2. Zvolte požadovaný projekt  a klikn

Soubory spekter projektu jsou takto uloženy do tabulky Náhled soubor
(File View Spectrum). Hrubé 
zvýrazněného spektra jsou pak spole
v tabulce Spectrum Scores. 

{b}Poznámka{/b} V tomto p
spekter byly v lokálním po

3.3.2.3  Zacházení s hlavními spektry (

Pro účely klasifikace lze hlavní spektra p

Uložení MSP do náhledu soubor

1. Přeneste požadovaná hlavní spektra do tabulky 

Selected MSP.  

2. Příslušné MSP zvýrazněte kliknutím pravého tla

vyberte nabídku Add MSPs for Identification

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

z projektů programu MALDI Biotyper RTC 

MALDI Biotyper RTC lze spektra pro další analaýzu 
zaci anebo vytváření MSP) ukládat přímo. 

MALDI Biotyper RTC  

Action > Open Realtime Classification Project. 

se zahájí potřebný dialog. 

 

a klikněte na OK. 

ktu jsou takto uloženy do tabulky Náhled souborů
Hrubé spektrum a výsledky klasifikace momentá

a jsou pak společně zobrazeny v náhledu (Spectrum View
 

tomto případě je zapotřebí, aby soubory hrubých 
lokálním počítači dostupné. 

hlavními spektry (MSPs) 

ely klasifikace lze hlavní spektra přidat do tabulky File View MSP. 

do náhledu souborů (File View) 

eneste požadovaná hlavní spektra do tabulky Current MSP anebo do tabulky 

te kliknutím pravého tlačítka myši a v kontextovém menu 

Add MSPs for Identification. 
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MALDI Biotyper RTC  

 nebo pro 

ktu jsou takto uloženy do tabulky Náhled souborů spekter 
momentálně 

Spectrum View) a 

ebí, aby soubory hrubých 

anebo do tabulky 

kontextovém menu 
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Odstranění MSP z náhledu soubor

1. MSP zvýrazněte kliknutím pravého tla

nabídku Remove Selected MSPs

Chcete-li z náhledu souborů odstranit všechna hlavní spektra

Select File > Clear All MSPs

3.3.2.4  Výběr spekter a MSP

Zvýraznění spekter a MSP určených ke zpracování
  
U některých pracovních postupů
MSP), je třeba příslušná spektra 
View) před zpracováním zvýraznit

• Jednotlivá spektra / MSP lze zvýrazní kliknutím levého tla

• Chcete-li zvýraznit několik po sob

klávesnici Shift a klikněte na první a poslední spektrum celé série

• Chcete-li zvýraznit několik po sob

klávesnici Ctrl a klikněte požadovaná 

• Pozadí zvýrazněných spekt

3.3.3  Tvorba, editování 

Pracovní procesy programu MALDI
spekter.  

• Metody předběžného zpracov

hrubých spekter. 

• Metody identifikace MSP  slouží k

získáno. 

• Metody tvorby MSP jsou pou

vybraných spekter. 

• Metody subtypizace tvorby 

z některého spektra hlavního 
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z náhledu souborů (File View) 

te kliknutím pravého tlačítka myši a v kontextovém menu vyberte 

ed MSPs.  

ů odstranit všechna hlavní spektra, použijte buď

File > Clear All MSPs anebo klikněte na . 

a MSP pro zpracování 

čených ke zpracování 

kterých pracovních postupů (manuální předběžná příprava, klasifikace
a nebo hlavní spektra (MSP)´v náhledu soubor

ed zpracováním zvýraznit.  

lze zvýrazní kliknutím levého tlačítka myši. 

kolik po sobě následujících spekter / MSP, podržte 

ěte na první a poslední spektrum celé série. 

kolik po sobě nenásledujících spekter / MSP, podržte 

te požadovaná spektra / MSP. 

pekter / MSP je modré. 

ování a výběr metod zpracování 

MALDI Biotyper jsou kontrolovány metodami zpracování 

žného zpracování slouží k vytvoření seznamu píků na základ

slouží k identifikaci vzorku, z něhož bylo spektrum 

jsou používány k vytvoření hlavního spektra ze souboru  

ce tvorby MSP se používají k vytvoření subtypu MSP 

kterého spektra hlavního MSP. 
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kontextovém menu vyberte 

použijte buď příkazy 

klasifikace, tvorba 
náhledu souborů (File 

podržte 

podržte 

jsou kontrolovány metodami zpracování 

 na základě 

hož bylo spektrum 

ení hlavního spektra ze souboru  

MSP 
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• Metody tvorby PCA slouží k

Component Analysis) spekt

• Metody klastrování PCA  slouží ke klastrování

na základě výsledků PCA. 

• Metody tvorby dendrogramů

základě některého  ze zvolených 

• Metody CCI (Composite Correlation Index

3.3.3.1  Editor metody programu 

Tento editor umožňuje uživateli zobrazovat
vzorků. Editor se z příslušného top
[method type] anebo příkazy Action > [method type] > Edit Method

Momentálně aktivní metoda je zobrazena v
instalace softwaru MALDI Biotyper 
pro každý proces (Biotyper [method type] Standard Method
určeny pouze pro čtení. 
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slouží k provedení analýzy hlavních komponent (Principal 

pekter předběžně zpracovaných. 

slouží ke klastrování předběžně zpracovaných 

 

tvorby dendrogramů MSP  se používají k vytvoření dendrogram

ze zvolených MSP. 

Composite Correlation Index) slouží k výpočtu  CCI matrix.

programu MALDI Biotyper  

teli zobrazovat, vytvářet a editovat metody zpracování 
íslušného top-level menu spouští buď příkazy Edit > Method > 

ction > [method type] > Edit Method. 

 

je zobrazena v poli název metody (Method Name
MALDI Biotyper obsahuje výrobcem nastavené soubory parametr
Biotyper [method type] Standard Method). Tyto parametry jsou 
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rincipal 

 zpracovaných spekter 

dendrogramu na 

CCI matrix. 

et a editovat metody zpracování 
Edit > Method > 

Method Name). Každá 
obsahuje výrobcem nastavené soubory parametrů 

Tyto parametry jsou 
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Editor také zobrazuje opční popis (Description) metody a specifická (unique) ID 
zvolené metody  (Method ID) a její verze (Method Version). Toto nastavení nelze 
měnit.  

Hlavní část editoru zobrazuje parametery a momentální nastavení pro příslušený typ 
metody. 

Chcete-li zobrazit  momentálně aktivní metody zpracování a jejich parametry, 

1. použijte příkazy  Edit > Method > [method type], čímž editor metody (MALDI 

Biotyper Method) spustíte . 

Poté se zobrazí momentálně aktivní metoda zpracování a její parametry. 

2. Editor zavřete kliknutím na OK. 

Tabulka 3-2     Metody zpracování vzorků (MALDI Biotyper processing methods) 

Typ metody Input Output 

Preprocessing 
(Předběžné zpracování/příprava)  

Hrubá spektra Seznamy píků 

MSP Identification 
(Identifikace MSP) 

Hrubá spektra anebo MSP Klasifikace 
mikroorganismů 

MSP Creation 
(Tvorba MSP) 

Seznamy píků předběžně 
zpracovaných spekter 

MSP (referenční spektrum) 

Subtypizace tvorby MSP Creation MSP Subtypizace MSP 

PCA Creation 
(Tvorba PCA) 

Předběžně zpracovaná 
spektra 

Základní analýza 
komponent  

PCA Clustering 
(Klastrování PCA) 

Předběžně zpracovaná 
spektra + PCA 

Klastrový diagram PCA 

MSP Dendrogram Creation 
(Tvorba dendrogramu MSP) 

MSP Dendrogram MSP 

Composite Correlation Index 
Calculation 
(Výpočet CCI) 

Předběžně zpracovaná 
spektra 

CCI matrix 
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3.3.3.2  Vytváření a editování uživatelských metod zpracování vzorků 
(Custom Processing Methods) 

Uživatelské metody zpracování vzorků se vytvářejí editováním kopie výrobně 
nastavené metody uložené pod odlišným názvem. 

Chcete-li metodu zpracování vytvořit 

1. použije příkazy Edit > Method > [method type], čímž  editor spustíte. 

Možnost: Popis nové metody vložte do inputového pole Description. 

2. Parametry podle potřeby upravte. 

Poznámka: Parametry metod předběžného zpracování jsou rozděleny do 
skupin  (Mass Adjustment, Smoothing atd.). Momentálně 

zobrazená skupina je označena šedou šipkou . 

3. Klikněte na Save As a nový název metody vložte do dialogu Insert New [method 

type]. 

Tato metoda bude uložena s novým ID a s vlastním číslem její verze (new Method 
ID and Method Version). 

4. Kliknutím na  OK se editor zavře a dojde k aktivaci nové metody. 

Tato nová metoda bude aktivní až do okamžiku vybrání jiné metody ze seznamu 
názvů metod (Method Name drop-down list) a po kliknutí na tlačítko OK. 

Chcete-li editovat uživatelskou metodu zpracování:   

1. použijte příkazy Edit > Method > [method type]; tím editor spustíte. 

2. Metodu, která má být editována, vyberte v seznamu názvů metod (Method Name 

drop-down list).   

3. Podle potřeby parametry upravte. 

4. Klikněte na příkaz Save. 

Metoda bude uložena pod stejným jménem a s novým ID (Method Name with a 
new Method ID). 

Propojený  
obrázek nelze  
zobrazit.  
Příslušný soubor  
byl 
pravděpodobně  
přesunut,  
přejmenován  
nebo odstraněn…
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5. Editor programu MALDI Biotyper Method zavřete a novou metodu aktivujete 

kliknutím na OK. 

3.3.3.3  Výběr metod zpracování  

Chcete-li  vybrat metodu zpracování vzorků 

1. Editor programu MALDI Biotyper Method Editor otevřete kliknutím na nabídky 

Edit > Method > [method type]. 

2. V seznamu názvů metod (Method Name drop-down list) vyberte požadovanou 

metodu. 

3. Editor MALDI Biotyper Method zavřete a vybranou metodu aktivujete kliknutím na 

OK. 

3.3.4  Předběžné zpracování spekter 

Metody předběžného zpracování se používají k vytvoření seznamu píků na základě 
hrubých spekter. Vzhledem k tomu, že množství informací potřebných pro každý 
z pracovních postupů se případ o případu různí, lze metody předběžného zpracování 
optimalizovat, čímž se proces analýzy urychlí a velikost souboru dat zmenší.  

3.3.4.1  Výrobcem nastavené metody předběžného zpracování  

Každá instalace softwaru MALDI Biotyper obsahuje tři metody předběžného 
zpracování; tyto metody jsou určeny pouze ke čtení a používají se při klasifikaci, 
tvorbě MSP, klastrování PCA a výpočtu CCI. 

Workflow 
(Pracovní posup) 

Doporučená metoda předběžného zpracování spekter 

Classification 
(Klasifikace) 

Standardní metoda předběžného zpracování v programu BioTyper 

MSP creation 
(Tvorba MSP) 

Standardní metoda předběžného zpracování v programu BioTyper 

PCA clustering 
(Klastrování 
PCA) 

Standardní PCA metoda předběžného zpracování v programu 
BioTyper 

CCI calculation 
(Výpočet CCI) 

Standardní CCI metoda předběžného zpracování v programu 
BioTyper 
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3.3.4.2  Uživatelské metody 

Uživatelé si mohou vytvořit své vlastní metody 
postupné optimalizace jednotlivých parametr
jsou v editoru metod uvedeny v tabulkách 

Chcete-li si vytvořit vlastní metodu 

1. Spusťte MALDI Biotyper Method Editor

Preprocessing…. 

Možnost: Popis nové metody vložte do inputového pole 

2. Podle potřeby parametry upravte

 
Metody předběžného zpracování

zobrazená skupina parametrů

3. Klikněte na nabídku Save As

dialogu Insert New Preprocessing Method Name

Tato metoda bude uložena s
and Method Version). 

4. Editor MALDI Biotyper Method

OK. 

Tato nová metoda bude aktivní až do okamžiku vybrání jiné metody
názvů metod (Method Name

Úprava hmotnosti 

Parametry úpravy hmotnosti (Mass Adjustment
třeba během předběžného zpracování
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metody předběžného zpracování 

t své vlastní metody předběžného zpracování
postupné optimalizace jednotlivých parametrů metod předběžného zpracování

tabulkách předběžného zpracování. 

vlastní metodu předběžného zpracování 

MALDI Biotyper Method Editor příkazem Select Edit > Method > 

Popis nové metody vložte do inputového pole Description

y upravte. 

žného zpracování jsou rozděleny do skupin. Momentáln

ů je označena šedou šipkou . 

Save As a nový název metody (Method Name) vložte

Insert New Preprocessing Method Name. 

a bude uložena s novým ID a jako číslovaná nová verze (Method ID

MALDI Biotyper Method zavřete a vybranou metodu aktivujete kliknutím na 

ato nová metoda bude aktivní až do okamžiku vybrání jiné metody ze seznamu 
Method Name drop-down list) a po kliknutí na tlačítko OK

Mass Adjustment parameters) definují zda a jak j
žného zpracování ve spektrech údaje o hmotnosti upravit
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žného zpracování pomocí 
žného zpracování, které 

Edit > Method > 

Description. 

Momentálně 

) vložte do 

Method ID 

ete a vybranou metodu aktivujete kliknutím na 

ze seznamu 
OK. 

ují zda a jak je 
upravit.  
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Vyhlazení šumu (Smoothing) 

Parametry vyhlazování šumu z měření (Smoothing)  určují zda a do jaké míry je 
během předběžného zpracování třeba spektra shladit. V programu MALDI Biotyper se 
používá Savistsky-Golay metoda vyhlazení šumu. 

Odečet od základny (Baseline Subtraction) 

Parametry tohoto odečtu (Baseline Subtraction) určují zda a do jaké míry je třeba 
povést během předběžného zpracování odečet od základní linie. V programu MALDI 
Biotyper se používají metody Multipolygon, Minimum, Penalized Least Squares a 
Penalized B-Spline baseline subtraction.  

Normalizace 

Parametry Normalization definují způsob, jímž lze spektra během 
přípravy/předbežného zpracování normalizovat. V programu MALDI Biotyper jsou 
použity metody Maximum Norm a P-Norm normalization. 

Parametry Peak Picking 

Parametry Peak Picking definují způsob zachycování píků během předbežného 
zpracování. Program MALDI Biotyper používá metody Spektra Differentiation, Peak 
Fitting a Local Maximum peak picking.  

Kontrola vlivu metody předběžného zpracování na hrubá spektra 
Optimalizace lze dosáhnout použitím příkazů Action > Preprocessing. Výběrem 
těchto příkazů příslušné aktivní parametry aplikujete k hrubým spektrům a zobrazíte 
výsledná zpracovaná spektra v Náhledu spekter (Spectrum View). 

1.   Požadovaná spektra vložte a zvýrazněte (viz část 3.3.2). 

V náhledu Spectrum View mají zvýrazněná spektra modrou barvu. 

2. Zvolte  příkazy Edit > Method > Preprocessing. V seznamu názvů metod 

(Method Name drop-down list), který se nachází v editoru metod vyberte 

požadovanou metody a klikněte na OK. 

3. Vliv jednotlivých parametrů prověřte následujícím způsobem: 

a. Příkazy Action > Preprocessing > Adjust Mass. 
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Pro všechna zvýrazněná spektra se vygeneruje spektrum hmotnostně upravené, 
které pak v oranžovém zabarvení překryje spektrum hrubé.  

b. Příkazy Action > Preprocessing > Smooth. 

Pro všechna zvýrazněná spektra se vygeneruje spektrum hmotnostně upravené, 
které pak v purpurovém zabarvení překryje spektrum hrubé. 

c. Příkazy Action > Preprocessing > Subtract Baseline. 

Pro všechna zvýrazněná spektra se vygeneruje spektrum hmotnostně upravené, 
vyhlazené, a odečtené od základny (baseline-subtracted), které pak 
v modrozeleném  zabarvení překryje spektrum hrubé. 

d.     Příkazy Preprocessing > Normalize. 

Pro všechna zvýrazněná spektra se vygeneruje spektrum hmotnostně upravené, 
vyhlazené, a odečtené od základny, které pak v zeleném zabarvení překryje 
spektrum hrubé. 

e. Příkazy Selecting Action > Preprocessing > Pick Peaks. 

Pro všechna zvýrazněná spektra se vygeneruje výsledný pík (peak picking result) 
a ten se zobrazí v barvě červené (při použití inverzní stupnice intenzity) pod 
předem zpracovaným (předpřipraveným) spektrem. 

f. Příkazy Action > Preprocessing > Batch Processing. 

Výše uvedené kroky a – e lze také provést jediným příkazem Batch Processing, 
kterým se vygeneruje výsledný pík pro všechna zvýrazněná spektra. 

3.3.5  Standardní a subtypizovaná hlavní spektra  

Při použití přístroje MALDI Biotyper je základem klasifikace hlavní spektrum (MSP). 
Toto spektrum je spektrem referenčním (nebo přesněji řečeno referenčním seznamem 
píků), které pak je přiřazeno (assigned) k určitému druhu nebo kmenu 
mikroorganismů. 

Při klasifikačním postupu jsou profily píků (peak patterns) neznámých vzorků 
porovnávány s údaji uloženými v knihovně MSP. Získané skóre shody (matching 
score) je pak měřítkem pravděpodobnosti správné klasifikace. 
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Hlavní spektra jsou vytvořena pomocí analýzy velkého po
dobře charakterizovaných vzorků
je obvykle vytvořeno na základě
dat je softwarem vygenerován 
základě informací o hmotnostni pík
a intenzitě  jejich distribuce (intensity distribution

Místo hrubých spekter lze ke klasifikaci vzork

Subtypizovaná MSP se používají p
informací o frekvenci píků a intenzit
MSP používá i dodatečné zvážení rozlišovacích pík
distinguishing peaks). 

Subtypizovaná MSP se používají p
standardních MSP nedávají jednozna

3.3.5.1  Tvorba standardních 

Standardní hlavní spektrum (M

1. Okno prohlížeče spekter otevř

kliknutím na . 

2. Kliknutím na Browse… pak na

kliknete na OK. 

Adresáře a podadresáře obsahující jednotlivá spektra
(main body) okna. Toto vyhledávání zkrátíte použitím 
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ena pomocí analýzy velkého počtu spekter získa
ovaných vzorků kultivovaných v příznivých podmínkách. Jedno MSP 
eno na základě 20 takovýchto spekter. Na základě celého souboru 

 seznam píků a příslušné MSP pak je vytvo
cí o hmotnostni píků (peak mass), o jejich frekvenci (peak frequency

intensity distribution).  

Místo hrubých spekter lze ke klasifikaci vzorků použít také spektra hlavní. 

se používají při rozlišování úzce příbuzných druhů
 a intenzitě jejich distribuce se při tvorbě sbtypizovan
né zvážení rozlišovacích píků (additional weighting to 

se používají při klasifikaci těch vzorků, které př
standardních MSP nedávají jednoznačné výsledky. 

ních MSP 

(MSP) se vytvoří takto: 

e spekter otevřete buď příkazy Select File > Add Spektra

naleznete adresu souboru požadovaného spektra a 

e obsahující jednotlivá spektra se pak objeví v hlavní 
Toto vyhledávání zkrátíte použitím filtrů 
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získaných u 
Jedno MSP 

 celého souboru 
pak je vytvořeno na 

peak frequency) 

íbuzných druhů. Kromě 
btypizovaných 

additional weighting to 

, které při použití 

a anebo 

leznete adresu souboru požadovaného spektra a 

hlavní části 
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3. Zkontrolujte zda jsou požadovaná 

nabídku Open je vložte do náhledu soub

Všechny boxy dendrogramu vyber
na nabídku Clear Selection všechny boxy vyprázdníte

K vytvoření standardního MSP je zapot

Možnost:  Běhen výbě
zpracování bu

a.  Action > Preprocessing > Edit Method

b.  Edit > Method > Preprocessing

Doporučenou metodou předb
zvaná Biotyper Preprocessing Standard Method

Možnost:  Metodu tvorby MSP lze d

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

 

Zkontrolujte zda jsou požadovaná spektra v asdresářích obsažena a kliknutím na 

je vložte do náhledu souboru (File View). 

Všechny boxy dendrogramu vyberete kliknutím na nabídku Select All. 
všechny boxy vyprázdníte. 

ení standardního MSP je zapotřebí nejméně dvaceti spekter. 

hen výběru definujte metodu použitou při předb
zpracování buď pomocí příkazů: 

Action > Preprocessing > Edit Method nebo příkazů 

Edit > Method > Preprocessing.  

ředběžného zpracování vzorků je standardní metoda 
Biotyper Preprocessing Standard Method. 

Metodu tvorby MSP lze definovat buď pomocí příkazů: 

fline klasifikace (OC) 
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kliknutím na 

. Kliknutím 

ředběžném 

 je standardní metoda 
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a. Action > MSP Creation > Edit Method anebo   

b. Edit > Method > MSP Creation.  

Doporučenou metodou tvorby MSP je standardní metoda zvaná Biotyper MSP 
Creation Standard Method. 

4. Ty soubory spekter, které mají být použity k tvorbě MSP, je třeba v kontextovém 

menu   náhledu souboru (File View) zvýraznit buď příkazy : 

a. Select Action > MSP Creation > Create či Create MSP, čímž se z hrubých 

spekter jednoho mikroorganismu vytvoří jediné MSP)  

ANEBO příkazy  

b. Select Action > MSP Creation > Create Series či Create MSP Series, čímž 

se z hrubých spekter různých mikroorganismů vytvoří vícenásobná MSP. 

Názvy těchto MSP jsou vygenerovány na základě použití nejnižší úrovně 

názvů nejednoznačných adresářů obsahujících příslušná spektra. Tak např. 

sérii hlavních spekter vytvořených ze spekter nacházejících se adresářích 

D:\data\MALDI_Biotyper_data\Acinetobacter\Acinetobacter 

baylyi a 

D:\data\MALDI_Biotyper_data\Acinetobacter\Acinetobacter 

grimontii budou přiřazeny názvy hlavních spekter (MSP) druhů 

Acinetobacter baylyi a Acinetobacter grimontii. 

Poznámka: Přesvědčte se, zda se všechna spektra použitá k tvorbě MSP 
jednoho druhu mikroorganismů nacházejí v jednom a tomtéž 
adresáři. 

6. Jinou možnost představuje následující postup: 

a. Buď vložte jméno nového MSP (Create MSP) a klikněte na OK.  



Bruker Daltonik GmbH 
 

MALDI Biotyper 3.0 User Manual Revision 2
 

ANEBO 

b. Klikněte na OK, čímž akcept

Series of MSPs). 
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ceptujte přiřazené (assigned) názvy MSP (Create 
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Názvy MSP by se měly skládat z rodového a druhového jména příslušného 
mikroorganismu; nově vytvořená MSP jsou v dendrogramu přidávána do uzlu 
Unassigned MSPs. 
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3.3.5.2  Zobrazení a editování seznam
metadat 

Zobrazení a editování seznamu

Seznam hodnot m/z, intenzity a 
editoru MALDI Biotyper MSP Peak List Editor.

1. Požadované MSP přesuňte bu

2. Pravým tlačítkem myši klikněte 

menu vyberte příkaz View MSP Peak List

 (pouze u vybrané tabuky

Tím se otevře editor seznamu pík

Hodnoty m/z a intenzity jsou zobrazeny s
na příslušnou buňku zobrazíte p

Seznamy lze třídit podle hodnot uvedených v
záhlaví příslušného sloupce kliknete
(buď zdola nahoru nebo naopak
indikovány šipkou, která se nachází vedle záhlaví p
�). 

Jednotlivé píky lze vybírat kliknutím na šedé polí
příslušného píku. Chcete-li vybrat v
klávesu Shift a klikněte na první a poslední pík dané série
počet po sobě nenásledujících pík
požadované píky. Kliknutí pravým tla
kontextové menu, které obsahuje p
vlož). 

Poznámka: Informace vybrané nebo zkopírované z
nelze do jiných seznam
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Zobrazení a editování seznamů standardních MSP píků 

Zobrazení a editování seznamu píků určitého MSP  

a hmotnosti (weightings) MSP píků lze editovat pomocí 
MALDI Biotyper MSP Peak List Editor. 

te buď to tabulky Current MSP anebo Selected MSP

ěte na tabulku MSP (table entry) a v kontextovém 

View MSP Peak List. Jinou možnost představuje, kliknutí na 

pouze u vybrané tabuky MSP). 

e editor seznamu píků (MALDI Biotyper MSP Peak List). 

jsou zobrazeny s přesností na 2 desetinná místa. 
ku zobrazíte přesnou hodnotu  v ní obsaženou. 

ídit podle hodnot uvedených v jednotlivých sloupcích, a to tak, že na 
kliknete. Opakovaným kliknutím se směr třídě

 zdola nahoru nebo naopak). Sloupec a pořadí použité pro třídě
indikovány šipkou, která se nachází vedle záhlaví příslušného sloupce 

kliknutím na šedé políčko nacházející se vlevo od 
li vybrat větší počet po sobě následujících píků

te na první a poslední pík dané série. Chcete-li vybrat v
 nenásledujících píků, podržte klávesu Ctrl a klikn

utí pravým tlačítkem myši na vybrané řádky otevírá 
, které obsahuje příkazy Cut, Copy a Paste (vyjmi, zkopíruj a 

vybrané nebo zkopírované z určitého seznamu pík
nelze do jiných seznamů vkládat. 
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 a 

ovat pomocí 

Selected MSP. 

kontextovém 

kliknutí na  

. Kliknutím 

jednotlivých sloupcích, a to tak, že na 
řídění změní 

adí použité pro třídění jsou 
 (� nebo 

ko nacházející se vlevo od řádku 
ledujících píků, podržte 

li vybrat větší 
klikněte na 

řádky otevírá 
zkopíruj a 

itého seznamu píků 
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3. Změny údajů obsažených v seznamech pík

buňku a vložením požadované informace

4. Editor uzavřete a provedené zm

Zobrazení a editování metadat 

{b}Poznámka{/b} MSP metadata 
údaje o jeho původu
vzorku. Všechny tyto údaje jsou nepovinné a slouží pouze pro 
Tato metadata jsou uložena do databáze programu 

1. Požadované MSP přesuňte bu

Selected MSP. 

2. Pravým tlačítkem myši klikněte na tabulku 

příkazy Select View / Edit MSP Metadata

Tím se otevře editor MALDI Biotyper MSP Metadat.
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seznamech píků lze provést kliknutím na příslu

ku a vložením požadované informace. 

ete a provedené změny uložíte kliknutím na OK. 

 určitého MSP  

MSP metadata zahrnují název a kmen mikroorganismu a 
vodu, kultivačních podmínkách a způsobu zpracování 

Všechny tyto údaje jsou nepovinné a slouží pouze pro 
jsou uložena do databáze programu MALDI Biotyper.

te buď do tabulky Current MSP anebo do tabulky 

ěte na tabulku MSP a v kontextovém menu vyberte 

View / Edit MSP Metadata. 

MALDI Biotyper MSP Metadat. 

klasifikace (OC) 
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říslušnou 

zahrnují název a kmen mikroorganismu a 
sobu zpracování 

Všechny tyto údaje jsou nepovinné a slouží pouze pro informaci. 
MALDI Biotyper. 

anebo do tabulky 

kontextovém menu vyberte 
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3. Kliknutím na   se provedou požadované zm

 

Field 
(Pole) 

Funkce 

Organism 
(Orgasmus 

Zápis rodového a druhového jména

Strain 
(Kmen) 

Zápis názvu kmene

Provided by 
(Původ vzorku) 

Identifikátor zdroje vzorku
kliknutím na nabídky 

Determined by Identifikátor metody stanovení 

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

 

se provedou požadované změny metadat. 

odového a druhového jména 

Zápis názvu kmene 

kátor zdroje vzorku. identifikátor lze vytvořit/editovat 
utím na nabídky New…/Edit…. 

kátor metody stanovení ID vzorku. Tento identifikátor lze 

Offline klasifikace (OC) 
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it/editovat 

Tento identifikátor lze 
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Field 
(Pole) 

Funkce 

(Stanoveno pomocí) vytvořit kliknutím na nabídky New…/Edit…. Hodnota 'Typ kmene' 
(Type strain) je speciální hodnotou, která označuje tu hodnotu, 
která označuje, že příslušný kmen je uložen v typové kolekci 
(např.v  ATCC nebo v DSM) a že ho 'poskytovatel' vzorku z této 
typové kolekce získal. 

Conserved 
(Zakonzervováno) 

Kontrola toho, zda je vzorek zakonzervován. 

Extraction Method 
(Metoda extrakce) 

Extrakční metoda použitá ke zpracování vzorku. Vytvoří se 
kliknutím na New… 

Matrix MALDI matrix použitá ke generování spektra. Vytvoří se kliknutím 
na New… 

Growth Conditions 
(Kultivační 
podmínky)   

Záznam o kultivačních podmínkách vzorku. 

Comment 
(Poznámka) 

Případné poznámky. 

 

4. Kliknutím na  OK editor zavřete a změny uložíte. 

Zobrazení detailů o MSP 

1. Požadované MSP přesuňte do tabulky Current MSP nebo Selected MSP. 

2. Pravým tlačítkem myši klikněte na MSP a v kontextovém menu vyberte buď 

zobrazení metody předběžného zpracování (View Preprocessing Method) anebo 

metody tvorby MSP (View MSP Creation Method). 

Tím se otevře editor programu MALDI Biotyper a zobrazí se příslušná metoda 
zpracování vzorku (určeno pouze ke čtení). 

3. Kliknutím na  OK se editor uzavře. 

3.3.5.3  Vymazání nepřiřazených MSP 

Nepřiřazená MSP lze vymazat pomocí editoru taxonomického dendrogramu. 
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Vymazání nepřiřazeného MSP 

1. Klikněte pravým tlačítkem myši na 

dendrogramu a vyberte buď př

na  . 

Tím se editor taxonomického dendrogramu

    V tabulce nepřiřazených MSP, 

2. Vymazání potvrďte a editor zav

3.3.5.4  Vytvoření, zobrazení 

Subtypizovaná MSP jsou vázána na svá rodi
v databázi a jsou zpracovávána spole

Poznámka Vytváření subtypi
příslušných mi
vyspělými uživateli

Vytváření subtypizovaných MSP

1. Příslušné MSP přesuňte do tabulky vybraných 

myši na název MSP v tabulce 

Selection nebo klikněte na 

Do tabulky vybraných MSP musí být vložena nejmén

Jiná možnost: Metodu tvorby subtypizovaného 

a. Action > MSP Creation > Edit Subtyping 

b. Edit > Method > Subtyping MSP Creation 

2. V tabulce Selected MSP zvýrazn

klikněte na  zvýrazněná MSP

Subtyping MSPs. 

3  MALDI Biotyper – Offline klasifikace (OC)
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MSP  

ítkem myši na taxonový uzel náhledu taxonomického 

ď příkaz Start Taxonomy Tree Editor anebo klik

ického dendrogramu otevře. 

MSP, klikněte na MSP a zvolte příkaz Delete MSP

zavřete kliknutím na OK. 

zobrazení a editace subtypizovaných MSP 

jsou vázána na svá rodičovská standardní MSP, jež se nacházejí 
databázi a jsou zpracovávána společně s nimi.  

ubtypizovaných MSP si vyžaduje expertní znalost 
mikroorganismů a mělo by být prováděno pouze 

lými uživateli. 

MSP 

te do tabulky vybraných MSP. Pak klikněte pravým tla

tabulce Current MSP a buď vyberte příkaz Add to MSP 

. 

Do tabulky vybraných MSP musí být vložena nejméně dvě MSP. 

Metodu tvorby subtypizovaného MSP definujte pomocí p

ation > Edit Subtyping Method anebo příkazů 

> Subtyping MSP Creation . 

zvýrazněte požadované MSP. Pravým tlačítkem myši 

MSP a v kontextovém menu zvolte příkaz Create 
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ického 

o klikněte 

Delete MSP. 

ovská standardní MSP, jež se nacházejí 

ní znalost 
ěno pouze 

te pravým tlačítkem 

Add to MSP 

definujte pomocí příkazů : 

 

ítkem myši 

Create 
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Tím se otevře editor programu 
MSP jsou pak zobrazena v tabulce standardních 

Nežádoucí MSP se ze seznamu standardních 
kliknutím pravého tlačítka myši a
v kontextovém menu. 

3. Pravým tlačítkem myši klikněte 

zvolte příkaz Create Subtyping MSPs

Poté, co jsou subtypizovaná 
tabulky subtypizovaných MSP. 
indikuje, že označená MSP js

Seznam subtypizovaných MSP 
v seznamu subtypizovaných 
příkazu Edit MSP Peak List v

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

editor programu MALDI Biotyper Subtyping MSP. Zvýrazn
tabulce standardních MSP editoru. 

se ze seznamu standardních MSP odstraní zvýrazn
myši a vybráním příkazu Remove MSP from List

 

ěte tabulku standardních MSP a v kontextovém menu  

Create Subtyping MSPs. 

zovaná MSP vytvořena, dojde v editoru k jejich zanesení do 
MSP. Zelené označení v tabulce standardních

sou  se svými subtypizovanými MSP propojena

MSP lze editovat zvýrazněním příslušného údaje 
zovaných MSP, kliknutím pravého tlačítka myši a 

v kontextovém menu. 
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Zvýrazněná 

odstraní zvýrazněním, 
Remove MSP from List 

kontextovém menu  

jejich zanesení do 
ních MSP 

propojena. 

íslušného údaje 
myši a výběrem 
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4. Kliknutím na OK editor zavřete 

Zobrazení/editování seznamu pík
Seznam píků subtypizovaných MSP
frekvence jako jejich výchozí 
weightings) však jsou odlišné. Podobn
intenzity a hmotností editovat.  

1. Výchozí standardní MSP přesu

pravého tlačítka myši na název 

(Current MSP) a volbou příkazu 

2. Zvolte příkazy MSP Creation > Create Subtyping MSPs

Tím se otevře editor MALDI 
uvedena v tabulce Subtyping MSP

3. Pravým tlačítkem myši klikněte na 

v kontextovém menu zvolte př

Tím se otevře editor MALDI Biotyper

3  MALDI Biotyper – Offline klasif

Revision 2 

 

řete a subtypizovaná MSP uložíte do databáze

seznamu píků subtypizovaných MSP 
MSP má stejné hodnoty m/z, stejné intenzity

jako jejich výchozí (parent) standardní MSP; píkové hmotnosti (
Podobně jako u standardních MSP lze hodnoty 

řesuňte do tabulky vybraných hlavních spekter k

název MSP v tabulce aktuálních hlavních spekter 

říkazu Add to MSP Selection nebo kliknutím na 

MSP Creation > Create Subtyping MSPs. 

MALDI Biotyper Subtyping MSP. Subtypizovaná 
Subtyping MSPs editoru. 

ěte na požadované subtypizované MSP a 

kontextovém menu zvolte příkaz Edit MSP Peak List. 

MALDI Biotyper Peak List. 

Offline klasifikace (OC) 

Strana 115 

uložíte do databáze. 

zity a stejné 
; píkové hmotnosti (peak 

lze hodnoty m/z, 

te do tabulky vybraných hlavních spekter kliknutím 

tabulce aktuálních hlavních spekter 

nutím na . 

zovaná MSP jsou 
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4. V seznamu píků pak proveďte požadované zm

Editovat lze i hodnoty m/z, inten
píkové hmotnosti. 

5. Kliknutím na OK editor uzavřete a zm

3.3.5.5  Vymazávání subtypi

Kolekci subtypizovaných MSP

1. Kliknutím pravého tlačítka myši na 

přesuňte výchozí standardní MSP

do tabulky Selected MSP a bu

klikněte na . 

2. Zvolte příkazy MSP Creation > Create Subtyping MSPs

Tím se otevře editor MALDI Biotyper
MSP je uveden v tabulce Subtyping MSPs 

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

e požadované změny. 

intenzity a hmotnosti. Doporučuje se však mě

uzavřete a změny uložíte. 

ubtypizovaných MSP 

P lze vymazat následujícím způsobem: 

myši na jméno MSP uvedené v tabulce Current MSP 

MSP spolu s navazující kolekcí subtypizovaných 

buď zvolte příkaz Add to MSP Selection neb

MSP Creation > Create Subtyping MSPs. 

MALDI Biotyper Subtyping MSP. Seznam subtypi
Subtyping MSPs tohoto editoru. 
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ěnit pouze 

Current MSP 

zovaných MSP 

nebo 

ubtypizovaných 



Bruker Daltonik GmbH 3  MALDI Biotyper – Offline klasifikace (OC) 
 

MALDI Biotyper 3.0 User Manual Revision 2 Strana 117 
 

3. Pravým tlačítkem myši klikněte na tabulku  subtypizovaných MSP a v kontextovém 

menu zvolte příkaz Delete All. 

4. Kliknutím na OK se editor zavře. 

3.4  Klasifikace neznámých vzorků porovnáním 
jejich spekter anebo hlavních spekter 

Analýza programem MALDI Biotyper generuje charakteristickou hmotnost a intenzitu 
distribuce proteinů určitého vzorku. Vzhledem k tomu, že toto spektrum je pro velký 
počet mikroorganismů druhově specifické, představuje jejich molekulární identifikátor 
('molecular fingerprint'). Neznámé mikroorganismy lze identifikovat porovnáním 
jejich identifikátoru ('fingerprint') s tisíci předloh (MSP), které se nacházejí v referenční 
databázi. Těsnost shody identifikovaného neznámého vzorku s referenčním hlavním 
spektrem (MSP) se přitom odráží v hodnotě skóre vypočteného přímo v průběhu 
procesu tohoto porovnávání (viz část 3.4.1). 

Subtypizační identifikační proces (pomocí subtypizovaných MSP) umožňuje přesnou 
klasifikaci úzce příbuzných druhů. 

3.4.1  Výpočet hodnoty skóre 

Při zpracování dat je v tomto případě prvním krokem převod hrubých hmotnostních 
spekter do seznamu píků. Ve druhém kroku pak jsou tyto seznamy píků porovnávány 
se specifickým podsouborem předloh uložených v referenční databázi. 

Srovnávací algoritmus přitom vypočítává tři samostatné hodnoty tří základních 
charakteristik identifikovaného vzorku a spekter referenčních.  

1. Nejprve se vypočte počet těch signálů v referenčním spektru, které se velmi  blíží 

hodnotám zjištěným u neznámého spektra. Nulová shoda je hodnocena známkou 

0, úplná shoda známkou 1. 

2. Poté se stanoví počet těch signálů neznámého spektra, které se velmi  blíží 

hodnotám spektra referenčního. I v tomto případě je nulová shoda hodnocena 

známkou 0 a úplná shoda známkou 1. 

3. Naskonec se vypočte symetrie shody signálních párů. Shodují-li se vysoce 

intenzivní signály neznámého spektra s vysoce intenzivními signály spektra 

referenčního a jestliže spolu korespondují i signály nízko intenzivní, získáváme 
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vysokou hodnotu symetrie a tzv. k

Jestliže srovnávané páry signál

výsledek hodnotu blízkou 0. 

Tyto tři výsledné hodnoty se potom navzájem vynásobí a výsledek je normalizován na 
1000. Hodnota skóre je logaritmem tohoto výsledku
má hodnotu 3 (= log 1000). 

Následné seřazení hodnot skóre uvádí nejlepší souvztažnosti v
konečného seznamu. Čím je hodnota skóre vyšší, tím je 
pravděpodobnější. Barevně zvýrazn
vyhodnocení konečného výsledku

Hodnoty skóre ≥ 2.0 lze považovat za pravd

Poznámka: Důležité je uv
MALDI Biotyper
mikroorganism
databáze tohoto programu

3.4.2  Provádění klasifi

Neznámý vzorek lze klasifikovat na základ
s referenčím seznamem píků, který je uložen v

Chcete-li provést klasifikaci neznámého vzorku

1. Vložte MSP určené pro porovnání se vzorkem následujícím zp

a.  Buď určitý taxonomický uzel v

zvýrazníte, kliknete na něj 

vyberte příkaz Add Hierarchy to MSP Selection

ANEBO 

b. taxonomický uzel v náhledu 

klikněte na  . 

ANEBO 

3  MALDI Biotyper – Offline klasifikace (OC)
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ie a tzv. korelační matrix skýtá hodnotu, která se blíž

Jestliže srovnávané páry signálů nevykazují vůbec žádnou symetrii, má kone

i výsledné hodnoty se potom navzájem vynásobí a výsledek je normalizován na 
aritmem tohoto výsledku. Maximální dosažitelné skóre tedy 

azení hodnot skóre uvádí nejlepší souvztažnosti v horní části jejich 
ím je hodnota skóre vyšší, tím je klasifikac

 zvýrazněná hodnota skóre přitom umoňuje rychlé 
ného výsledku. 

lze považovat za pravděpodobnou klasifikaci. 

ležité je uvědomit si, že skóre vygenerované programem 
MALDI Biotyper vyjadřuje pravděpodobnost toho, že neznámý 
mikroorganismus patří do některého specifického podsouboru 

tohoto programu. 

lasifikace 

kovat na základě porovnání jeho spektra nebo 
, který je uložen v databázi MSP. 

neznámého vzorku 

ené pro porovnání se vzorkem následujícím způsobem: 

omický uzel v náhledu  taxonomického dendrogramu 

na něj pravým tlačítkem myši a v kontextovém menu pak 

Add Hierarchy to MSP Selection. 

náhledu  taxonomického dendrogramu zvýrazněte
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skýtá hodnotu, která se blíží k 1. 

má konečný 

i výsledné hodnoty se potom navzájem vynásobí a výsledek je normalizován na 
dosažitelné skóre tedy 

části jejich 
klasifikace druhu 

ňuje rychlé 

ované programem 
podobnost toho, že neznámý 

kterého specifického podsouboru 

 porovnání jeho spektra nebo MSP 

ického dendrogramu 

kontextovém menu pak 

ěte a 
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c. vložíte/natáhnete knihovnu 

Vybraná MSP pak jsou přidána do ta
v okně Náhled tabulky (Table View

2. Zvýrazněte spektrum nebo MSP 

souboru (viz část 3.3.2). 

Možnost: Metodu předběžného zpracování d
těchto příkazů: 

a. buď zvolte příkazy Action > Preprocessing > Edit 

anebo příkazy 

b. Edit > Method > Preprocessing

Doporučenou metodou předb
metoda předběžné přípravy vzorku (

Možnost:  Metodu identifikace MSP d
příkazů:  

a. Action > Identification > Edit 

b. Edit > Method > MSP Identification

Doporučenou metodou identifikace je v
identifikace vzorku (BioTyper MSP Identification Standard Method

3. Klasifikaci zahajte buď volbou p

kliknutím na . 

Indikační lišta v dolní části okna programu 
stav klasifikace . 

Možnost:  Kliknutím na 

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

vložíte/natáhnete knihovnu MSP (viz část 3.5.4) 

řidána do tabulky Selected MSPs, která se nachází 
Table View). 

o MSP neznámého vzorku a uložte je do Náhledu 

ěžného zpracování definujte během klasifikace 

Action > Preprocessing > Edit Method  

> Preprocessing.  

ředběžného zpracování je v tomto případě standardní 
ípravy vzorku (BioTyper Preprocessing Standard Method

Metodu identifikace MSP definujte během klasifikace buď vybráním 

Action > Identification > Edit Method anebo příkazů 

Edit > Method > MSP Identification.  

enou metodou identifikace je v tomto případě standardní metoda 
BioTyper MSP Identification Standard Method). 

 volbou příkazů Identification > Start Identification

ásti okna programu MALDI Biotyper indikuje momentální 

Kliknutím na   klasifikaci přerušíte. 
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která se nachází 

neznámého vzorku a uložte je do Náhledu 

 vybráním 

ě standardní 
BioTyper Preprocessing Standard Method). 

ď vybráním 

 standardní metoda 

Identification > Start Identification anebo 

kuje momentální 
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V závislosti na tom, jak dalece jsou vzorky k
spektra/názvu MSP objeví v
indikují kvalitu shody porovnávaných soubor

3.4.3  Zobrazení výsledk

Deset3 nejpřesnějších výsledků
zobrazeno v tabulce Spectrum / MSP Scores
signálů indikuje míru shody (zelená

Doplňující informace o skóre lze zobrazit k
tabulky  Spektrum Scores a výbě

Grafické zobrazení míry shody mezi vzorkem a zvýrazn
píků lze nalézt v okně Identification View

                                                           
3Maximální počet zobrazených případů shody lze zm

General Settings > Result Display

skóre (Maximum Number of Scores Retrieved after Match)
4Prahové hodnoty barevného kódování skóre lze uživatelsky nastavit pomocí  p

Options > General Settings > Result Display > MSP Identification > Result 

Thresholds. 

3  MALDI Biotyper – Offline klasifikace 

Revision 2 

závislosti na tom, jak dalece jsou vzorky klasifikovány, se vedle názvu souboru 
spektra/názvu MSP objeví v Náhledu souboru dopravní světelné signály, které 
indikují kvalitu shody porovnávaných souborů s předlohou. 

výsledků  klasifikace MSP  

výsledků klasifikace je spolu s jejich příslušnými 
Spectrum / MSP Scores. Kódování v barvách dopravníc

zelená = dobrá shoda, červená = špatná shoda)4

lze zobrazit kliknutím pravého tlačítka myši na 
výběrem požadované možnosti v kontextovém menu

ení míry shody mezi vzorkem a zvýrazněným seznamen referen
Identification View.  

ů shody lze změnit pomocí příkazů Tools > Options > 

General Settings > Result Display a vybráním požadovaného maximálního počtu nalezených 

Maximum Number of Scores Retrieved after Match).  

Prahové hodnoty barevného kódování skóre lze uživatelsky nastavit pomocí  příkazů Tools > 

Options > General Settings > Result Display > MSP Identification > Result 
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se vedle názvu souboru 
telné signály, které 

íslušnými skóre 
barvách dopravních 

4. 

 

myši na záhlaví 
kontextovém menu. 

ným seznamen referenčních 

Tools > Options > 

tu nalezených 

Tools > 

Options > General Settings > Result Display > MSP Identification > Result 
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Seznam píků spektra neznámého vzorku je zobrazen v
Zbarvení těchto píků odráží míru jejich shody s
shoda, žlutá = částečná shoda, č

V dolní polovině grafu je v modré barv
referenčního MSP (invertní stupnice barevné intenzity)

3.4.4  Subtypizace úzce p

Subtypizace uživatelům umožň
jednotlivé kmeny v rámci stejného druhu)
k dispozici subtypizační hlavní spektra (

Znaménko plus u markeru kódování v
porovnání shody lze tuto subtypiza
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 spektra neznámého vzorku je zobrazen v horní polovině tohoto grafu
 odráží míru jejich shody s referenčním MSP (zelená

červená = žádná shoda). 

modré barvě zobrazen seznam píků příslušného 
ní stupnice barevné intenzity). 

úzce příbuzných mikroorganismů 

m umožňuje rozlišit úzce příbuzné mikroorganism
rámci stejného druhu). Subtypizaci lze provést pouze tehdy, jsou

ní hlavní spektra (MSPs) (viz část 3.3.5.4). 

u markeru kódování v barvách dopravních signálů indikuje, že 
zační klasifikaci provést.  
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 tohoto grafu. 
zelená = plná 

 příslušného 

organismy (např. 
zaci lze provést pouze tehdy, jsou-li 

kuje, že  pro 
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Subtypizační klasifikaci lze zahájit bu
v tabulce obsahují skóre hodnocení s
Scoring z kontextového menu. 

Při subtypizaci se v datových souborech úzce p
rozlišovacích píků zvyšují zatímco hmotnosti spole

Výsledek subtypizační klasifikace

Identifikační náhled zobrazuje shodu (familiary match) mezi vzorkem a seznamem 
referenčních píků. 
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ní klasifikaci lze zahájit buď opalovaným kliknutrím na výsledek uvedený 
ahují skóre hodnocení spekter/MSP anebo výběrem příkazu View Sub

datových souborech úzce příbuzných organismů hmotnosti 
 zvyšují zatímco hmotnosti společných píků klesají. 

e je zobrazen v tabulce Sub-MSP Scores.  

 

zobrazuje shodu (familiary match) mezi vzorkem a seznamem 
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 opalovaným kliknutrím na výsledek uvedený 
View Sub-

ů hmotnosti 

zobrazuje shodu (familiary match) mezi vzorkem a seznamem 
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3.4.5  Generování zprávy o výsledcích k

Podrobnou zprávu o výsledcích k

Tato zpráva obsahuje stejné informa
programu MALDI Biotyper RTC

Chcete-li vygenerovat zprávu o

1. V náhledu souboru (File View

spektra / MSP a v kontextovém menu zvolte p

Tím se otevře dialog Enter Report Title
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Revision 2 

 

ování zprávy o výsledcích klasifikace  

výsledcích klasifikace lze vygenerovat po každé dílčí klasifikaci. 

informace jaka ty, které jsou vygenerovány př
MALDI Biotyper RTC (viz část 2.17). 

zprávu o výsledcích klasifikace: 

File View) klikněte pravým tlačítkem myši na  požadovaná 

kontextovém menu zvolte příkaz Create Report.  

Enter Report Title. 
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ovány při použití 

požadovaná  
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2. Použijte příkazy Name a Description

3. Kliknutím na OK zprávu vytvoř

Na lokálním pevném disku jsou k
následujícím způsobem:  

C:\Documents and Settings\<username>

Daltonik\MALDIBiotyperAutomationControl

Při každém vytvoření nové zprávy je stávající 

3.5   Taxonomické dendrogramy a knihovny 

V programu MALDI Biotyper mohou být hlavní spektra sdružová
odlišných struktur:   

• Taxonomické dendrogramy 

hierarchicky seřazeným taxon

odvozeny of taxonomického dendrogramu 

MALDI Biotyper poskytuje dva 

o Taxonomický  — tento dendrogram je ur

všechny uzly taxonomického dendrogramu 

o Taxonomický firmy Bruker

NCBI, který obsahuje více ne

• Knihovny MSP — uživatelem definované 

spekter. Tyto kolekce lze použít p

skupiny hlavních spekter. 
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Description (nepovinné). 

zprávu vytvoříte a otevřete ji ve standardním prohlížeči. 

Na lokálním pevném disku jsou klasifikační zprávy uloženy jako <projectname>.html 

<username>\Application Data\Bruker 

DIBiotyperAutomationControl\HtmpResults 

ení nové zprávy je stávající HTML soubor přepsán. 

ické dendrogramy a knihovny MSP

mohou být hlavní spektra sdružována pomocí dvou 

Taxonomické dendrogramy jsou kolekcemi těch MSP, která lze  přiřadit k

taxonovým uzlům, jejichž uspořádání a názvy jsou 

ického dendrogramu NCBI. Každá instalace softwaru 

poskytuje dva taxonomické dendrogramy:  

tento dendrogram je určen pouze pro čtení a obsahuje 

všechny uzly taxonomického dendrogramu NCBI. 

Bruker— podsoubor  taxonomického dendrogramu 

, který obsahuje více než 3 700 hlavních spekter. 

uživatelem definované nehierarchické sbírky hlavních 

e lze použít při snaze omezit klasifikační vyhledávání
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<projectname>.html 

MSP  

na pomocí dvou 

řiřadit k těm 

názvy jsou 

ce softwaru 

tení a obsahuje 

ického dendrogramu 

ké sbírky hlavních 

ní vyhledávání určité 
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3.5.1  Editor taxonom

Tyto taxonomické dendrogramy jsou vytvá

• Vytvoření taxonomického dendrogramu

• Přidání uzlů do taxonomického dendrogramu

• Přidání hlavních spekter do uzl

Taxonomické dendrogramy jsou vytvá
Biotyper Taxonomy Tree. 

Editor taxonomického dendrogramu má t
těchto náhledů lze měnit tak, že kurzorem po

• Kmenový náhled (Lineage View

taxonomického uzlu tvořícího ko

funkčního dendrogramu (Working Tree View

3  MALDI Biotyper – Offline klasifikace (OC)
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axonomického dendrogramu MALDI Biotyper

ické dendrogramy jsou vytvářeny ve třech krocích (etapách): 

ického dendrogramu. 

ického dendrogramu. 

idání hlavních spekter do uzlů. 

jsou vytvářeny a editovány pomocí editoru

ického dendrogramu má tři části/náhledy (views). Relativ
nit tak, že kurzorem popotáhujeme jejich horizontální okraje

Lineage View): Tento náhled zobrazuje pozici 

řícího kořen momentálně aktivního kmene v náhledu 

Working Tree View). Kliknutím na určitý taxon 
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MALDI Biotyper 

ovány pomocí editoru MALDI 

 

elativní výšky 
potáhujeme jejich horizontální okraje. 

náhledu 

taxon 
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nacházející se kmenovém náhledu se nastartuje funk

vyšším uzlu taxonu. 

• Náhled funkčního kmene (

momnetálně aktivní kmen 

určený pouze ke čtení). Celkový po

taxonomickému uzlu a jeho uzl

• Náhled MSP: Tento náhled obsahuje dv

seznam těch MSP, která jsou dostupná v 

nejsou momentálně přiřazen

jsou pak zobrazena všechna spektra, která jsou p

vybraným v daném funkčním dendrogramu

s příslušným názvem, datem vytvo

použity. 

Aby bylo možno taxonové uzly mezi kmeny navzájem kopírovat, jsou v
taxonomického dendrogramu (
momentálně aktivní (funkční) kmen, tak také na kmen vzdálený 

Je-li editor spuštěn, je kmen 
(Working Tree) a momentálně
(Taxonomy Tree View) je nastaven jako dendrogram

Oba tyto dendrogramy jsou definovány v

3.5.2  Vytváření a užívání t

Vytvoření taxonomického dendrogramu

1. V seznamu Taxonomy Tree View

3  MALDI Biotyper – Offline klasifikace (OC)
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kmenovém náhledu se nastartuje funkční kmen ve zvoleném 

ního kmene (Working Tree View): Tento náhled obsahuje 

 aktivní kmen (výrobcem nastaveno jako 'Taxonomický kmen

Celkový počet MSP přiřazených ke každému 

taxonomickému uzlu a jeho uzlům dceřinným je uveden v závorkách. 

ento náhled obsahuje dvě tabulky. Na levé straně je uveden 

, která jsou dostupná v databázi programu MALDI Biotyper

řazena k žádnému z taxononových uzlů. Na stran

jsou pak zobrazena všechna spektra, která jsou přiřazena k taxonovým uzl

čním dendrogramu. Každě MSP je v seznamu uvedeno 

íslušným názvem, datem vytvoření a počtem píků, jež byly k jeho vytvo

ové uzly mezi kmeny navzájem kopírovat, jsou v
taxonomického dendrogramu (Taxonomy Tree Editor) uvedeny odkazy jak na 

kmen, tak také na kmen vzdálený (uživatelský).

n, je kmen 'Taxonomy' nastaven jako dendrogram pracovní 
momentálně zvolený náhled dendrogramu taxonom
) je nastaven jako dendrogram uživatelský.  

Oba tyto dendrogramy jsou definovány v dialogu Configure Tree. 

 

ení a užívání taxonomických dendrogramů

ického dendrogramu 

Taxonomy Tree View zvolte požadovaný dendrogram. 
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ní kmen ve zvoleném 

Tento náhled obsahuje 

Taxonomický kmen' 

 je uveden 

MALDI Biotyper a 

Na straně pravé 

ovým uzlům 

seznamu uvedeno 

jeho vytvoření 

ové uzly mezi kmeny navzájem kopírovat, jsou v editoru 
uvedeny odkazy jak na 

). 

nastaven jako dendrogram pracovní 
taxonomického 

ických dendrogramů 
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2. Pravým tlačítkem myši klikněte na taxon

Taxonomy Tree Editor aneb

3. Pak klikněte na  hlavní část editoru (

menu vyberte nabídku Configure

4. Klikněte na nabídku Create, vložte název nového dendrogramu do dialogu 

New Customer Tree a klikně

5. Kliknutím na OK editor taxonom

Chcete-li  do taxonomického dendrogramu p
provést pouze v projektovém dendrogramu

1. V seznamu Taxonomy Tree View

2. Klikněte na  taxonový nodus a bu

nebo klikněte na . 

3. Pak klikněte pravým tlačítkem myši na  

menu zvolte nabídku New Node

4. Vložte název nového nodu a 

5. Kliknutím na OK editor taxonom

Poznámka: Nový dceř
automaticky tehdy, je
dendrogramu p

Chcete-li do taxonomického dendrogramu

1. V seznamu Taxonomy Tree View 

obsahuje. 

2. Na  příslušný taxonový nodus

Editor anebo klikněte na 

3. Klikněte na  hlavní část editoru (

menu příkaz Configure. 

4. V dialogu Configure Tree definujte momentáln

(Customer) dendrogram a klikn

5. V hlavní části editoru taxonomického dendrogramu p
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ěte na taxonový nodus a buď zvolte nabídku Start 

anebo klikněte na . 

ást editoru (Taxonomy Tree Editor) a z kontextového 

Configure.  

vložte název nového dendrogramu do dialogu 

klikněte na OK. 

axonomického dendrogramu zavřete. 

do taxonomického dendrogramu přidat další (dceřinný) uzel (toto lze 
ovém dendrogramu) 

Taxonomy Tree View zvolte požadovaný dendrogram. 

us a buď zvolte příkaz Start Taxonomy Tree Editor

ítkem myši na  původní (parent) nodus a v kontextovém 

New Node.  

 stiskněte Enter.  

axonomického dendrogramu zavřete. 

Nový dceřinný nodus je uživatelského dendrogramu p
automaticky tehdy, je-li určité hlavní spektrum v
dendrogramu přiřazeno ke správnému (odpovídajícímu) uzlu

li do taxonomického dendrogramu přidat některý již existující nodus

Taxonomy Tree View vyberte ten dendrogram, který tento uzel 

us klikněte a buď zvolte příkaz Start Taxonomy Tree 

. 

ást editoru (Taxonomy Tree Editor) a vyberte v kontextovém 

definujte momentálně aktivní (Working) a cílový 

klikněte na OK. 

ásti editoru taxonomického dendrogramu přejděte na požadovaný uzel.
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Start 

kontextového 

vložte název nového dendrogramu do dialogu Create 

toto lze 

Start Taxonomy Tree Editor 

kontextovém 

inný nodus je uživatelského dendrogramu přidán 
ité hlavní spektrum v NCBI 

azeno ke správnému (odpovídajícímu) uzlu. 

istující nodus 

vyberte ten dendrogram, který tento uzel 

Start Taxonomy Tree 

kontextovém 

a cílový 

te na požadovaný uzel. 
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6. Klikněte na  něj a v kontextovém menu zvolte nabídku 

7. Kroky 5 a 6 opakujte u každého nodu, který chcete p

dendrogramu. 

Dceřinné uzly je třeba přidávat odd
jedno, zda k němu již MSP bylo p

Za určitých okolností jsou taxon
příkazu Add to Customer Tree
nenacházejícímu se v uživatelském dendrogramu se automaticky p
nodus. 

8. Kliknutím na OK editor taxonom

Přejmenování nodu (toto lze provést pouze v p

1. V seznamu Taxonomy Tree View

2. Pravým tlačítkem myši klikněte na 

Taxonomy Tree Editor aneb

3. Pravým tlačítkem myši klikněte na 

zvolte příkaz Rename Node. 

4. Vložte nový název nodu a stiskn

5. Kliknutím na OK editor taxonom

Chcete-li určitý nodus z taxonom
pouze v projektovém a cílovém dendrogramu

1. V seznamu Taxonomy Tree View

který má být odstraněn. 
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kontextovém menu zvolte nabídku Add to Customer Tree

 

opakujte u každého nodu, který chcete přidat do cíkového (Customer

řidávat odděleně. Při přidávání taxonového nodu je zcela 
bylo přiřazeno. 

taxonové uzly přidávany zcela automaticky, bez použití 
Add to Customer Tree. Přiřazením určitého MSP k taxonovému 

uživatelském dendrogramu se automaticky přidává i tento 

axonomického dendrogramu zavřete. 

toto lze provést pouze v projektovém dendrogramu

Taxonomy Tree View vyberte požadovaný taxonomický dendrogram

ěte na určitý taxonový uzel a buď zvolte nabídku 

anebo klikněte na . 

ěte na požadovaný nodus a v kontextovém menu 

 

Vložte nový název nodu a stiskněte Enter.  

axonomického dendrogramu zavřete. 

taxonomického dendrogramu odstranit (toto lze provést 
a cílovém dendrogramu) 

Taxonomy Tree View vyberte dendrogram, jenž obsahuje nodus, 
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Add to Customer Tree. 

Customer) 

u je zcela 

idávany zcela automaticky, bez použití 
ovému nodu 
řidává i tento 

ovém dendrogramu) 

ický dendrogram. 

 zvolte nabídku Start 

kontextovém menu 

(toto lze provést 

dendrogram, jenž obsahuje nodus, 
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2. Pravým tlačítkem myši klikněte na 

Tree Editor nebo klikněte na 

3. V hlavní části editoru taxonomického dendrogramu p

odestraněn. 

4. Odstraňovaný nodus zcela otev

5. Pravým tlačítkem myši klikněte na 

menu zvolte příkaz Remove. 

6. Krok 5 opakujte až do okamžiku, kdy je požadovaný 

7. Kliknutím na OK editor taxonom

Poznámka: Odstraněním nodu z uživatelského dendrogramu se jeho 
přidružené hlavní spektrum (MSP) v
nevymazává

Poznámka:  Má-li být nodus z
být prázdný

Přidání nepřiřazeného MSP k ur

1. V seznamu Taxonomy Tree View

2. Pravým tlačítkem myši klikněte na 

Tree Editor anebo klikněte na 

3. V hlavní části editoru taxonomického dendrogramu p

Hlavní spektra, jež jsou momentáln
MSPs of '<node name>'. Nep
MSPs. 

4. Nepřiřazené  MSP přesuňte ze seznamu  

'<node name>' tak, že je vyberete a 
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ěte na tento uzel a buď zvolte příkaz Start Taxonomy 

na . 

ásti editoru taxonomického dendrogramu přejděte na nodus, který má být 

ovaný nodus zcela otevřete (expand). 

ěte na subnodus nejnižší úrovně a v kontextovém 

 

opakujte až do okamžiku, kdy je požadovaný nodus odstraněn. 

axonomického dendrogramu zavřete. 

ěním nodu z uživatelského dendrogramu se jeho 
idružené hlavní spektrum (MSP) v NCBI dendrogramu

nevymazává. 

li být nodus z projektového dendrogramu odstraně
být prázdný. 

určitému nodu 

Taxonomy Tree View vyberte požadovaný dendrogram. 

ěte na tento uzel a buď zvolte příkaz Start Taxonomy 

na . 

ásti editoru taxonomického dendrogramu přejděte na požadovaný nodus

Hlavní spektra, jež jsou momentálně v tomto nodu uložena, jsou uvedena 
Nepřiřazená MSP jsou uvedena v tabulce Unassigned 

ňte ze seznamu  Unassigned MSPs do tabulky MSPs of 

k, že je vyberete a kliknete na  . 
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Start Taxonomy 

us, který má být 

kontextovém 

ním nodu z uživatelského dendrogramu se jeho 
NCBI dendrogramu 

projektového dendrogramu odstraněn, musí 

Start Taxonomy 

te na požadovaný nodus. 

tomto nodu uložena, jsou uvedena v tabulce 
Unassigned 

MSPs of 
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5. Kliknutím na OK editor taxonom

Odstranění MSP z nodu 

1. V seznamu Taxonomy Tree View

2. Pravým tlačítkem myši klikněte na 

Tree Editor nebo klikněte na 

3. V hlavní části editoru taxonomického dendrog

4. Požadovaný nodus přesuňte do hlavní 

Ta MSP, která se v daném okamžiku v
MSPs of '<node name>'. 

4. MSP přesuňte z tabulky MSPs of '<node name>'

tak, že je vyberete a klikněte 

5. Kliknutím na OK editor taxonom

3  MALDI Biotyper – Offline klasifikace (OC)
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axonomického dendrogramu zavřete. 

Taxonomy Tree View vyberte požadovaný dendrogram. 

ěte na tento uzel a buď zvolte příkaz Start Taxonomy 

na . 

ásti editoru taxonomického dendrogramu přejděte na požadovaný nodus

ňte do hlavní části editoru. 

daném okamžiku v nodu nacházejí, jsou uvedena v

MSPs of '<node name>' do tabulky Unassigned MSPs

 na . 

axonomického dendrogramu zavřete. 
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Start Taxonomy 

te na požadovaný nodus. 

nodu nacházejí, jsou uvedena v tabulce 

Unassigned MSPs 
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3.5.3  Odstranění taxonom

Nežádoucí taxonomické dendrogramy lze z

{b}Poznámka{/b} Dendrogram
('Taxonomy') odstranit nelze

Taxonomický dendrogram se odstraní následujícím zp

1. Pravým tlačítkem myši klikněte na 

Taxonomy Tree Editor aneb

2. Pravým tlačítkem myši klikněte na 

(Taxonomy Tree Editor) a v 

3. V dialogu Configure Tree defin

(uživatelský) dendrogram a klik

4. Editor taxonomického dendrogramu

3.5.4  Vytváření a používání knihoven 

Knihovny MSP představují pohodlný zp
spekter, např. v případě, že chceme zúžit proces 
skupiny mikroorganismů. Obsah knihoven 
vkládaných do tabulky Selected MSPs

Vytvoření knihovny MSP  

1. Kliknutím pravého tlačítka myši na 

přesuňte jednotlivá hlavní spektra do tabulky vybraných MSP (

buď použijte příkaz Add to MSP Selection

2. V tabulce vybraných MSP zvolte požadovaná hlavní spektra tím, že

pravým tlačítkem myši a pak v

Library. Jinou možnost představuje výb

3. Do dialogu Save MSP Library

MSP.  

Vložením nového názvu MSP je stávající knihovna t
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axonomického dendrogramu 

Nežádoucí taxonomické dendrogramy lze z databáze odstranit. 

Dendrogram projektů ('Projects') a dendrogram 
odstranit nelze. 

ický dendrogram se odstraní následujícím způsobem: 

ěte na nodus taxonu a buď vyberte nabídku Start 

anebo klikněte na  . 

ěte na hlavní část editoru taxonomického dendrogramu 

 kontextovém menu zvolte nabídku Configure

efinujte nežádoucí dendrogram jako destinační 

klikněte na Delete. 

Editor taxonomického dendrogramu zavřete kliknutím na OK . 

ení a používání knihoven MSP  

edstavují pohodlný způsob jak se dostat k určité skupině
, že chceme zúžit proces klasifikačního vyhledávání ur

Obsah knihoven MSP je spravován pomocí údaj
Selected MSPs, která se nachází v Table View. 

myši na název MSP uvedený v tabulce Current MSP 

te jednotlivá hlavní spektra do tabulky vybraných MSP (Selected MSP

Add to MSP Selection anebo klikněte na . 

zvolte požadovaná hlavní spektra tím, že na ně

pak v kontextovém menu zvolíte nabídku Save MSP 

ředstavuje výběr požadovaných MSP a kliknutí na 

Save MSP Library napište název (Name) a opční popis (Description

nového názvu MSP je stávající knihovna těchto spekter přepsána
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endrogram NCBI 

Start 

ást editoru taxonomického dendrogramu 

Configure. 

ční 

ité skupině hlavních 
ního vyhledávání určité 

je spravován pomocí údajů 

Current MSP 

Selected MSP) a 

na ně kliknete 

Save MSP 

nutí na  . 

Description) 

epsána. 
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4. Knihovnu uložíte kliknutím na 

Natažení (nahrání) knihovny MSP 

1. Pravým tlačítkem myši klikněte na  

zvolte příkaz Load MSP Library

2. Požadovanou knihovnu natáhnete bu

a. dDvojím kliknutím na požadovanou knihovnu v

ANEBO 

b. vybráním požadované knihovny a 

Hlavní spektra (MSPs ) obsažená ve vybrané knihovn
tabulky vybraných MSP (Selected MSPs table

3.6  MSP dendrogram

Podobně jako matice CCI  (viz 
jsou si jednotlivé mikroorganismy navzájem podobné/blízké
podobá porovnávání neznýmých spekter s
spekter s knihovnou MSP vytvo
vzájemné podobnosti jednotlivých mikro
předem stanovené podobnosti či nepodobnosti

3.6.1  Vytvoření MSP 

Chcete-li MSP dendrogram vytvo

1. Klikněte pravým tlačítkem myši na 

přesuňte je to tabulky Selected MSP 

Alternativní možností je přesunout všechna aktuální hlavní spektra (pouze 

horizontální transfokaci) klikně

nepřiřazených MSP (Unassigned MSP

Selection nebo kliknutím na  
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uložíte kliknutím na OK. 

MSP  

ěte na  tabulku Selected MSPs a v kontextovém menu 

Load MSP Library. jinou možností je kliknout na . 

Požadovanou knihovnu natáhnete buď: 

utím na požadovanou knihovnu v dialogu Load MSP Library

vybráním požadované knihovny a kliknutím na OK. 

) obsažená ve vybrané knihovně pak jsou vložena do 
Selected MSPs table). 

endrogramy 

(viz část 3.8), ukazují i MSP dendrogramy do jaké míry 
y navzájem podobné/blízké. V rámci procesu, který se 

podobá porovnávání neznýmých spekter s knihovnou MSP je porovnáním hlavních 
knihovnou MSP vytvořen dendrogram. V tomto dendrogramu

vzájemné podobnosti jednotlivých mikroorganismů stanovena na základ
podobnosti či nepodobnosti (arbitrary distance level).   

MSP dendrogramů 

vytvořit 

ítkem myši na název MSP uvedený v tabuloce Current MSP

Selected MSP a zvolte příkaz Add to MSP Selection

řesunout všechna aktuální hlavní spektra (pouze 

liknětím pravého tlačítka myši do uzlu (node) 

Unassigned MSP) a zvolit příkaz Add Hierarchy to MSP 

 . 
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kontextovém menu 

Load MSP Library  

 pak jsou vložena do 

y do jaké míry 
cesu, který se 

je porovnáním hlavních 
u je míra 

stanovena na základě jejich 

Current MSP, 

Add to MSP Selection. 

esunout všechna aktuální hlavní spektra (pouze 

rarchy to MSP 
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Možnost:  Definování identifi
možné buď pomocí p

a. Action > Identification > Edit 

b. Edit > Method > MSP Identification

Možnost: Metodu vytvoření 

a. Action > MSP Dendrogram > Edit 

b. Edit > Method > MSP Dendrogram Creation 

Možnost:  Zvolte příkazy Tools > Options >
vložte nastavení  

2. Požadovaná MSP zvýrazněte

K vytvoření dendrogramu je zapot

3.  Zvolte příkazy Action > MSP Dendrogram > View

kliknutí pravým tlačítkem myši na  

MSP Dendrogram v kontextovém

View. 

3.6.2  Zobrazení  MSP 

MSP dendrogram je zobrazen v 
jsou distance normalizovány na 
distance jsou relativní a nelze je př

V níže uvedeném příkladu je ukázáno, jak byl p
k vytvoření Listeria CCI matrix (viz 
klastry, které byly pomocí analýzy 
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identifikační metody MSP použité během klasifikac
 pomocí příkazů: 

Action > Identification > Edit Method anebo příkazů 

> MSP Identification. 

ření MSP dendrogramu lze zvolit buď pomocí příkaz

Action > MSP Dendrogram > Edit Method anebo příkazů 

> MSP Dendrogram Creation . 

Tools > Options > General Settings > Dendrogram
 požadovaného dendrogramu. 

ěte. 

ení dendrogramu je zapotřebí nejméně tří MSP. 

Action > MSP Dendrogram > View. Jinou možnost představuje

ítkem myši na  zvýrazněná hlavní spektra a volba příkazu 

ovém menu či kliknutí na  v panelu nástroj

MSP dendrogramů 

 okně s názvem Dendrogram. V daném dendrogram
ovány na maximální hodnotu 1000, což znamená, že tyto 

ní a nelze je při srovnávání dendrogramů použít. 

íkladu je ukázáno, jak byl příslušný MSP Dendrogram 
(viz část 3.8.4). V dendrogramu jsou viditelné

klastry, které byly pomocí analýzy CCI matrix identifikovány. 
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klasifikace je 

 pomocí příkazů: 

General Settings > Dendrogram a 

ředstavuje 

říkazu View 

panelu nástrojů Table 

dendrogramu 
což znamená, že tyto 

MSP Dendrogram použit 
dendrogramu jsou viditelné i dva 
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Detailnější vztahy lze zkoumat na základ
v jednom klastru a vytvoření nového 

Transfokace a sledování dendrogram

Chcete-li aktuální dendrogram mě
příkazy Zoom nebo Pan. 

Transfokaci dendrogramu lze provést vybráním p
kurzoru myši na požadované polí
Posuňte kurzor na požadovaný výchozí bod, klikn
k požadovanému cílovému bodu. Ve zvolené oblasti stisk tla
požadovanoju transfokaci proveď

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 

 

jší vztahy lze zkoumat na základě výběru hlavních spekter nacházejících se 
ení nového dendrogramu. 

 

endrogramů 

měnit nebo s ním manipulovat, vyberte v menu 

u lze provést vybráním příkazů View > Zoom a posunutím 
é políčko (plot). Tím se zobrazípod kurzorem  

požadovaný výchozí bod, klikněte a táhněte kurzrem sm
požadovanému cílovému bodu. Ve zvolené oblasti stisk tlačítka uvoln

proveďte.  
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ru hlavních spekter nacházejících se 

menu  View 

posunutím 
ím se zobrazípod kurzorem  zoom . 

te kurzrem směrem 
ítka uvolněte a 

Propojený  
obrázek nelze  
zobrazit.  
Příslušný  
soubor byl  
pravděpodob
ně přesunut…



Bruker Daltonik GmbH 3  MALDI Biotyper – Offline klasifikace (OC) 
 

MALDI Biotyper 3.0 User Manual Revision 2 Strana 135 
 

Transfokační kroky jsou skládány na sebe samostatně pro každé políčko, což 
umožňuje postupné zvětšování náhledu pomocí příkazu Zoom Out uvedeného 
v kontextovém menu.  

Dvojím kliknutím levého tlačítka myši a nebo výběrem příkazu Reset to Original View 
v kontextovém menu původní náhled obnovíte.  

V době, kdy je příkaz Zoom aktivní, klikněte pravým tlačítkem myši se v dendrogramu 
otevře kontextové menu, které obsahuje následující příkazy: 

Příkaz Funkce 

Zoom Out  
(Zvětšit) 

Postupné zvětšování. 

Reset to Original View  
(Resetovat  původní náhled) 

Obnoví původní náhled. 

Zoom Options > 
(Možnosti transfokace >)    

Unconstrained Zoom  
(Disproporční transfokace)   

Umožní disproporční transfokaci. 

Horizontal Zoom  
(Horizontální transfokace) 

Umožní pouze horizontální transfokaci. 

Vertical Zoom 
(Vertikální transfokace) 

Umožní pouze vertikální transfokaci.  

 

Chcete-li určitý dendrogram sledovat, zvollte příkaz View > Pan a kurzor myši 
přesuňte na požadovaný dendrogram. Po tomto kroku se objeví sledovací kurzor (pan 
cursor) . Po kliknutí lze příslušný diagram přesunovat (táhnout) v požadovaném 
směru. 

Původní náhled lze obnovit buď dvojím stikem levého tlačítka myši anebo zvolením 
příkazu Reset to Original View, který se nachází v kontextovém menu.  

3.7  Klastrování spekter pomocí analýzy hlavních 
komponent (PCA) 

Program MALDI Biotyper umožňuje analýzu hlavních komponent (Principal 
Component Analysis) jednotlivých souborů spekter. Tato statistická analýza 
poskytuje informaci o heterogenitě či homogenitě určitého souboru dat. Program PCA 
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je řízen externím softwarovým nástrojem MATLAB, který je do programu MALDI 
Biotyper integrován. 

3.7.1  PCA hmotnostních spekter 

Cílem PCA je redukovat rozměrnost toho souboru dat, v němž existuje velký počet 
vzájemně propojených a na sobě závislých proměnných, které si zachovávají svoji 
různorodost.  

V rámci MALDI Biotyper analýzy, se soubor dat skládá z hmotnostních spekter 
získaných od různých druhů mikroorganismů. V hmotnostních spektrech představují 
intenzity jednotlivých m/z poměrů odpovídající proměnné. Program PCA vypočte nový 
systém koordinát, který může být vyjádřen jako lineární kombinace původních 
proměnných (mass-to-charge ratios m/z). Tímto způsobem lze hlavní trendy dat 
identifikovat. 

Analýza PCA je založena na dekompozici kovariance vlastních hodnot/vlastních 
vektorů  anebo korelačních matic původních proměnných. Příslušná data lze 
adekvátně popsat pomocí mnohem menšího počtu vzdálených koordinát (hlavních 
komponent) než při použití původních proměnných. 

PCA je používána hlavně jako jako metoda redukce dat a jako nástroj vizualizace. 
Vynesení dat do systému souřadnic, který je založen na principiálních komponentách, 
často objasňuje ty vztahy a klastry, které by při použití souřadnic původních nebyly 
zřejmé. 

3.7.2  Klastrování pomocí PCA  

Klastrování pomocí MALDI Biotyper PCA  se skládá ze tří různých kroků, z nichž 
každý představuje samostanou metodou zpracování: 

• Předběžné zpracování dat 

• Tvorba PCA  

• PCA klastrování 

Výsledky PCA klastrování lze zobrazit dvěma různými způsoby: 

• Vynesením a uložením hodnot skóre (Scores and loading plots) (viz část 

3.7.3.1) 

• Klastrováním dendrogramů (viz část 3.7.3.2) 
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V závislosti na požadovaném náhledu musí být příslušná metoda PCA klastrování 
(PCA Clustering Method) definována v následujících dvou krocích. 

Vlastní PCA klastrování 

1. V okně Náhled souboru (File View) natáhněte a zvýrazněte ta hrubá spektra, která 

mají být k PCA použita (viz část 3.2.1). Pro PCA klastrování anebo pro tvorbu 

dendrogramu je zapotřebí použít nejméně tří spektra. 

Možnost: Metodu předběžného zpracování definujte buď příkazy: 

a. Action > Preprocessing > Edit Method anebo příkazy  

b. Edit > Method > Preprocessing.  

Doporučenou metodou předběžného zpracování je metoda BioTyper 
Preprocessing Standard Method PCA. 

Možnost: Metodu tvorby PCA definujte buď příkazy: 

a. Action > PCA > Edit Creation Method anebo příkazy  

b. Edit > Method > PCA Creation.  

Doporučenou metodou tvorby PCA je BioTyper PCA Creation Standard Method. 

2. Metodu PCA klastrování vyberte následujícím způsobem.   

a. Zobrazení výsledků pomocí skóre a vynesených  dat (loading plots) — 

PCA klastrování definujte buď pomocí příkazů Action > PCA > Edit 

Clustering Method anebo příkazů Edit > Method > PCA Clustering. 

Doporučenou metodou PCA klastrování pro generování skóre a vynesení dat 

je BioTyper PCA Clustering Standard Method. 

b. Zobrazení výsledků ve forme klastrovacího dendrogramu — PCA 

klastrování definujte buď pomocí příkazů Action > PCA > Edit Clustering 

Method anebo příkazů Edit > Method > PCA Clustering. Doporučenou 

metodou PCA klastrování pro generování klastrovacích dendrogramů je 

BioTyper PCA Clustering Standard Method. 

3. PCA klastrování začněte takto:. 
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a. Chcete-li výsledky zobrazit jako skóre a vynesené hodnoty,

Action > PCA > View Clustering

b. Chcete-li výsledky zobrazit jako klastrovací dendrogram,

Action > PCA > View Dendrogram

Stavová lišta v dolní části okna programu 
Batch Processing, která indikuje, že klastrování pomocí PCA probíhá
se otevře po několika sekundách

3.7.3  Zobrazení výsledk

3.7.3.1  Skóre a grafy vynesených hodnot (

Hlavní okno PCA obsahuje osm r
2D) grafů; čtyři grafy zobrazující s
osmi grafů může být prohlížen samostatn
grafů okna PCA. 

Ve výrobním nastavení se skóre
komponentám, které jsou označ
obvykle postačují k vyjádření (popisu) p
souboru. Celkový počet hlavních komponent je závislý na použité metod
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li výsledky zobrazit jako skóre a vynesené hodnoty, zvolte příkazy 

> View Clustering. 

li výsledky zobrazit jako klastrovací dendrogram, použitje příkazy 

Action > PCA > View Dendrogram. 

ásti okna programu MALDI Biotyper zobrazuje informaci 
která indikuje, že klastrování pomocí PCA probíhá. PCA okno 

kolika sekundách. 

Zobrazení výsledků klastrování pomocí PCA  

grafy vynesených hodnot (Loadings Plots) 

obsahuje osm různých trojrozměrných a dvourozměrných (
i grafy zobrazující skóre a čtyři grafy zobrazující data. Každý z
že být prohlížen samostatně po zvolení relevantní nabídky v menu 

 

skóre a vložená data vztahují k prvním třem hlavním 
které jsou označeny jako PC1, PC2 a PC3. Tyto hlavní komponenty 

ení (popisu) převážné části variance určitého datového 
et hlavních komponent je závislý na použité metodě PCA

Offline klasifikace (OC) 

Strana 138 

říkazy 

říkazy 

zobrazuje informaci 
PCA okno 

rných (3D and 
Každý z těchto 

 po zvolení relevantní nabídky v menu 

řem hlavním 
yto hlavní komponenty 

itého datového 
ě PCA. 
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Horní část okna PCA obsahuje č
s vynesením hodnot PC1 vs. PC2 vs: PC3 a
jednotlivý bod těchto grafů představuje jedno 
automaticky přiřazovány ke klastrů

Dolní část okna PCA obsahuje 
s vynesením hodnot Load1 vs. Load2 vs: Load3 a
Každý jednotlivý bod těchto graf
analyzovaných spekter a indikuje do jaké míry se hlavní komponenty
k původním píkům. Čím je vzdálenost píku od za
podíl na varianci datového souboru

Jednotlivé grafy mohou být v
odpovídajícího příkazu v menu graf

Volbou příkazů View > Mark Data Points
Kliknutím levého tlačítka myši na p
označení buď číslem spektra 
hodnot – loading points). Opakovaným kliknutím se toto ozna

Ty hlavní kompolnenty, které byly proti sob
PCA měnit pomocí tlačítek PC > PCs
políček PC a klikněte na OK.  

 

Změnou vynesených hlavních komponent se aktualizují všechny grafy zobrazené 
v hlavním okně. Grafy v ostatních samostatných oknech z

Chcete-li obsah okna kopírovat do schránky
Edit > Copy. 
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obsahuje čtyři grafy skóre; jeden trojrozměrný graf (
PC1 vs. PC2 vs: PC3 a tři grafy dvourozměrné (2D plots

ředstavuje jedno spektrum. Tyto body (spektra) 
azovány ke klastrům, jejichž data (members) mají společnou barvu

obsahuje čtyři grafy dat; jeden trojrozměrný graf (
Load1 vs. Load2 vs: Load3 a tři grafy dvourozměrné (

chto grafů představuje jeden pík ze seznamu pík
ikuje do jaké míry se hlavní komponenty

ím je vzdálenost píku od začátku větší, tím větší je také jeho 
souboru. 

Jednotlivé grafy mohou být v samostatných oknech zobrazeny pomocí volby 
menu grafů (Plots menu). 

View > Mark Data Points se aktivuje značení vynášených dat
ítka myši na příslušný údaj dojde k jeho zakroužkování a 

 (grafy skóre) nebo hodnotou m/z 
Opakovaným kliknutím se toto označení odstraní. 

Ty hlavní kompolnenty, které byly proti sobě navzájem vyneseny, lze v hlavním okn
PC > PCs. Požadované hlavní komponenty  vložte do 

nou vynesených hlavních komponent se aktualizují všechny grafy zobrazené 
ostatních samostatných oknech zůstávají nezměněny

li obsah okna kopírovat do schránky pro použití v jiné aplikaci, použij

Pro
poj
ený 
obr
áze
k 
n…

Propojený obrázek nelze zobrazit. Příslušný soubor byl pravděpodobně  
přesunut, přejmenován nebo odstraněn. Ověřte, zda propojení odkazuje  
na správný soubor a umístění.
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rný graf (3D plot) 
2D plots). Každý 

(spektra) jsou 
nou barvu. 

rný graf (3D plot) 
(2D plots). 

edstavuje jeden pík ze seznamu píků 
ikuje do jaké míry se hlavní komponenty vztahují 

tší je také jeho 

samostatných oknech zobrazeny pomocí volby 

ení vynášených dat. 
jeho zakroužkování a 

 (grafy 

hlavním okně 
Požadované hlavní komponenty  vložte do 

nou vynesených hlavních komponent se aktualizují všechny grafy zobrazené 
ěny. 

jiné aplikaci, použijte příkazy 

Propojený obrázek nelze zobrazit. Příslušný soubor byl pravděpodobně  
přesunut, přejmenován nebo odstraněn. Ověřte, zda propojení odkazuje  
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Transfokace, sledování a otáčení objektu  

Se zobrazeným objektem lze v aktuálním náhledu manipulovat pomocí příkazů Zoom, 
Pan nebo Rotate, které jsou obsaženy v menu náhledu (View). 

Při transfokaci ve dvourozměrném grafu zvolte příkazy View > Zoom a kurzor myši 
přesuňte na požadovaný graf. Tím dojde k transfokaci . Kurzor umístěte na 
požadovaný výchozí bod, klikněte a přetáhněte ho na požadovanou cílovou poozici. 
Po uvolnění tlačítka myši se zvolená oblast zmenší.  

Pro každé z vybraných míst lze transfokační kroky klást postupně na sebe (stacked) 
pomocí příkazu Zoom Out,  který se nachází v kontextovém menu.  

Velikost původního náhledu obnovíte buď dvojím kliknutím levého tlačítka myši anebo 
vybráním příkazu Reset to Original View v kontextovém menu.  

Jakmile je příkaz Zoom aktivní, lze kliknout na dvourozměrný graf pravým tlačítkem 
myši; tím se zobrazí kontextové menu, které obsahuje následující příkazy: 

 

Příkaz Funkce 

Zoom Out 
(Zvětšení) 

Postupné zvětšování. 

Reset to Original View  
(Resetuj původní náhled) 

Obnovéní původního náhledu. 

Zoom Options > 
(Možnosti transfokace >) 

  

Unconstrained Zoom  
(Disproporční transfokace)  

Umožní disproporční transfokaci. 

Horizontal Zoom  
(Horizontální transfokace) 

Umožní pouze horizontální transfokaci. 

Vertical Zoom 
(Vertikální transfokace) 

Umožní pouze vertikální transfokaci.  

 

Panning technika umožňuje přetahovat všechna data obsažená ve dvourozměrném 
grafu jakýmkoli směrem, což umožňuje čtení dlouhých popisů, jež jsou  k datovým 
bodům připojeny.  

Propojený  
obrázek nelze  
zobrazit.  
Příslušný  
soubor byl  
pravděpodob
ně přesunut…
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Chcete-li s dvourozměrným grafem manipulovat, zvolte příkazy View > Pan a 
přesuňte kurzor myši do požadovaného grafu. Tím se zobrazí manipulační kurzor (pan 
cursor) . Po kliknutí lze datové body přesunovat v požadovaném směru. 

Dvojím kliknutím na levé tlačítko myši anebo výběrem příkazu Reset to Original View 
v kontextovém menu lze původní zobrazení obnovit.  

Příkaz Rotate umožňuje manipulaci s trojrozměrnými grafy (tj. jejich otáčení). Chcete-
li trojrozměrným grafem otáčet, zvolte příkazy View > Rotate a přemístěte kurzor myši 
do požadovaného grafu. Tím se zobrazí rotační kurzor . Po kliknutí lze grafem 
otáčet v požadovaném směru.  

Dvojím kliknutím na levé tlačítko myši anebo výběrem příkazu Reset to Original View 
v kontextovém menu lze původní zobrazení obnovit.   

3.7.3.2  PCA Dendrogramy 

Klastrování dendrogramů vyjadřuje vzájemnou příbuznost jednotlivých spekter 
(uvedených na ose x). Podobně jako u grafů hodnot skóre, jsou i v tomto případě 
spektra automaticky přiřazována k jednotlivým klastrům, jejichž příslušníci (members) 
mají stejnou barvu. 

PCA dendrogramy lze zobrazit pomocí příkazů, které jsou stejné jako při zobrazování 
dendrogramů hlavních spekter (viz část 3.6.2). 

Původní náhled lze obnovit buď dvojím kliknutím levého tlačítka myši nebo volbou 
příkazu Reset to Original View v kontextovém menu.  

Propojený  
obrázek nelze  
zobrazit.  
Příslušný  
soubor byl  
pravděpodob
ně přesunut…

Propojen
ý 
obrázek 
nelze 
zobrazit.  
Přísluš
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3.8  CCI analýza 

Ke statistické analýze vztahů mezi jednotlivými spektry lze použít matici k
korelačního indexu (CCI matrix). 

3.8.1   Vytvoření CCI Matrix

Hodnoty CCI se vypočítají na základ
intervalů a jejich porovnání napříč
skýtá CCI, jenž se používá jako parameter
spektry. Hodnota CCI shody rovná 
znamená absenci korelace. 

Zvýšením počtu intervalů použitých l výpo
této analýzy. CCI analýzy programu 
vztahů mezi spektry získanými od úzce p
také použít k identifikaci neznámých vzork
s údaji uvedenými v knihovně známých spekter
indikuje silnou korelaci (příbuznost) s
identifikaci. 

3  MALDI Biotyper – Offline klasifikace (OC)
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ů mezi jednotlivými spektry lze použít matici kompo
.  

CCI Matrix 

ítají na základě rozdělení spekter do jednotlivých nespopjitých 
jejich porovnání napříč souborem dat. Složení korelací všech interval

parameter, který definuje vzdálenost mezi jednotlivými 
shody rovná 1 vyjadřuje úplnou korelaci, hodnota rovná 

 použitých l výpočtu CCI se zvyšuje i rozlišovací schopnost
ýzy programu MALDI Biotyper se používají hlavně ke studiu 

y získanými od úzce příbuzných mikroorganismů. CCI anal
ikaci neznámých vzorků na základě porovnání jejich 

ě známých spekter. Vysoká hodnota CCI shody 
íbuznost) s referenčním druhem a velmi pravděpodobnou 
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ompozitního 

lení spekter do jednotlivých nespopjitých 
Složení korelací všech intervalů pak 

uje vzdálenost mezi jednotlivými 
hodnota rovná 0 

se zvyšuje i rozlišovací schopnost 
ě ke studiu 

. CCI analýzu lze 
 porovnání jejich spekter 

shody (>0.9) 
ěpodobnou 
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Chcete-li vytvořit Composite Correlation Index (CCI) matrix 

1. V náhledu souboru (File View) vyberte ta hrubá spektra, která mají být použita (viz 

část 3.2.1). 

Možnost:  Metodu předběžného zpracování lze definovat buď pomocí příkazů: 

a.  Action > Preprocessing > Edit Method anebo příkazů  

b. Edit > Method > Preprocessing.  

Doporučenou metodou je metoda BioTyper Preprocessing Standard Method 
CCI. 

Možnost:  Metodu stanovení kompozitního korelačního indexu lze definovat buď 
pomocí příkazů: 

a. Action > Composite Correlation Index > Edit Method anebo příkazů 

b. Edit > Method > Composite Correlation Index.  

Doporučenou metodou výpočtu CCI je BioTyper Composite Correlation 
Standard Method. 

2. Zvolte příkazy Action > Composite Correlation Index > Create. 

Tím se otevře dialog Create Composite Correlation Index Matrix. Je-li třeba, lze 
hlavní znaky (leading characters) z názvu souboru odstranit tak, že se na příslušné 
políčko klikne a nežádoucí znaky se odstraní. 
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3. Zkontrolujte návrh CCI grupování a 

Tím se otevře dialog New CCI Matrix Name
k přepsání CCI stávajícího. 
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ování a klikněte na OK. 

New CCI Matrix Name. Vložením názvu nového CCI 
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CCI dojde 
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4. Výpočet zahájíte kliknutím na 

Po několika sekundách se okno korela
otevře. 

3.8.2  Zobrazení výsledk

Okno korelační matrix zachycuje m
v místě průniku dvou různých skupin indikuje míru jejich vzájemné p
červená = horký vztah = těsná p
příbuznost). Níže uvedený př
vygenerované u skupin 1 a 2 (Groups 1 and 2

Zobrazení stávající CCI matrix 

1. Zvolte příkazy Action > Composite Correlation Index > View

Tím se otevře dialog Composite Correlation Matrix
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íte kliknutím na CCI matrix a na OK . 

kolika sekundách se okno korelační matrix (Correlation Matrix 

Zobrazení výsledků CCI  

ní matrix zachycuje mřížku „horké mapy“ ('heat-map' grid). Barv
zných skupin indikuje míru jejich vzájemné příbuznosti 

sná příbuznost; modrá = studený vztah = ne př
Níže uvedený příklad zachycuje dva zřetelně odlišné klastry 

Groups 1 and 2) a u skupin 3 a 11 (Groups 3 and 

 

 

Action > Composite Correlation Index > View. 

Composite Correlation Matrix. 
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Correlation Matrix window) 

Barva políček 
íbuznosti (tmavě 

e příliš těsná 
 odlišné klastry 

and 11). 
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2. Požadovanou CCI otevřete buď

a. dvojím kliknutím na zvolenoui 

Matrix 

ANEBO 

b. výběrem požadované CCI matrix a

Poznámka: V jednom okamžiku m
Další CCI matrix lze zobrazit až po zav
okna korelační matrix (

3.8.3  Provedení CCI klasifikace

CCI matice lze použít při provádě
zpracování jsou spektra z neznámých vzork
metody CCI (Composite Correlation Index
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ete buď: 

utím na zvolenoui CC matrix v dialogu Composite Correlation 

CCI matrix a kliknutím na OK. 

jednom okamžiku může být zobrazena pouze jedna CCI
Další CCI matrix lze zobrazit až po zavření momentálně otev

ční matrix (Correlation Matrix). 

klasifikace  

i provádění klasifikace neznámého vzorku. Po předb
z neznámých vzorků porovnávána s CCI matrix 

Composite Correlation Index Method). 
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Composite Correlation 

CCI matrix. 
otevřeného 

ředběžném 
matrix pomocí 
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Provedení klasifikace pomocí CCI matrix 

1. Z náhledu souboru (File View) stáhněte a vyberte ta hrubá spektra, jež jsou  ke 

klasifikaci učena (viz část 3.2.1). 

Možnost:  Metodu předběžného zpracování definujte následujícím způsobem. 
Buď zvolte příkazy: 

a. Action > Preprocessing > Edit Method anebo příkazy 

b. Edit > Method > Preprocessing.  

Doporučenou metodou předběžného zpracování vzorku je metoda BioTyper 
Preprocessing Standard Method CCI. 

Možnost:  Metodu stanovení CCI definujte následujícím způsobem. Buď 
zvolte  příkazy: 

a. Action > Composite Correlation Index > Edit Method anebo příkazy   

b. Edit > Method > Composite Correlation Index.  

Doporučenou metodou stanovení CCI je BioTyper Composite Correlation 
Standard Method. 

2. Zvolte  příkazy Action > Composite Correlation Index > Match. 

3. Požadovanou CCI matrix otevřete buď: 

a. dvojím kliknutím na požadovanou CCI matrix v dialogu Composite 

Correlation Index Matrix to be Viewed  

ANEBO 

b. vybráním požadované CCI matrix a kliknutím na OK. 

Na stavové liště zobrazené v dolní části okna programu MALDI Biotyper je zachycen 
prúběh procesu porovnávání (Composite Correlation Index matching running), 
který indikuje, že klasifikace právě probíhá. Výsledky klasifikace a srovnávané 
hodnoty jsou zobrazeny v tabulce CCI Scores, která je zobrazena v náhledu tabulky 
(Table View). 
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3.8.4  Zobrazení výsledk

V tabulce CCI skóre jsou zobrazeny všechny 
tyto skupiny jsou uspořádány v
spektrem neznámého vzorku. Kódování v
indikuje (zelená = dobrá shoda, č

 V níže uvedeném příkladu byl „neznámý“ vzorek získaný z
monocytogenes klasifikován pomocí matrix 

3.9  Uzavření programu MALDI Biotyper OC

Program MALDI Biotyper OC uzav

1. Buď zvolte  příkazy File > Exit 

3.10  Rychlé odkazy do menu programu 
Biotyper 3.0 Menus a zkrácené p

Příkaz Funkce

                                                           
5 Skórovací prahové hodnoty barevného kódování lze uživatelsky nastavit pomocí p

Options > General Settings > Result Display > MSP Identification > Result 

Thresholds. 
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Zobrazení výsledků CCI klasifikace 

jsou zobrazeny všechny skupiny, které se v CCI matrix nacházejí; 
ádány v pořadí, které je založeno na míře jejich shody se 

Kódování v barvách dopravních signálů tuto míru shody
dobrá shoda, červená = špatná shoda)5. 

íkladu byl „neznámý“ vzorek získaný z bakterií druhu 
kován pomocí matrix Listeria CCI. 

ení programu MALDI Biotyper OC 

Program MALDI Biotyper OC uzavřete takto: 

File > Exit a klikněte na   anebo stiskněte Alt+F4. 

Rychlé odkazy do menu programu  MALDI 
Biotyper 3.0 Menus a zkrácené příkazy 

Funkce Tlačítko 

ací prahové hodnoty barevného kódování lze uživatelsky nastavit pomocí příkazů Tools > 

Options > General Settings > Result Display > MSP Identification > Result 
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nacházejí; 
e jejich shody se 

 tuto míru shody 

bakterií druhu Listeria 

 

 

čítko Zkratka 

Tools > 

Options > General Settings > Result Display > MSP Identification > Result 
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File > 
(Soubor >)    

Add Spektra 
(Přidat spektra) 

Spustí prohlíže
Browser

Close All Spektra 
(Zavřít všechna spektra) 

Zav
(File View

Open Realtime 
Classification Project 
(Otevřít projekt klasifikace 
v reálném čase) 

Otev
umož
Biotyper

Exit Zav
Edit >   

Method > [Method type] 
(Metoda > [typ metody] 

Otev
Method
tabulky [typ metody] 

Action > Preprocessing > 
(Akce > Předpříprava / 
přeběžné zpracování) 

  

Edit Method 
(Editovat metodu) 

Zobrazí, edituje a vybere m
předb

Adjust Mass 
(Upravit hmotnost) 

Upraví
spektra

Smooth 
(Vyhladit) Vyhladí

Subtract Baseline 
(Odečíst základnu) 

U zvoleného spektra provede ode
základní 

Normalize  
(Normalizovat)  Normalizuje zvolené

Pick Peaks 
(Vybrat píky) Ze zvoleného spektra vybere píky.

Batch Processing 
(Skupinové zpracování)  

V zvoleného spe
postupn
zpracování.

Action > Identification > 
(Akce > Identifikace >) 

  

Edit Method 
(Editovat metodu) 

Zobrazí, edituje a vybere metodu 
identfikace MSP.
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Spustí prohlížeč spekter (Spectrum 
Browser) umožňující jejich uložení  

Zavře a odstraní  z náhledu souborů 
File View) všechna spektra.  

Otevře dialog Load Project 
umožňující natažení projektů MALDI 
Biotyper RTC. 

 

Zavře program MALDI Biotyper.  
  

Otevře editor MALDI Biotyper 
Method Editor, který zobrazuje 
tabulky [typ metody]  

  

  

Zobrazí, edituje a vybere metodu 
předběžného zpracování.   

Upraví hmotnostní rozmezí vybraného 
spektra.   

yhladí  zvolené spektrum.   

U zvoleného spektra provede odečet 
základní čáry.   

Normalizuje zvolené spektrum.     

Ze zvoleného spektra vybere píky.   

V zvoleného spektra provede 
postupně všechny kroky předběžného 
zpracování. 

  

  

Zobrazí, edituje a vybere metodu 
identfikace MSP.   
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 Ctrl+O 

   

 Ctrl+P 

 Alt+F4 
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Start Zahájí klasifikaci vybraného   
spektra.     

Action > MSP Creation >       
Edit Method 
(Editovat metodu) 

Zobrazí, edituje a vybere metodu 
tvorby MSP.     

Edit Subtyping Method 
(Editovat metodu 
subtypizace) 

Zobrazí, edituje a vybere metodu 
tvorby subtypizace MSP.     

Create 
(Vytvořit) Ze zvolených spekter vytvoří MSP.     

Create Series 
(Vytvořit sérii) 

Ze zvolených spekter vytvoří sérii 
MSP.     

Action > MSP Dendrogram 
> 
(Akce > Dendrogram MSP) 

      

Edit Method 
(Editovat metodu) 

Zobrazí, edituje a vybere metodu 
tvorby dendrogramu MSP.     

View 
(Zobrazit) Vytvoří a zobrazí dendrogram MSP.     

Action > PCA > 
(Akce > PCA >)       

Edit  Creation Method 
(Editovat metodu tvorby) 

Zobrazí, edituje a vybere metodu 
tvorby PCA.     

Edit Clustering Method 
(Editovat metodu 
klastrování) 

Zobrazí, edituje a vybere metodu 
klastrování PCA.     

View Clustering  
(Zobrazit klastrování) 

Pro vybraná spektra zobrazí výsledky 
klastrování PCA.     

View Dendrogram  
(Zobrazit dendrogram) 

Pro vybraná spektra zobrazí 
dendrogram PCA.     

Action > Composite 
Correlation Index > 
(Akce > CCI) 

      

Edit Method  
(Editovat metodu) 

Zobrazí, edituje a vybere metodu 
výpočtu CCI (Composite Correlation 
Index). 

    

Create  
(Vytvořit) 

Z vybraných hrubých spekter vytvoří  
CCI matrix.     

View  
(Zobrazit) Zobrazí již existující CCI matrix.     
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Match  
(Porovnat) 

Porovná neznámé spektrum s CCI 
matrix.     

Export 
(Exportovat) Exportuje již existující CCI matrix.     

Tools > 
(Nástroje >)       

Server Settings 
(Nastavení serveru) Definuje nastavení serveru.     

Options 
(Možnosti) Definuje obecná nastavení.     

Clear Spektrum Cache 
(Vyčistit vyrovnávací 
paměť spektra) 

U serveru vyčistí vyrovnávací paměť 
spekter.     

Help > 
(Nápověda >)       

Help Topics 
(Témata nápovědy) 

Spustí nápovědu programu MALDI 
Biotyper. F1   

O programu MALDI 
Biotyper 

Zobrazí informace o autorských 
právech a licencování.     

3.11  Řešení problémů 

Problém Příčina Doporučený postup 

MALDI Biotyper nelze 
spusit, namísto toho se 
objeví hláška : “Could not 
create model ...”  

Soubor s osobními 
nastaveními 
uživatele je 
poškozen. 

Smažte soubor s nastaveními: 
C:\Documents and 

Settings\<username>\ 

Application Data\Bruker 

Daltonik\BioTyper\ 

GeneralSettings.xml  

MALDI Biotyper se 
spustí s prázným 
taxonomickým 
dendrogramem. 

Není nainstalován 
místní server 
MALDI Biotyper. 

Nastavte vzdálený server MALDI 
Biotyper Options > Server. 

Není spuštěn 
místní server 
MALDI Biotyper. 

Zkontrolujte/Spusťte službu Bruker 
MBT Service v menu Windows 
Service. 

Objeví se „pop-up“okno s 
chybovou hláškou 
obsahující termíny    

Jedná se o 
serverovou 
výjimku. Server 

Zkontrolujte zda editor Method Editor 
obsahuje prázdné pole pro zvolení typu  
metody. Pokud ano zvolte 
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Problém Příčina Doporučený postup 

“SOAP fault” nebo 
“SoapException”. 

má potíže se 
špatně zadanou 
vstupní hodnotou 
(a výjimka nebyla 
převedena na 
chybu klienta).  

požadovanou metodu a zmáčkněte 
OK. 

Příkaz  Start 
Identification vytvoří 
prázdnou tabulku MSP 
Skóres. 

Srovnávání MSP 
bylo spuštěno s 
prázdnými 
vstupními daty. 

Zvolte jedno nebo více spektrum/MSP 
ze vstupní sestavy  a znovu spusťte 
srovnávání.  

Počet MSP zobrazených 
v závorce za uzlem 
taxonu je chybný. 

Obvykle se jedná 
o problém 
způsobený 
opakovaným 
(novým) načtením. 

Zavřete příslušný parent node a znovu 
jej otevřete (k opakovanému načtení 
správných hodnot). Nepřiřazené uzly 
MSPs načtete znovu přepnutím mezi 
stromy (např. Project a Bruker 
Taxonomie). 
 

Příkaz  Search MSP je 
spuštěn v taxonomickém 
dendrogramu (ne v 
editoru Taxonomy Tree 
Editor) a nezobrazují se 
žádné výsledky. 

Použitý název 
struktury 
neodpovídá. 

Zkraťte vyhledávací řetězec a použíjte 
hvězdičku (*) jako zástupnou hodnotu 
na konci řetězce (např. Bacil*). 

K vyhledávání byl 
použit prázný 
strom klienta. 

Spusťte editor Taxonomy Tree Editor, 
nastavte jako strom klienta 'Bruker 
Taxonomy' a stiskněte OK. 
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Příloha  A — Příprava matrix a MALDI 

Spotřební materiály 

Mnohé plasty nejsou pro analýzu hmotnostní spektrometrií vhodné, a to p
proto, že se z nich uvolňují polymer
trubic.  

Používání nevhodných plastových materiál
a polymerové signály, které mohou klasifikaci mikrobiálních druh
MALDI Biotyper ovlivnit nebo dokonce znemožnit

Rozpouštědla a chemikálie 

Všechna Rozpouštědla a chemikálie, jež jsou pro zpracování vzork
Biotyper použita, musejí být chemicky vysoce 
grade). 

MALDI terčíky 

Při analýze vzorků přístrojem MALDI Biotyper 

o MSP 96 terčík  z leštěné oceli

o MSP BigAnchorChip™ 24 (

o MSP BigAnchorChip™ 96 (

• Terčíky vhodné pouze pro autoflexní p

o MTP 384 terčík z leštěné oceli

o MTP BigAnchorChip™ 384 T F (

POZOR

 

MALDI terčíky, reagen
materiály používané p
do styku s mikroorganism
nebezpečný biologic

Za opatrné zacházení s
materiály, za jejich dekontaminaci a za jejich správn
v souladu s příslušnými celostátními nebo místními p
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říprava matrix a MALDI terčíků

y nejsou pro analýzu hmotnostní spektrometrií vhodné, a to př
polymery. Nepoužívejte proto žádný typ silikonizovaných 

Používání nevhodných plastových materiálů má za následek heterogenní krystalizaci
ály, které mohou klasifikaci mikrobiálních druhů pomocí p

ovlivnit nebo dokonce znemožnit. 

dla a chemikálie, jež jsou pro zpracování vzorků přístrojem 
ejí být chemicky vysoce čistá (přinejmenším stupně

MALDI Biotyper lze použít následující MALDI terč

ěné oceli (Výr. č. 224989, Bruker Daltonik GmbH)

MSP BigAnchorChip™ 24 (Výr. č. 255080, Bruker Daltonik GmbH) 

MSP BigAnchorChip™ 96 (Výr. č. 254460, Bruker Daltonik GmbH) 

íky vhodné pouze pro autoflexní přístrojě: 

leštěné oceli T F (Výr. č. 209520, Bruker Daltonik GmbH)

MTP BigAnchorChip™ 384 T F (Výr. č. 254454, Bruker Daltonik GmbH)

POZOR:  BIOLOGICKÁ RIZIKA 

íky, reagenční činidla, reagencie a další spot
materiály používané při těchto analýzách (protokolech) mohly p

roorganismy a představují proto potenciáln
biologický materiál. 

Za opatrné zacházení s těmito látkami, příslušenstvím a spot
materiály, za jejich dekontaminaci a za jejich správnou likvidaci 

íslušnými celostátními nebo místními předpisy je 
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 pomocí přístroje 
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terčíky: 

224989, Bruker Daltonik GmbH) 

 

 

209520, Bruker Daltonik GmbH) 

254454, Bruker Daltonik GmbH) 

alší spotřební 
ohly přijít 

edstavují proto potenciálně 

íslušenstvím a spotřebními 
ou likvidaci 
ředpisy je 
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zodpovědný uživatel

 

POZOR: HOŘLAVÉ / K

 

 

 

Některé z chemikálií, které jsou p
vysoce hořlavé, koro

Pečlivě si pročtěte p
upozornění na chemická rizika a bezpe
dodavatelů těchto reagencií
bezpečnostní předpisy

Při zacházení s těmito chemik
pravidla bezpečnosti práce

Vždy používejte laboratorní plášt
rukavice. 

Je-li to výrobcem činidla doporu

 

A.1  Příprava matrix 

Jako matrix je třeba používat preparát 
Výr. č. 255344, Bruker Daltonik GmbH) 

DŮLEŽITÉ UPOZORNĚNÍ: R
Delší skladování roztoku 

DŮLEŽITÉ UPOZORNĚNÍ: 
př
kvalitní materiály a chemicky vysoce

3  MALDI Biotyper – Offline klasifikace (OC)
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dný uživatel. 

KOROZIVNÍ / NEBEZPEČNÉ CHEMIKÁLIE

chemikálií, které jsou při těchto analýzách používány, jsou 
orozivní anebo škodlivé. 

čtěte příslušné bezpečnostní materiálové listy, 
ní na chemická rizika a bezpečnostní pokyny výrobc

chto reagencií. Dodržujte všechny celostátní i místní 
edpisy. 

ěmito chemikáliemi vždy a všude dodržujte i obecná 
nosti práce. 

Vždy používejte laboratorní pláště, bezpečnostní brýle a ochranné 

činidla doporučeno, pracujte v digestoři. 

atrix roztoku 

eba používat preparát HCCAportioned (α-cyano-4-hydroxycinnamic acid
255344, Bruker Daltonik GmbH) ve všech aplikacích přístroje MALDI Biotyper.

Roztok matrix musÍ být připraven v den měření vzork
Delší skladování roztoku matrix se nedoporuč

NÍ: Pro správné zpracování vzorků je třeba se vždy 
přesvědčit o tom, že zda jsou použity pouze velmi 
kvalitní materiály a chemicky vysoce čisté reagen
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►► Příprava matrix roztoku 

1. Do Eppendorfovy mikrozkumavky odpipetujte 475 µl ultračisté vody, 25 µl 100% 

kyseliny trifluorooctové a 500 µl acetonitrilu, čímž dosáhnete celkového objemu 

1 ml. 

2. Tuto směs pečlivě promíchejte. Výsledná směs se nazývá “standardní 

rozpouštědlo”. 

3. Do mikrozkumavky s HCCAportioned matrix odpipetujte 250 µl standardního 

rozpouštědla. 

o Chcete-li připravit matrix pro terčíky BigAnchor MALDI targets odpipetujte do 

mikrozkumavky s HCCAportioned matrix 500 µl standardního rozpouštědla. 

4. HCCA rozpouštějte mícháním při pokojové teplotě až do okamžiku, kdy se roztok 

stane zcela průhledným (v roztoku musejí být rozpuštěny všechny krystaly). 

Konečná koncentrace roztoku matrix je 10 mg HCCA/ml. 

o Konečná koncentrace roztoku matrix pro terčíky BigAnchor MALDI targets je 

5 mg HCCA/ml. 

V tomto okamžiku je roztok matrix připraven k použití. 

Poznámka:  Připravený roztok matrix může být uložen ve tmě a při 
pokojové teplotě  (předcházejte kontaktu s UV zářením) po 
dobu jednoho pracovního dne. 

A.2  Čištění MALDI terčíků 

Před použitím při MALDI Biotyper procedurách musejí být MALDI terčíky pečlivě 
vyčištěny 70% vodným etanolem a 80% vodným roztokem kyseliny trifluorooctové. 

►► Příprava  70% vodného etanolu (100 ml) 

1. 30 ml deionizované vody nalijte do 100 ml odměrného válce. 

2. Obsah válce přelijte do kádinky. 

3. Do 100 ml odměrného válce nalijte 70 ml čistého etanolu. 

4. Obsah válce přelijte do kádinky obsahující 30 ml vody. 
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5. Roztok promíchejte přeléváním směsi obou reagencií z kádinky do válce a zpět 

(proveďte celkem pětkrát). 

Po tomto promíchání je vodný roztok etanolu připraven k použití. 

►► Příprava 80% vodného roztoku kyseliny trifluorooctové (250 µl) 

1. 50 µl deionizované vody odpipetujte do 1,5 ml Eppendorfovy mikrozkumavky. 

2. Opatrně přidejte 200 µl 100% kyseliny trifluorooctové. 

3. Roztok míchejte vířením po dobu 1 minuty. 

 Po tomto promíchání je roztok připraven k použití. 

►► Čištění MALDI terčíků 

DŮLEŽITÉ UPOZORNĚNÍ:   Nepoužívejte chemikálie jinak než je předepsáno. 
MALDI terčíky nikdy nenamáčejte do organických 
rozpouštědel na dobu delší než 20 minut. 

1. MALDI terčík vložte do vhodné nádobky a přelijte 70% vodným roztokem etanolu 

(připraveným podle výše uvedeného návodu) tak, aby byl zcela ponořen. 

2. Při pokojové teplotě nechejte MALDI terčík v roztoku máčet po dobu 5 minut. 

3. Pak MALDI terčík z lázně vyjměte a dokonale opláchněte pod tekoucí vodou. 

4. Utěrkou Kimwipe MALDI terčík pečlivě vyčistěte pomocí 70% vodného roztoku 

etanolu. 

5. Pak MALDI terčík znovu opláchněte tekoucí vodou a utřete do sucha utěrkou 

Kimwipe. 

6. 100 µl 80% vodného roztoku kyseliny trifluorooctové (připraveného podle výše 

uvedeného návodu) napipetujte na MALDI terčík. Všechny části MALDI terčíku 

pečlivě otřete utěrkou Kimwipe. 

7. MALDI terčík opláchněte v deionizované vodě a utřete do sucha utěrkou Kimwipe. 

8. Při pokojové teplotě nechejte MALDI terčík po do dobu nejméně 15 minut úplně 

uschnout. 

V tomto okamžiku je MALDI terčík připraven pro použití v MALDI Biotyper aplikacích. 

{b}Poznámka {/b} Vyčištěné MALDI terčíky lze před použitím skladovat i 
delší dobu na suchém místě a při pokojové teplotě. 
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Příloha  B —  Analýza vzorků 

B.1  Kultivace mikroorganismů 

V normálních kultivačních podmínkách se ke standardní kultivaci bakterií pro MALDI 
Biotyper analýzy používá krevní agar Columbia obsahující 5% ovčí krve. 

Jiná kultivační média (např. LB nebo YPD) mohou být použita taktéž, stejně jako 
různá růstová stádia anebo jiné teploty. Nejlepších výsledků lze dosáhnout  za 
podmínek, které se shodují s těmi podmínkami, které byly použity při kultivaci 
referenčních vzorků uložených v databázi.  

Při standardní metodě kultivace kvasinek pro MALDI Biotyper analýzu se používají 
v souladu s doporučeními dodavatele glukózo-agarové destičky (Sabouraud-glucose-
agar plates). 

Případné změny média nebo kultivačních podmínek jsou závislé na rozhodnutí 
uživatele a před použitím je třeba je validovat. 

Výchozí materiál musí být čerstvý, se subkulturou jediného druhu (kulitvace přes noc; 
pouze u pomalu rostoucích bakterií může kultivace trvat i několik dní). U kolonií 
kultivovaných na primáních agarových destičkách existuje zvýšené riziko výskytu dvou 
různých druhů mikroorganismů; toto riziko by mělo být prověřeno pomocí jejich 
izolované kultivace (opět přes noc). 

B.2  Příprava vzorků 

Pro analýzy přístrojem MALDI Biotyper existují tři různé metody přípravy vzorků: 

• Metoda přímého transferu — vhodná pro nepatogenní mikroorganismy. 

• Metoda extrakce kyselinou mravenčí — vhodná pro všechny nesporulující 

mikroorganismy. 

• Metoda extrakce kyselinou trifluorooctovou (TFA) — vhodná pro sporulující 

mikroorganismy. 

Metody extrakce kyselinou mravenčí a TFA lze použít především v těch případech, 
kdy metoda přímého transferu selže.  
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B.2.1  Metoda přímého transferu 

►► Příprava vzorků metodou přímého transferu 

{b}Poznámka {/b} Metoda přímého transferu by neměla být používána ke 
klasifikaci patogenů. Ke klasifikaci patogenních mikroorganismů použijte 
metody extrakce kyselinou mravenčí anebo TFA. 

1. Biologický materiál (jedinou kolonii) naneste jako tenký film  přímo na čistý MALDI 

terčík.  

Použít lze buď pipetové „špičky“ nebo inokulační kličky. Inokulovaný materiál je 
vždy třeba nanést stejnoměrně (homogenně). 

{b}DŮLEŽITÉ UPOZORNĚNÍ {/b} Tento krok je nejkritičtější 
součástí metody přímého transferu. Důležité je použít správné 
množství biologického materiálu. Tato analytlcká metoda je velmi 
citlivá a obecně lze říci, že při ní stačí použít jen malé množství 
materiálu. Je-li použité množství biologického materiálu příliš velké, 
klasifikace se nezdaří. 

{b}DŮLEŽITÉ UPOZORNĚNÍ {/b} Abychom se vyhnuli křížové 
kontaminaci, je nutno vždy používat buď nové pipetové špičky  
anebo plamenem desinfikované inokulační kličky. 

{b}DŮLEŽITÉ UPOZORNĚNÍ {/b} Po uschnutí vzorku je třeba 
matrix aplikovat nejpozději do 10 minut. 

2. Každou pozici vzorku (= spot) pečlivě překryjte 1 µl matrix roztroku (viz Přílohu  B). 

{b}DŮLEŽITÉ UPOZORNĚNÍ {/b} Je  velmi důležité, abychom se 
vyhnuli spojování různých vzorků, neboť kapičky matrix se 
navzájem smíchávají. Takovýto proces pak může způsobit křížovou 
kontaminaci a nesprávné výsledky. 

3. Jednotlivé pozice (skvrny) vzorků nechejte uschnout při pokojové teplotě. 

Vždy je třeba, aby byl získaný preparát homogenní. 

V tomto okamžiku je vzorek připraven ke klasifkaci. Připravený MALDI terčík vložte 
okamžitě do hmotnostního spektrometru MALDI-TOF. 
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4. Bude-li třeba provést ještě další klasifikační analýzy, uchovávejte agarové destičky  

při pokojové teplotě. 

Poznámka: Uchovávání agarových destiček v chladničce má na kvalitu 
spekter negativní vliv. 

Poznámka  Uplyne-li od použití vzorku pro přímý transfer více než 12 hodin, 
je třeba ho pro další analýzu překultivovat. 

B.2.2  Metoda extrakce kyselinou mravenčí 

►► Příprava vzorků pomocí extrakce kyselinou mravenčí  

1. Odpipetujte 300 µl ultračisté vody do čisté Eppendorfovy mikrozkumavky.  

2. Do zkumavky přeneste jen jednu jedinou kolonii biologického materiálu. 

3. Suspenzi buněk v  Eppendorfove zkumavce homogenizujte opakovaným 

pipetováním a odsáváním, po němž následuje intenzivní promíchání krouživým 

pohybem (minimálně po dobu jedné minuty). 

4. Do mikrozkumavky odpipetujte 900 µl čistého etanolu a vznikou suspenzi 

krouživým pohybem intenzivně promíchejte (minimálně jednu minutu). 

5. Pak zkumavku 2 minuty odstřeďujte při 13 000 ot/min a supernatant pipetou 

odsajte. 

6. Krok 5 zopakujte.  

Všechen reziduální etanol je třeba odstranit. 

7. Odpipetujte 30 µl H2O a 70 µl 100% kyseliny mravenčí do čisté Eppendorfovy 

mikrozkumavky a směs intenzivním krouživým pohybem promíchejte.  

Výsledkem této procedury je 70% vodný roztok kyseliny mravenčí. 

K peletě přidávejte 1–80 µl 70% vodného roztoku kyseliny mravenčí a výslednou 
směs pečlivě promíchejte opakovaným pipetováním a odsáváním, po němž 
následuje promíchání intenzivním krouživým pohybem. Pak do zkumavky přidejte 
stejný objem 100% acetonitrilu a vše znovu důkladně promíchejte. Objem 70% 
kyseliny mravenčí a acetonitrilu přidaný k peletě by měl odpovídat množství 
biologického materiálu, který byl do zkumavky přenesen v kroku 2. 
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  Malá jediná 
kolonie 

Velká jediná 
kolonie 

1 µl inokulační 
klička 

10 µl inokulační 
klička 

Kyselina 
mravenčí 

1–5 µl 5–15 µl 10–40 µl 30–80 µl 

Acetonitril 1–5 µl 5–15 µl 10–40 µl 30–80 µl 

 

9. Zkumavku odstřeďujte při 13 000 ot/min po dobu 2 minut. 

10. Pipetou naneste 1 µl supernatantu tohoto mikrobiálního extraktu na čistý MALDI 

terčík. 

11. Vzorek pak nechejte uschnout při pokojové teplotě. 

Výsledkem tohoto postupu by měl být homogenenní preparát. 

DŮLEŽITÉ UPOZORNĚNÍ: Po uschnutí vzorku je třeba matrix přidat nejpozději 
do 10 minut. 

12. Pčlivě překryjte každou pozici vzorku (= skvnu) 1 µl roztoku matrix (viz Příloha  B). 

DŮLEŽITÉ UPOZORNĚNÍ: Je velmi důležité vyhýbat se smíchávání různých 
vzorků, nebot‘ může dojít k vzájemnému průsaku (bleeding) 
kapiček. 

13. Hodnocené skvrny vzorku pak nechejte uschnout při pokojové teplotě. 

 Výsledkem tohoto postupu by měl být homogenenní preparát. 

Výsledný vzorek je tak připraven pro klasifikační proces. MALDI terčík vložte 
bezopdkladně do hmotnostního spektrometru MALDI-TOF. 

B.2.3  Metoda TFA extrakce 

Metoda TFA extrakce je vhodná pri inaktivaci sporulujícího biologického materiálu. 

►► Příprava vzorku  pomocí metody TFA extrakce 

1. Biologický materiál (5-10 mg) přeneste od čisté Eppendorfovy mikrozkumavky. 



Bruker Daltonik GmbH 3  MALDI Biotyper – Offline klasifikace (OC) 
 

MALDI Biotyper 3.0 User Manual Revision 2 Page 162 of 191 
 

2. Do zkumavky pak odpipetujte 50 µl  80% TFA a vše resuspendujte opakovaným 

pipetováním, které je třeba provádět tak dlouho, až se biologický materiál úplně 

rozpustí/denaturuje.  

Při práci se sporulujícími mikroorganismy zůstává roztok turbidní (zakalený).  

3. Inkubujte při pokojové teplotě po dobu 10–30 minut. 

4. Do zkumavky odpipetujte 150 µl H2O. 

5. Dále do zkumavky odpipetujte 200 µl acetonitrilu a výslednou směs intenzivním 

krouživým pohybem promíchejte. 

6. Zkumavku odstřeďujte při 13 000 ot/min po dobu 2 minut. 

7. 1 – 2 µl supernatantu tohoto mikrobiálního extraktu naneste pipetou na čistý 

MALDI terčík. 

8. Skvrny vzorku nechejte uschnout při pokojové teplotě. 

 Výsledkem tohoto postupu by měl být homogenenní preparát. 

DŮLEŽITÉ UPOZORNĚNÍ: Po zaschnutí vzorku je třeba matrix přidat nejpozději 
do 10 minut. 

9. Každou pozici vzorku (= skvrnu) překryjte 2 µl roztoku matrix (viz Příloha  B). 

DŮLEŽITÉ UPOZORNĚNÍ: Je velmi důležité vyhýbat se smíchávání různých 
vzorků, nebot‘ může dojít k vzájemnému průsaku (bleeding) 
kapiček. 

9. Skvrny vzorku nechejte uschnout při pokojové teplotě. 

 Výsledkem tohoto postupu by měl být homogenenní preparát. 

Vzorek je nyní připraven ke klasifikaci. MALDI terčík vložte bezodkladně do 
hmotnostního spektrometru MALDI-TOF. 

B.3  Měření MALDI-TOF spekter 

Při klasifikaci pomocí přístroje MALDI Biotyper jsou k měření spekter vhodné 
následující přístroje firmy Bruker: 



Bruker Daltonik GmbH 
 

MALDI Biotyper 3.0 User Manual Revision 2
 

• Přístroje řady microflex™  

• Přístroje řady autoflex™speed 

• Přístroje řady ultrafleXtreme™ 

B.3.1  Kalibrace 

Uživatelé si mohou sami definovat tu pozici ter
procesu klasifikace provedena automatic

Kalibrační a validační procedura 
standardu Bruker Bacterial Test Standard 
je v podstatě preparátem kmene 
dodatečnými proteiny do horní č
v hmotnostním rozmezí od 4 do 17 kDa.

►► Provedení kalilbrační procedury u p

1. Vložte  MALDI terčík se vzorkem testovacího standardu 

Standard do přístroje a spusť

Při přípravě testu postupujte podle pokyn
k výrobku (Product Information

2. Metodu flexControl spust’te př

3. Provedete to buď tak, že: 

a. metodu flexControl spustíte př

40 míst (shots) na různých pozicích skvrny nacházející se na skvrn

standardu (Bruker Bacterial Test Standar

K akumulaci těchto míst (shots) bu

. 

ANEBO 

b. Natáhněte vhodnou metodu automatického provedení testu zvanou 

method (např. MBT_AutoX.axe

3  MALDI Biotyper – Offline klasifikace (OC)
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autoflex™speed  

ultrafleXtreme™  

živatelé si mohou sami definovat tu pozici terčíku, na níž bude před zahájením 
automatická kalibrační a validační procedura. 

 se provádí na té pozici terčíku, která obsahuje vzorek 
Bruker Bacterial Test Standard (Bruker díl výr. č.255343). Tento

 preparátem kmene E. coli DH5α, který byl nanesen se dv
nými proteiny do horní části hmotnostního rozmezí, což umožňuje kalibraci 

o 17 kDa. 

ní procedury u přístroje MALDI Biotyper  

ík se vzorkem testovacího standardu Bruker Bacterial Test 

ístroje a spusťte program flexControl. 

 testu postupujte podle pokynů uvedených v brožuře p
Product Information). 

spust’te příkazem MBT_FC.par. 

spustíte příkazem MBT_FC.par a pak manuálně změř

zných pozicích skvrny nacházející se na skvrně testovacího 

Bruker Bacterial Test Standard spot). 

chto míst (shots) buď použijte tlačítek 

te vhodnou metodu automatického provedení testu zvanou autoXecute 

MBT_AutoX.axe) a klikněte na . 
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ed zahájením 
 

íku, která obsahuje vzorek 
ento standard 

který byl nanesen se dvěma 
ňuje kalibraci 

Bruker Bacterial Test 

ře přiložené 

ěříte 6 x 

 testovacího 

 a 

autoXecute 
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4. Pak klikněte na tlačítka Display sum buffer

buffer  ( ).  

5. Vyberte tabulku Calibration a

příkaz MBT_Standard    

6. buď: 

a. kliknutím na  , čímž provedete 

kalibrovaného vzorku  

ANEBO 

b. píky přiřaďte manuálně tak, že

o kalibrant vyberete ze seznamu 

objeví vertikální červená č

o Poté ihned klikněte vlevo od píku, který pat

červená čára zezelená a 

7. U každého kalibrantu zkontrolujte sloupec 

3  MALDI Biotyper – Offline klasifikace (OC)
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Display sum buffer ( ) a Smooth spectrum in sum 

 

a v sestupném seznamu Mass Control List 

, čímž provedete automatické přiřazení píků 

 tak, že: 

ibrant vyberete ze seznamu Mass Control List (na displeji spektra se 

ervená čára).  

te vlevo od píku, který patří ke kalibrantu (tím vertikální 

 na špičce píku se zobrazí odpovídající hmotnost

každého kalibrantu zkontrolujte sloupec Err/ppm.  
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trum in sum 

 zvolte 

na displeji spektra se 

kální 

ce píku se zobrazí odpovídající hmotnost). 
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Zobrazená hodnota nesmí být vyšší než 
než ±300 ppm, vraťte se zpět a zopakujte krok 

7. Novou kalibraci akceptujete kliknutím na 

8. Nové kalibrační hodnoty uložte d
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Zobrazená hodnota nesmí být vyšší než ±300 ppm. Je-li kterákoli z hodnot vyšší 
ět a zopakujte krok 3. 

Novou kalibraci akceptujete kliknutím na . 

ní hodnoty uložte do metody flexControl pomocí MBT_FC.par

ifikace (OC) 
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hodnot vyšší 

MBT_FC.par. 
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Příloha  C — Instalace a licencování softwaru 
MALDI Biotyper  

V přístroji Bruker Daltonics MALDI Biotyper 3.0 je nainstalována anglická verze 
Windows XP. Podrobnosti týkající se servisních balíčků naleznete v poznámkách 
Release Notes na instalačním CD-ROM. 

Pro práci spřístrojem MALDI Biotyper 3.0 je třeba nainstalovat aplikaci MATLAB 
Component Runtime. Při tomto postupu software MALDI Biotyper installation 
nejdříve zkontroluje, zda je komponenta MATLAB nainstalována a jestliže tomu tak 
není, upozorní uživatele na to, že před spuštěním programu MALDI Biotyper 
installation, je třeba tuto applikaci nainstalovat. Oba softwary (MALDI Biotyper a 
MATLAB Component Runtime) se nacházejí na instalačním CD softwaru MALDI 
Biotyper. 

První instalací programu MALDI Biotyper Offline Classification do kteréhokoli počítače 
se automaticky vytváří dočasná licence, která platí 60 dnů. Jakmile tato dočasná 
licence skončí, je třeba použít licenční heslo, které je dodáváno spolu se softwarovým 
baličkem (jinak MALDI Biotyper nebude fungovat). 

C.1  Systémové požadavky 

Minimální požadavky kladené na počítač užívající serverovou a klientskou aplikaci 
jsou uvedeny níže: 

• CPU: mikroprocesor Dual core processor (např. Intel Core nebo Intel Xeon) 

• Hard disk: nejméně 1 GB volného místa na disku 

• Hlavní paměť: 4 GB RAM 

• Operační systém: Windows XP nebo Windows 7 s nejnovějším servisním 

balíčkem  

• Grafické rozlišení: 1024 x 768 pixelú, 256 barev nebo vyšší (např. 1650 x 1080 

with true colours) 

• Mechaniky CD-ROM / DVD (pouze pro instalaci) 

• Internet Explorer 8.0 

• Microsoft .NET Runtime 3.5 (nenachází-li se v počítači, bude nainstalován 

Setupem) 
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C.2  Instalace softwaru MALDI Biotyper 

Software MALDI Biotyper používá architekturu client/server. Existují dva hlavní 
instalační balíčky, tj.: klientský balíček a serverový balíček. Vzhledem k tomu, že za 
správu dat zodpovídá server, je serverový balíček nainstalován pouze do jednoho 
počítače (centrální server). Klientský balíček může být nainstalován do různých 
počítačů (každá instalace si ale vyžaduje samostanou licenci). Všichni offline klienti 
softwaru MALDI Biotyper mají přístup k datům nacházejícím se na centrálním 
serveru. 

Klientská a serverová instalace se iniciují z příslušného bodu menu jejich spouštěče, 
který se obvykle nastartuje po natažení instalačního CD. Je-li funkce Autostart 
deaktivována, nastartujte instalaci přímo pomocí aplikace ‘Launch.exe’, která se 
nachází v kořenovém adresáři (root directory) instalačního CD. 

C.2.1  Instalace MALDI Biotyper serveru 

Instalační balíček MALDI Biotyper serveru se skládá ze čtyř dílčích balíčků (sub 
packages), které se nainstalují automaticky v předem určeném pořadí. 

1. Java runtime (JVM) 

2. MATLAB component runtime (MCR) 

3. Server relační databáze (PostgreSQL) 

4. Aplikační server (JBoss) 

Během instalace postupuje uživatel podle instalačních kroků (setups). 

V závislosti na rychlosti počítače může instalace trvat několik minut až půl hodiny. 

Instalací serveru se do databáze uloží výrobcem nastavené referenční profily hlavních 
spekter (50 MSPs). Další hlavní spektra lze získat v samostatném instalačním balíčku 
(MaldiBiotyperDBRestore_Standard.exe), který však může být nainstalován až 
po instalaci MALDI Biotyper serveru. 
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C.2.2  Instalace balíčku MALDI Biotyper Offline Classification

Instalační balíček MALDI Biotyper Offline Classification
které se nainstalují automaticky v

1. Balíček MATLAB component runtime

2. Balíček s aplikací MALDI Biotyper Offline Classification

Během instalace postupuje uživatel podle jednotlivých instala
Balíček MCR je nainstalován pouze v

C.2.3 Instalace baličku MALDI Biotyper Offline Classification 
v síti se vzdáleným MALDI Biotyper Server

Tuto proceduru použijte tehdy, chcete
severem. 

►► Instalace baličku MALDI Biotyper Offline Classification 
MALDI Biotyper Serverem: 

1. Zvolte příkazy  > Programs > Bruker Daltonics > MALDI Biotyper.

2. Není-li software MALDI Biotyper 

3. Na požádání se zalogujte (přihlaste)

Zobrazí se klientská aplikace s

4. Zvolte příkazy Tools > Server

vzdáleného serveru. Původní č

5. Dialog Server Settings ukonč

3  MALDI Biotyper – Offline klasifikace (OC)
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MALDI Biotyper Offline Classification

MALDI Biotyper Offline Classification obsahuje dva dílč
ky v předem stanoveném pořadí.  

MATLAB component runtime (MCR) 

MALDI Biotyper Offline Classification  

upuje uživatel podle jednotlivých instalačních kroků (
je nainstalován pouze v tom případě, že v systému není přítomen

MALDI Biotyper Offline Classification 
MALDI Biotyper Serverem 

hdy, chcete-li klientský počítač propojit se vzdáleným 

Biotyper Offline Classification v síti se vzdáleným 

> Programs > Bruker Daltonics > MALDI Biotyper.

MALDI Biotyper licencován, vložte platné licenční heslo. 

Na požádání se zalogujte (přihlaste). 

ská aplikace s prázdným taxonomickým dendrogramem. 

Tools > Server a do dialogu Server Settings vložte název 

vodní čtyřmístné nastavení portu neměňte. 

 

ukončíte kliknutím na OK. 
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MALDI Biotyper Offline Classification 

obsahuje dva dílčí balíčky, 

ů (setups). 
ítomen. 

MALDI Biotyper Offline Classification   

 propojit se vzdáleným 

síti se vzdáleným 

> Programs > Bruker Daltonics > MALDI Biotyper. 

 

 

vložte název 
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6. Je-li u specifikovaného hostitelského po

objeví se  na obrazovce platný 

uloží nový název serveru. 

C.3  Licencování softwaru

Po první instalaci softwarového balí
počítače se automaticky vytvoří do
tato dočasná licence skončí, je tř
softwarovým baličkem MALDI Biotyper
po 30 dnech varování, že po dalších 30 dnech tato licence vyprší

Poznámka  Je-li ve vašem systému na
Compass Security Pack
automaticky v
Bruker Daltonics UserManagement
v tomto módu 
uživatelé, kteří jsou vybaveni speciálními právy

►►  Licencování balíčku  MALDI Biotyper Offline Classification
takto: 

1. Volbou příkazů   > Programs > Bruker Daltonics > Administration > 

LicenseManager zahajte dialog 

2. Do políček New license key 

Classification. 

3. Klikněte na Add (lze provést až po vložení licen

• V nepovoleném módu se po vložení platného licen

do seznamu Existing licenses

• V nepovoleném módu se v

enter Your Password. Požadované heslo vložte znovu a klikn

heslo správné a uživatel má právo licence p

přijata.  

Není-li heslo správné anebo nemá

chybové hlášení. 

3  MALDI Biotyper – Offline klasifikace (OC)
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li u specifikovaného hostitelského počítače MALDI Biotyper server nalezen

objeví se  na obrazovce platný taxonomický dendrogram a do klientské apl

cování softwaru MALDI Biotyper 

ci softwarového balíčku MALDI Biotyper Offline Classification 
ří dočasná licence, která má platnost 60 dnů

í, je třeba použít licenční heslo, které je dodáváno spolu se 
MALDI Biotyper. Je-li dodána pouze dočasná licence, objeví se 

po 30 dnech varování, že po dalších 30 dnech tato licence vyprší. 

li ve vašem systému nainstalována aplikace Bruker Daltonics 
Compass Security Pack, funguje software MALDI Biotyper 

ky v povoleném (Compliance) módu a užívá aplikaci 
Bruker Daltonics UserManagement (část 4.1). Při fungování 

tomto módu mohou licence přidávat a vymazávat pouze ti 
uživatelé, kteří jsou vybaveni speciálními právy. 

MALDI Biotyper Offline Classification lze provést 

> Programs > Bruker Daltonics > Administration > 

zahajte dialog Bruker Daltonics LicenseManager. 

 vložte licenční heslo balíčku MALDI Biotyper Offline 

lze provést až po vložení licenčního hesla). 

nepovoleném módu se po vložení platného licenčního hesla licence př

Existing licenses. 

nepovoleném módu se v případě použití platného hesla otevře dialog 

Požadované heslo vložte znovu a klikněte na OK

heslo správné a uživatel má právo licence přidávat/odebírat, bude tato 

li heslo správné anebo nemá-li uživatel požadovaná práva, objeví se 
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nalezen, 

ický dendrogram a do klientské aplikace se 

MALDI Biotyper Offline Classification do 
nů. Jakmile 

ní heslo, které je dodáváno spolu se 
asná licence, objeví se 

Bruker Daltonics 
MALDI Biotyper 

u a užívá aplikaci 
ři fungování 

t pouze ti 

lze provést 

> Programs > Bruker Daltonics > Administration > 

MALDI Biotyper Offline 

ního hesla licence přidává 

e dialog Re-

OK. Je-li 

bude tato licence 

li uživatel požadovaná práva, objeví se 
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• Chcete-li některou z licencí vymazat

klikněte na Delete. 

4. Kliknutím na Close aplikaci Bruker Daltonics LicenseManager

Program LicenseManager může být v
příkazů Compass > License. 
licence, které jsou momentálně pro aplikace

C.4  Odinstalování program

►► Chcete-li program MALDI Biotyper 3.0 Client/Server

1. Zvolte příkazy  > Settings > Control Panel

2. Dvakrát klikněte na nabídku Add/Remove Program

3. V seznamu nainstalovaných program

RTC/OC. 

4. Klikněte na nabídku Remove

5. Potvrďte dotaz, zda tento software

C.5   Instalace programu 
Classification  

1. Software MALDI Biotyper Real Time Classification

dat (flexControl) s jejich klasifikací 

nainstalovat pouze do toho akvizi

flexControl. 

3  MALDI Biotyper – Offline klasifikace (OC)
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cí vymazat, vyberte ji v seznamu Existing licenses

Bruker Daltonics LicenseManager ukončíte. 

ůže být v softwaru MALDI Biotyper otevřen také pomocí 
. V tomto případě LicenseManager zobrazí
ě pro aplikace Bruker Daltonics dostupné. 

ování programu MALDI Biotyper 

MALDI Biotyper 3.0 Client/Server odinstalovat: 

> Settings > Control Panel. 

Add/Remove Program. 

seznamu nainstalovaných programů zvolte software MALDI Biotyper 3.0 

Remove. 

software skutečně chcete odstranit. 

ace programu MALDI Biotyper Real Time 

MALDI Biotyper Real Time Classification (viz část 2) propojuje akvizici 

jejich klasifikací (MALDI Biotyper). Tento balíček lze 

nainstalovat pouze do toho akvizičního systému, v němž funguje program 
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Existing licenses a 

en také pomocí 
zobrazí všechny 

MALDI Biotyper 3.0 

MALDI Biotyper Real Time 

juje akvizici 

mž funguje program 
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Příloha  D — Nastavení registrů (určeno pouze 
pro vyspělé uživatele) 

Konfigurační registr pro program MALDI Biotyper RTC je lokalizován na adrese: 

HKEY_CURRENT_USER\Software\Bruker Daltonik\BioTyper Automation 

Control\Configuration. 

Nastavení registračního klíče (registry key settings) mohou být rozdělena do pěti 
skupin: 

• AutoXecute — slouží ke spuštění funkce AutoXecute. 

• Report Creation (tvorba zprávy) — definuje pořadí, v němž se budou výsledky 

klasifikace objevovat ve zprávě o výsledcích klasifikace (Classification Results 

report). 

• Data Directory Name (název datového adresáře) — definuje název adresáře, 

do něhož jsou naměřené údaje uloženy. 

• Project Import (import projektu) — používá se k přiřazení hodnot obsažených v 

CSV souborech do náhledu tabulek v Průvodci programem MALDI Biotyper 

RTC. 

• Sequential Insert Mode (sekvenční modus ukládání) — kontroluje přiřazování 

ID v sekvenční módu ukládání (viz část 2.5.1.4) 

Klíč registru Výrobcem nastavená hodnota  Poznámka 

AutoXecute     

autoXecuteMetod 
DefaultMeasure   

measuringOrder 
HORIZONTAL_ZIGZAG   

spectrumDir 
D:\Data\MALDIBiotyperRealTime 
Classification 

  

targetGeometry 
MSP 96   

Report Creation     
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Klíč registru Výrobcem nastavená hodnota  Poznámka 

sortColumn 
name Sloupce použité pro třídění 

výsledků ve zprávě. 
povolené hodnoty = name, 
externalID, description. 

Data Directory 
Name 

    

sampleNameColumn 
externalId Přidání dalšího 

podadresáře mezi projekt a 
adresáře vzorků  na cestě 
ukládání spekter. Název 
tohoto podadresáře je 
odvozen od příslušné 
hodnoty. Povolené hodnoty 
= name, externalID, 
description. 

Project Import     

importFolder 
C:\Documents and 
Settings\<user>\Desktop 

Designovaný importní 
adresář pro importovaný 
CSV soubor (viz část 
2.6.2). 

importSuffix 
in V importním dialogu budou 

zobrazeny pouze soubory 
mající tuto příponu (viz část 
2.6.2). 

csvDelimiter 
; Separátor používaný pro 

analýzu (parsing) CSV 
souborů. 

posOnScoutImport 

ColumnNumber 

1 Sloupec CSV souboru 
odpovídající pozici 
(Position). 

externalIdImport 

ColumnNumber 

2 Sloupec CSV souboru 
odpovídající ID. 

nameImport 

ColumnNumber 

0 Sloupec CSV souboru 
odpovídající Name.  
0 = nepoužito. 

descriptionImport 
0 Sloupec CSV souboru 

odpovídající popisu 
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Klíč registru Výrobcem nastavená hodnota  Poznámka 
ColumnNumber (Description). 

0 = nepoužito. 

chipOnScoutImport 

ColumnNumber 

0 Sloupec CSV souboru 
odpovídající Chip. 
0 = nepoužito. 

Sequential Import 
Mode 

    

generateAnalyte 

IdNumber 

0 0 = povoluje ve stejném 
projektu opakovat ID (např. 
pro větší počet preparátů 
téhož vzorku); 1 = přidává 
k ID sčítač (counter) (-00x) 
a zvyšuje ID pro 
opakované případy (tzn. že 
všechna ID jsou 
jedinečná). 
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Příloha  E —  Povolený modus 

Software MALDI Biotyper může být pužit také v povoleném pracovním módu 
(Compliance mode), což napomáhá při plnění požadavků FDA 21 CFR Part 11 
(pravidla FDA pro elektronické podpisy a záznamy). 

E.1  Činnost softwaru MALDI Biotyper v povoleném 
módu 

K činnosti sortwaru MALDI Biotyper v povoleném módu je zapotřebí nainstalovat 
aplikaci Bruker Daltonics Compass Security Pack, která zajišťuje funkci Bruker 
Daltonics UserManagement; tuto aplikaci je nejvhodnější nainstalovat na centrální 
server. Existuje-li licence Compass Security Pack, zahájí software MALDI Biotyper 
činnost v povoleném módu zcela automaticky.  

{b}Poznámka {/b} V kontextu balčku Compass Security Pack znamená 
Povolený modus (Compliance mode) to, že jsou nástroje a funkce balíčku 
Compass Security Pack dostupné a že je uživatel může použít k tomu, aby 
splnil požadavky pravidel FDA pro elektronické podpisy a záznamy (21 
CFR Part 11 requirements). Ani povolený modus (Compliance mode), ani 
balíček Compass Security Pack však úplnou shodu s požadavky 21 CFR 
Part 11 zajistit nemohou. 

Povolený modus dává softwaru MALDI Biotyper následující vlastnosti: 

• Do programu MALDI Biotyper se mohou zalogovat pouze ti uživatelé, kteří byli 

vytvořeni správci aplikace UserManagement (UserManagement 

administrators). Pro zalogování je třeba uvést uživatelské ID a heslo. 

• Administrátor aplikace UserManagement může přístup do programu MALDI 

Biotyper umožnit tím, že uživatelům, které vytvoří, udělí jejich individuální práva. 

Tato práva se týkají těch činností (actions), jejichž provádění je jim v systému 

MALDI Biotyper povoleno. 

• Všechny Bruker Daltonics aplikace, které jsou v uživatelském počítači 

nainstalovány, mohou být tímto uživatelem zamykány a odemykány. 

Poznámka:  Výše uvedené vlastnosti se týkají kterékoli aplikace, která je 
podporována softwarem Bruker Daltonics UserManagement. 
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E.2  Operační práva k aplikacím Bruker Daltonics 
UserManagement a MALDI Biotyper   

Aplikace UserManagement je určena jak pro klienty, tak pro server. Databáze 
definující uživatele a jejich práva je nainstalována v serverovém počítači, zatímco 
aplikace Bruker Daltonics jsou nainstalovány v počítačích klientských. 

Operátoři jsou vytvářeni a vybavování příslušnými právy pomocí aplikace Bruker 
Daltonics UserManagement Administration Tool. Vytvářet operátory a udělovat jim 
jejich práva smějí pouze administrátoři aplikace UserManagement. 

Poznámka:  Podrobné informace o tom, jak jsou uživatelé vytvářeni a jak jsou 
jim jejich práva předělována, lze nalézt v aplikaci s pomocnými 
nástroji UserManagement Administration Tool help tools. 

Aplikace UserManagement uděluje tato oprávnění, která se týkají softwaru MALDI 
Biotyper: 

• Právo obecné  analýzy (General Analyses Processing) — základní právo, 

které uživatel potřebuje mít k tomu, aby mohl spektra v přístroji MALDI Biotyper 

zpracovávat. Uživatel sice smí používat metody, hlavní spektra a další, které již 

existují, nesmí ale žádnou z metod měnit. 

• Právo měnit konfiguraci programu (Change Program Configuration) — toto 

oprávnění klient využívá k měnění metod stávajících a k vytváření nových 

metod, MSP atd. 

U aplikace MALDI Biotyper jsou předdefinovány dvě uživatelské kategorie:  

• Projektoví manažeři (Project Managers) — příslušníci  této skupiny mají 

oprávnění provádět jak obecnou analýzu, tak také měnit konfiguraci programu.  

• Operátoři (Operators) — příslušníci  této skupiny jsou oprávněni provádět 

pouze obecnou analýzu.  

o  Pokusí-li se operátor provést tu akci, k níž nemá potřebné oprávnění, objeví 

se příslušná varovná informace. 
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E.3  Změna uživatelských hesel

V Povoleném módu (Compliance mode
uživatele zadáním jeho ID a hesla
uživatelé své heslo měnit kdykoli to bude zapot

Uživatel je požádán, aby změnil s

• Při prvním přihlášení se do té aplikace

podporuje program UserManagement

• V okamžiku,kdy je adminstrátorem programu 

požádán, aby se definoval jako nový uživatel.

• Poté, co administrátor aplikace 

heslo (tak např. poté, co byl ze systému vylou

neplatného hesla) 

Nová hesla musejí být vytvořena v
definována administrátorem programu 

►► Změna hesla 

1. V dialogu spusťte přihlašování d

programu anebo výběrem příkaz

2. Do políčka Operator vložte platné ID uživatele

3. Kliknutím na nabídku Change Password

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 Page 

na uživatelských hesel 

Compliance mode) je pro zalogování nutno prověst identifikaci 
a hesla. V době, kdy je  MALDI Biotyper v chodu, mohou 

nit kdykoli to bude zapotřebí a kdykoli si to budou přát. 

své heslo v těchto případech: 

ihlášení se do té aplikace systému Bruker Daltonics, která 

UserManagement. 

okamžiku,kdy je adminstrátorem programu UserManagement  poprve 

požádán, aby se definoval jako nový uživatel. 

aplikace UserManagement změnil nebo resetoval jeho 

co byl ze systému vyloučen kvůli opakovanému zadání 

řena v souladu s pravidly jejich tvorby; tato pravidla jsou 
ována administrátorem programu UserManagement. 

ihlašování do programu MALDI Biotyper buď vybráním tohoto 

říkazů Compass > Operator. 

vložte platné ID uživatele. 

Change Password dialog Change Password zahájíte
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li opakovanému zadání 

pravidly jejich tvorby; tato pravidla jsou 

 vybráním tohoto 

zahájíte. 
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4. Do políčka Old password vložte momentál

Při psaní se heslo nezobrazuje
písmena. 

5. Nové heslo vložte do políčka 

Nová hesla musejí být vytvoř
jsou definována administrátor

6. Nové heslo vložte ještě jednou do polí

7. Klikněte na OK a zavřete zprávu potvrzující úsp

Objeví-li se chybové hlášení, zopakujte všechny požadované kroky

E.4   Zamykání a odemykání 

Administrátoři programu UserManagement 
vyloučit. Vyloučení uživatelé se pak nemohou p
systému Bruker Daltonics, které jsou programem 

3  MALDI Biotyper – Offline klasifikace (OC)

Revision 2 Page 

vložte momentálně platné heslo.  

i psaní se heslo nezobrazuje. V heslech je třeba rozlišovat velká a malá 

čka New password. 

ová hesla musejí být vytvořena v souladu s pravidly jejich tvorby; tato pravidla 
ována administrátorem programu UserManagement. 

 jednou do políčka Confirm new password. 

ete zprávu potvrzující úspěšnou změnu hesla.  

 

li se chybové hlášení, zopakujte všechny požadované kroky. 

 

Zamykání a odemykání uživatelů 

UserManagement mohou uživatele kdykoli ze systému 
ení uživatelé se pak nemohou přihlásit do žádné z těch aplikací 

které jsou programem UserManagement kontrolovány
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eba rozlišovat velká a malá 

pravidly jejich tvorby; tato pravidla 

mohou uživatele kdykoli ze systému 
ěch aplikací 

kontrolovány. 
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Opakované vkládání neplatného hesla vede k
vyloučen. Administrátor programu U
neplatných hesel může uživatel vložit p

O tom, že byli ze systému vyloučeni, budo

Přístup do systému může uživateli obnovit p
UserManagement. 

E.5  Zamykání a odemykání aplikací programu 
Daltonics  

V povoleném operačním módu mohou uživatelé p
programu Bruker Daltonics zamykat
uživatel, který ji uzamkl anebo administr

{b}Poznámka {/b} Všechny aplikace programu 
kontroluje UserManagement 
kterákoli z nich nebude po ur

►► Zamčení aplikací systému 

1. Zvolte příkazy Compass > Lock All Applications

Tím se otevře dialog, který bude uživatele informovat o tom, že je systém 
MALDI Biotyper uzamčen. 

3  MALDI Biotyper – Offline klasifikace (OC)
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ní neplatného hesla vede k tomu, že je uživatel ze systému 
Administrátor programu UserManagement může určit, jaký počet zadání 

že uživatel vložit před tím, než bude ze systému vyloučen

O tom, že byli ze systému vyloučeni, budou uživatelé posléze informováni.  

že uživateli obnovit přístup pouze administrátor programu 

Zamykání a odemykání aplikací programu Bruker 

ním módu mohou uživatelé přístup do jednotlivých aplikací 
zamykat. Aplikaci může znovu otevřít pouze bu

dministrátor. 

Všechny aplikace programu Bruker Daltonics
UserManagement budou automaticky uzamčeny v případ
nich nebude po určitou dobou použita. 

kací systému Bruker:  

Compass > Lock All Applications. 

e dialog, který bude uživatele informovat o tom, že je systém 
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►► Odemčení aplikací systému Bruker:  

1. Vložte platné uživatelské ID (rozlišujte velká a malá písmena) do políčka Operator 

v dialogu programu MALDI Biotyper. 

V dialogu se zobrazí ten  Operator, který aplikaci uzamkl.  

Poznámka:  Jiní uživatelé než operátor, který aplikace uzamkl, musejí mít 
právo tyto aplikace odemknout. 

2. Vložte platné uživatelské ID (rozlišujte velká a malá písmena). 

3. Klikněte na nabídku Log On. 



Bruker Daltonik GmbH 3  MALDI Biotyper – Offline klasifikace (OC) 
 

MALDI Biotyper 3.0 User Manual Revision 2 Page 180 of 191 
 

Příloha  F —  Glosář 

A 

Active (target) position – Aktivní (cílová) pozice 
Cílová pozice zvolená pro vložení údajů o pozici analytu vybraného pro vložení 
potřebných údajů. Na displeji stránky Analyte Placement je tato pozice označena 
bílým kroužkem. 

Ambiguous result – Nejednoznačný výsledek  
Nejednoznačný výsledek je získán tehdy, jestliže je u jediného vzorku získána 
vice než jedna pravděpodobná klasifikace druhu (hodnota skóre >2.0). 

Analyte – Analyt  
Vzorek nalyzovaný (tj. definovaný, změřený a oklasifikovaný) během klasifikace 
programem MALDI Biotyper. 

Analyte Placement page – Stránka umístění analytu 
Stránka v Průvodci programem IVD MALDI Biotyper RTC určená k vložení údajů 
o analytu a jeho pozici. 

Analyte position – Pozice analytu 
Pozice cílového analytu (= Pozice vložená na stránku Analyte Placement v 
Průvodci k programu MALDI Biotyper RTC).Target position with associated 
analyte data. Na cílové obrazovce vyznačena bílým kroužkem. Geometrická 
pozice  terčíku se vzorkem, který má být analyzován. Lokatizace vzorku na 
MALDI terčíku, např. A1, B5, apod. 

B 

Bruker Bacterial Test Standard – Testovací standard 
Preparát bakteriálních bílkovin, který se používá ke kalibraci přístroje. Bruker part 
no. #255343. 

C 

Chemical Risk & Safety Phrases (R&S-Phrases) – Upozornění na chemická a 
bezpečnostní rizika 

Tato standardní upozornění objasňují rizika vznikající při zacházení s určitými 
reagenciemi (Riziková upozornění) a poskytují rady, jak se jim vyhnout 
(Bezpečnostní upozornění). 

Classification – Klasifikace  
Proces porovnávání profilů píků neznámého vzorku se všemi (nebo 
s podsouborem) referenčních profilů uložených v databázi programu MALDI 
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Biotyper. V závislosti na hodnotě skóre nejlepší shody je výsledek (identifikace) 
považován za  úspěšný či neúspěšný. 

Classification project – Klasifikační projekt 
Zásobník všech dat vztahujících se ke klasifikaci vzorků na terčíku měřeném 
v jedné šarži. 

Classification Results Report – Zpráva o výsledku klasifikace 
Zpráva o výsledku klasifikace obsahuje seznam výsledků klasifikačního projektu 
v tabelární formě. 

Classification run – Klasifikační chod 
Série měření provedených pomocí přístroje MALDI Biotyper v rámci daného 
klasifikačního projektu. 

Composite Correlation Index (CCI) Matrix analysis – Analýza matice 
kompozitního korelačního indexu (CCI) 

Metoda použitá ke statistické analýze vztahů existujících mezi jednotlivými 
spektry. 

Consistency category – Kategore shody 
Kategorie (A, B, or C), která vyjadřuje specifitu (tj. míru) shody  u určitého druhu 
nebo rodu mikroorganismů. 

F 

flexControl 
Software, který řídí činnost hmotnostního spektrometru a usnadňuje akvizici dat. 

Fume hood – Digestoř  
Zařízení používané k bezpečnému odvodu chemických výparů z prostorů 
laboratoře, např. na základě jejich odsávání nebo absorpce ve filtrech 
obsahujících aktivní uhlí.  
POZNÁMKA: Nezaměňovat s laminárním boxem (flowboxem), který se používá 
při práci s buněčnými kulturami. Tato zařízení odstraňují pouze pracové částice, 
ne chemická činidla. 

H 

HCCA 
viz kyselina α-cyano-4-hydroxyskořicová. 

I 

Identification – Identifikace  
Proces porovnávání profilu určitého píku zjištěného v neznámém spektru  se 
všemi (nebo s podsouborem) referenčních profilů uložených v databázi programu 
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MALDI Biotyper. V závislosti na hodnotě skóre nejlepší shody je výsledek 
(identifikace) považován za  úspěšný či neúspěšný. 
  

Identification metod – Metoda identifikace  
Soubor parametrů použitých k porovnání seznamu píků (neznámého spektra) 
s referenčními profily uloženými v knihovně známých profilů. 

Inactive (target) position – Inaktivní pozice terčíku) 
Cílová pozice nezvolená pro vložení údajů o pozici analytu vybraného pro vložení 
stránku Analyte Placement. Na stránce Analyte Placement je tato pozice 
označena bílým kroužkem. 
 

L 

Library – Knihovna  
Referenční hodnoty hmotnostních otisků (mass signatures) proteinů 
mikroorganismů uložené ve stuktuře, která se podobá databázi. 

M 

MALDI 
Akronym (zkratkové slovo) vytvořené z názvu Matrix Assisted Laser Desorption 
Ionization. 

MALDI target – Maldi terčík 
Nosič vzorku, obvykle ve formě ocelové destičky. 

Matrix 
Činidlo, které absorbuje UV záření a přenáší protony do jiných molekul. Nezbytné 
pro provádění MALDI-TOF hmotnostní spektrometrie. 

MSP 
Hlavní spektrum. 

P 

Polymer signals – Polymerové signály 
Stopy polymerů vyluhovaných z plastových materiálů. Jsou viditelné jako 
charkateristické profily četných opakujících se píků, jež se na ose x nacházejí 
v malých a stejných vzdálenostech (m/z-rozmezí). 

Preprocessing metod – Metoda předběžného zpracování (předpřípravy)  
Soubor parametrů použitých k vytvoření seznamu píků na základě 
(kalibrovaného) hrubého spektra. 
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Principal Component Analysis (PCA) – Analýza hlavních komponent (PCA) 
Statistická analýza poskytující informace o heterogenitě či homogenitě daného 
souboru dat. 

R 

Realtime classification – Klasifikace v reálném čase 
Kombinace měření s klasifikací vzorku. 

S 

Score value – Hodnota skóre 
Biostatistický parametr, který vyjadřuje spolehlivost shody mezi profilem vzorku a 
profilem referenčním. Čím je hodnota skóre vyšší, tím vyšší je i míra shody. 

Selected (target) position – Zvolená (cílová) pozice 
Cílová pozice zvolená pro umístění analytu na cílovém displeji na stránce Analyte 
Placement. Je označena modrým čtverečkem. 

Spot – Skvrna  
Suchý vzorek anebo kapička aplikované na MALDI terčík. 

T 

Target position – Cílová pozice  
Geometrická lokalizace na MALDI terčíku, např. A1, B5, atd. 

V 

Validation position – Validační pozice terčíku 
Pozice terčíku obsahujícího testovací standard (Bruker Bacterial Test Standard). 
Používá se při prověrkách kalibrace a validace. 

Α 

α-cyano-4-hydroxycinnamic acid (HCCA) 
Matrix použitá pro měření přístrojem IVD MALDI Biotyper. 
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Index 

A 

Abort (Zrušit) 
classification run  (kalsifikační chod) 60 

Abort Classification button (Tlačítko pro 
zrušení klasifikace) 60 

Analyte-specific ranking table (report)  
(Tabulkad s pořadím analytů - zpráva) 70 

Archived projects (Archivované projekty) 
loading (ukládání) 61 

B 

Baseline Subtraction (Odečet od základní čáry) 
101 

C 

Calibration (Kalibrace) 158 
CCI  138 
CCI analysis (CCI analýza)  138 

classification (klasiáfikace) 142 

results (výsledky) 141 

CCI matrix 
creating (vytvoření) 138 

CCI Scores  (CCI skóre)86 
Classification (Klasifikace) 

CCI  142 

MSP (Hlavní spektrum)  117 

results (výsledky) 118, 144 

subtyping (subtypizace) 119 

Classification job files (Klasifikační soubory) 
47 

Classification results (Výsledky klasifikace) 

viewing (zobrazení) 63 

Classification Results Report (Zpráva o 
výsledcích klasifikace)  

Analyte-specific ranking table  (Tabulka pořadí 
analytů) 70 

consistency categories (kategorie shody) 70 

generating (generování) 65 

Matching hints (Shodné výsledky) 68 

Meaning of score values (význam hodnot 
skóre) 69 

printing (tisk) 65, 73 

Project info (Projektové informace)  66 

Result overview  (Přehled výsledků) 67 

Classification run (Klasifikační chod) 
Abort (Zrušení)  60 

following (sledování)  57 

starting (zahájení)  53 

Clear command  (Příkaz vymazání) 45 
Comment  (Poznámka) 69 
Composite Correlation Index  See CCI 

Kompozitní korelační index - viz CCI  
Consistency categories (Kategorie shody) 70 
CSV files (CSV soubory) 47 
Current MSP (Aktuální MSP) 85 

D 

Delete Samples command (Příkaz k vymazání 
vzorků) 45 

Dendrogram 
MSP  129 

PCA clustering  (Klastrování PCA) 138 
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E 

Error Messages(Chybové hlášení) 
MALDI Biotyper RTC  73 

Existing project (Stávající projekt) 
opening (otevření) 54 

F 

File View (Náhled souboru) 80 

G 

Gel View (Náhled gelu)  84 

H 

HCCA  150 

I 

Identification View (Náhled identifikace)82 
Import button (Tlačítko importu) 48 
Import Project dialog (Dialog Project Import) 

48 

M 

Main spectrum  See MSP(Hlavní spektrum - 
viz MSP) 

MALDI Biotyper Metod Editor  (Editor metody 
programu MALDI Biotyper) 97 

MALDI Biotyper OC  18 
menus and commands (menu a příkazy)  144 

starting the software (spuštění softwaru) 78 

toolbars (panely nástrojů) 87 

user interface (uživatelské rozhraní) 78 

workflows (pracovní postupy) 90 

MALDI Biotyper Offline Classification - viz  
MALDI Biotyper OC 

MALDI Biotyper Realtime Classification - viz 
MALDI Biotyper RTC 

MALDI Biotyper RTC  16, 20 
error messages (chybová hlášení) 73 

menus and commands (menu a příkazy) 77 

result table (tabulka výsledků) 22 

starting the software (spuštění softwaru)  20 

toolbars (panely nástrojů)  21 

troubleshooting (vyhledávání a odstraňování 
chyb)  73 

user interface (uživatelské rozhraní)  20 

MALDI Biotyper RTC projects (Projekty 
MALDI Biotyper RTC)  

opening (otevření)  95 

MALDI Biotyper RTC Wizard  (Průvodce 
programem  MALDI Biotyper RTC)  24 

starting  (spuštění) 25 

MALDI Biotyper Taxonomy Tree Editor 
(Editor taxonomického dendrogramu 
programu MALDI Biotyper)  123 

MALDI targets  (MALDI terčíky) 149 
cleaning  (čištění)151 

MALDI-TOF spectra (MALDI-TOF spektra)  
measuring (měřeníú  157 

Mass Adjustment (Úprava hmotnosatni) 
 101 
Matching hint (Míra shody) 69 
Matching hints (report)  (Zpráva o mírách 

shodey) 68 
Matrix solution (Roztok matrix)  

preparing (příprava)  150 

Meaning of score values (report) (Význam 
hodnot skóre) 69 

Method (Metoda) 
preprocessing (předběžné zpracování) 100 
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Method Editor  (Editor (použité) metody)97 
Microorganisms (Mikroorganismy  

culturing (kultivace) 153 

Molecular Fingerprint  (Molekulární 
identifikátor) 17 

MSP (Hlavní spektrum) 
current (aktuální) 85 

deleting (vymazání)  111, 114 

selected (vybrané) 85 

standard (standardní) 103 

subtyping (subtypizace)  112 

MSP classification (MSP klasifikace) 117 
MSP dendrogram  129 

creating (tvorba) 130 

viewing (náhled) 130 

MSP libraries (Knihovny hlavních spekter)  122 
creating (tvorba) 128 

using (užívání)  128 

MSP peak lists (Seznam MSP píků) 108 
editing (editace) 108 

MSP Scores  (MSP skóre) 86 
MSPs (Hlavní spektra) 103 

handling (manipulace)  95 

highlighting (zvýraznění) 96 

loading (vkládání) 95 

selecting (výběr) 96 

MSPS 
removing (odstranění)  96 

N 

New classification project (Nový klasifikační 
projekt) 

creating (tvorba)  26 

New Project dialog (Dialog Nový projekt) 28 
Normalization (Normalizace) 101 

O 

Open Project dialog (Zahájení projektového 
dialogu) 54, 55 

Open Tree button  (Tlačítko otevření 
dendrogramu) 54, 55 

P 

PCA  132 
PCA clustering  (PCA klastrování)132 

dendrogram  138 

results  135 

Peak Picking (Výběr píků) 101 
Preprocessing metod (Metoda předběžného 

zpracování) 100 
Preprocessing spectra (Předběžné  zpracování  

spekter) 100 
Principal Component Analysis  See PCA 

(Analýza hlavních komponent - viz PCA) 
Printing (Tisk) 

classification results reports (zprávy o 
výsledcích klasifikace)  65, 73 

Processing metods (Metody zpracování)  96 
creating (tvorba) 98 

editing (editace) 98 

selecting (výběr) 99 

viewing (zobrazení) 98 

Project (Projekt) 
cancelling setup (zrušení setupu)  52 

create using "Import"  (vytvoření pomocí 
příkazu "Import") 47 

create using "New" (vytvoření pomocí 
příkazu "Nový") 28 
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Project info (report) (Projektové informace - 
zpráva)  66 

Project metods (Projektové metody) 
defining (definování)  50 

Project Metods page (Stránka projektových 
metod)  50 

Project settings (Nastavení rojektu) 
checking (kontrola)  51 

Project Summary page (Souhrnná stránka 
projektu) 51 

Protocols (Protokoly)  149 
consumables (spotřební materiály) 149 

solvents and chemicals (ředidla a chemikálie)  
149 

R 

Result overview (report) (Pehled výsledků - 
zpráva) 67 

Result table (Tabulka výsledků) 
MALDI Biotyper RTC  22 

Results (Výsledky) 
viewing (náhled)  118 

Results command (Příkazy) 65, 72 

S 

Sample data (Údaje o vzorku) 
barcode format  (formát čárového kódu)36 

character restrictions (zakázané znaky) 32 

copying (kopírování) 37 

CSV format (CSV formát) 47, 48 

editing  (editace)44 

entering  (vložení) 29, 32, 36, 37 

importing  (import) 41, 48 

obligatory (povinná) 32 

optional (opční) 32 

pasting  (vkládání)37 

requirements (požadavky) 30 

XML format  41 

Sample positions (Pozice vzorku) 
deleting (vymazání) 45 

Samples (Vzorky) 
classifying (klasifikace) 115 

preparing (příprava) 153 

Score value (Hodnota skóre) 17 
calculating (výpočet) 

 116 

Score values (report) (Zpráva o hodnotách 
skóre) 69 

Scores (Skóre)  
CCI  86 

MSP  86 

Spectrum  85 

Sub-MSP  86 

Scores and Loadings Plots  135 
Selected MSP  85 
Sequential insert mode  30 
Sequential Insert Mode command  30 
Show Report command  121 
Smoothing  101 
Spectra (Spektra) 

closing  (zavírání) 94 

handling (zacházení se spektry) 91 

highlighting (zvýrazňování) 96 

loading (vkládání) 91, 95 

preprocessing (příprava/předběžné 
zpracování  100 

removing (odstraňování)  94 
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selecting (výběr) 96 

Spectrum Scores (Skóre spektra) 85 
Spectrum View  (Náhled spektra) 82 
Spectrum/Identification (Identifikace spektra) 
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 82 
Standard MSPs (Standardní hlavní spektra) 

creating (tvorba) 103 

Sub-MSP Scores (Skóore sub-MSP)   86 
Subtyping (Subtypizace) 119 
Subtyping MSP (Subtypizace MSP) 

creating (tvorba)  112 

Switch off scrolling  (Vypnutí rolování)Y23 
System components (Systémové komponenty)  

16 

T 

Table (Tabulka) 
CCI Scores (CCI skóre) 86 

Current MSP (Aktuální hlavní spektrum) 85 

MSP Scores (MSP skóre) 86 

Selected MSP (Zvolené MSP) 85 

Spectrum Scores  (Skóre spektra) 85 

Sub-MSP Scores (Skóre vedlejších MSP)  86 

Table columns (Sloupky tabulky) 
displaying (zobrazení)  86 

hiding (skrytí)  86 

Table View (Náhled tabulky)  85 
Target positions (Pozice terčíku) 

selecting (výběr) 30 

Taxonomy tree (Taxonomický dendrogram)  
122 

creating (vytvoření)  123 

deleting (vymazání)  128 

Taxonomy Tree Editor  (Editor taxonomického 
dendrogramu) 123 

Taxonomy Tree View (Náhled taxonomického 
dendrogramu) 83 

Toolbars (Panely nástrojů)  21, 87 
MALDI Biotyper OC  87 

MALDI Biotyper RTC  21 

Troubleshooting (Hledání a odstraňování chyb) 
MALDI Biotyper  147 

MALDI Biotyper RTC  73 

U 

User interface (Uživatelské rozhraní) 
MALDI Biotyper OC  78 

MALDI Biotyper RTC  20 

V 

Validation check (Validační kontrola) 45 
Validation position (Validační pozice) 45 
Validation status (Uživatelem definovaný 

validační status) 
user-defined  64 

View (Náhled)   
File (Soubor)  80 

Gel  84 

Identification (Identifikace) 82 

Spectrum (Spektrum) 82 

Spectrum/Identification/MSP Peak List 
(Seznam spekter/identifikací/MSP píků 82 

Table (Tabulka)  85 

Taxonomy Tree (Taxonomický dendrogram 83 

View Results button (Tlačítko zobrazení 
výsledků) 65, 72 

W 

Welcome page (Uvítací stránka)  25 
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X 

XML soubory  41 

Z 

Zooming (Tansfokace)  83 

Α 

α-cyano-4-hydroxycinnamic acid  150 
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